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About This Guide 

This guide describes how to install, configure, and customize Novell iPrint Appliance on your network.

 Chapter 1, “iPrint Overview,” on page 11

 Chapter 2, “What’s New or Changed in iPrint Appliance,” on page 17

 Chapter 3, “Planning Your iPrint Appliance Environment,” on page 23

 Chapter 4, “Installing iPrint Appliance,” on page 31

 Chapter 5, “Configuring Print System,” on page 39

 Chapter 6, “Document Rendering,” on page 71

 Chapter 7, “Managing iPrint Appliance,” on page 81

 Chapter 8, “Managing Print System,” on page 93

 Chapter 9, “Installing and Setting Up iPrint on Client Workstations,” on page 147

 Chapter 10, “Mobile Device Management (MDM),” on page 187

 Chapter 11, “Troubleshooting iPrint Appliance,” on page 193

 Chapter 12, “Known Limitations,” on page 209

 Appendix A, “Email Service Parameters,” on page 211

 Appendix B, “Best Practices,” on page 213

 Appendix C, “iPrint Appliance Support Matrix,” on page 215

 Appendix D, “TIDs for iPrint,” on page 223

 Appendix E, “iPrint Commands and Utilities,” on page 225

 Appendix F, “iPrint Appliance Documentation Updates,” on page 231

Audience

This guide is intended for Novell iPrint Appliance administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation.

Documentation Updates

For the most recent version of the Novell iPrint Appliance 1.1 Administration Guide, and other 
documentation for this product, visit the Novell iPrint Appliance 1.1 Documentation Web site (http://
www.novell.com/documentation/iprint-appliance1/).

For information about configuring and using the mobile app, see the iPrint Appliance User Guide, or 
the Help section of the app.
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1 1iPrint Overview

Organizations want to reduce the complexity of managing printers by IT and allow end users to easily 
locate and install printers. 

That’s where Novell iPrint comes in. Novell iPrint offers a single, scalable solution for managing all of 
your printing across multiple office locations from any device. It lets the users print quickly, easily, and 
more securely.

 Section 1.1, “Challenges in Print Environment,” on page 11

 Section 1.2, “What is Novell iPrint?,” on page 11

1.1 Challenges in Print Environment
End users: 

 Printing from mobile devices (BYOD)

 Ease of installing printers and printer drivers

 Updating printer specific drivers 

Administrators: 

 Complexity of managing printers and printer drivers

 Auditing and accounting of print jobs

 Health-monitoring of a printer

 Secure printing

 Printing in heterogeneous environments - Windows, Mac, and Linux platforms 

1.2 What is Novell iPrint?
 Section 1.2.1, “iPrint Features,” on page 11

 Section 1.2.2, “iPrint Components,” on page 13

Novell iPrint provides secure enterprise print services for your desktops, laptops, and mobile devices. 
Novell’s iPrint solution integrates with any of your existing corporate printers, irrespective of the 
printing vendor or brand allowing you to deliver self-service printer provisioning to your device users. 

1.2.1 iPrint Features

Simplified enterprise printing: Novell iPrint connects all your organization's workstations and 
mobile devices to your current printers. iPrint scales exceptionally well, reducing the server 
infrastructure you need to maintain hundreds or thousands of printers and thus lowering your network 
bandwidth costs.

Self-service printing: Users can print from their desktops, laptops, or mobile devices without waiting 
for the helpdesk to set-up a printer. 
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From desktops or laptops, users can print by selecting printers on a map using a web browser.

From mobile devices, users can print to any organizational printer via AirPrint, an iPrint app or email.

Mobile device printing:  Users of iOS, Android, and Windows mobile devices can download apps 
that allow them to print from their mobile devices directly to any of your organization's printers. 

Novell iPrint provides all of the necessary document rendering and conversion.

AirPrint Integration: Makes wireless, proximity-based printing a possibility across your organization. 
Allows iOS users to use their devices' AirPrint capabilities with any iPrint printer.

Samsung KNOX certified: Enhanced security for Android devices while maintaining user-friendly, 
secure mobile printing in your corporate environment.

QR Code Support: Scan a QR code to quickly connect your mobile device to a specific printer.

Email print jobs to any iPrint printer: Any email-enabled device can print to any iPrint printer by 
sending the print job in the body of the email or as an attachment.

Works in heterogeneous environments: Saves IT time and money by significantly reducing the 
management burden required for mixed fleets of Mac, Windows, or Linux desktops. It works across 
the major mobile platforms as well, meaning IT only has to manage a single print solution for all your 
organization's endpoints. 

Leverages your current directory service: Novell iPrint makes secure printing easy by integrating 
its data store with your identity directory. It works with lightweight directory access protocol (LDAP) 
directories such as Active Directory and NetIQ eDirectory.

Works with legacy printers: Mobilize your existing fleet of printers rather than buying new.
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1.2.2 iPrint Components

Figure 1-1   iPrint Overview

 “Users” on page 14

 “Devices” on page 14

 “Protocols” on page 14

 “Administration” on page 14

 “Accounting With iPrint” on page 15

 “Identity Source” on page 15

 “iPrint Appliance” on page 15

 “Renderers” on page 15

 “Printers” on page 15

 “iPrintman” on page 16
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Users

Users can submit print jobs through iPrint from their desktops, laptops, or mobile devices to both new 
and legacy printers from all the major print vendors, without worrying about print drivers. You can 
either import users from an existing LDAP source or create new users on the iPrint Appliance.

Devices

iPrint supports printing from desktops, laptops, or mobile devices. 

Desktops and laptops: Clients for Windows, Mac, and Linux workstations.

Mobile Devices: Apps for iOS, Android, Windows, and BlackBerry devices.

Protocols

IPP/ Email: The devices and app uses IPP (Internet Printing Protocol) or email to submit the print job. 
If a direct network connection to iPrint Appliance is unavailable, the device switches to email printing, 
and uses the email client configured on the device.

LDAP: LDAP is used for communication between iPrint Appliance and identity stores (eDirectory and 
Active Directory).

HTTPS: HTTPS protocol is used for secure communication between iPrint Appliance and remote 
renderers.

LPR/RAW/SNMP: iPrint Appliance supports printer communications using the Line Printer Remote 
(LPR), RAW, or SNMP protocols.

Administration

Using Novell iPrint Appliance Management Console, you can add and manage printers, check the 
printer status, create printer maps, and monitor the appliance. 

iPrint Appliance Configuration:  Use for initial iPrint configuration and setup. You can configure 
mobile printing, LDAP user/group sources, and renderers for enhanced document conversion.

Appliance System Configuration: : Use this tool to reconfigure the system's network settings, time, 
SSL certificates, and passwords. Network Settings should not be changed once iPrint Appliance 
Configuration has been initiated.

iPrint Printer Configuration (iManager):  iManager is a web-based tool that allows you to set up 
and manage your print environment. You can create printers, printer drivers, profiles, and users.

iPrint Health Monitor:  Monitors your iPrint environment. You can view status of print jobs and 
manage jobs, and generate audit reports that show details of who printed and how much. 

iPrint Migration Utility:  You can migrate printers, drivers, driver profile, and printer configuration 
details from your existing NetWare or OES environment.

iPrint Map Designer: Use this tool to create map displaying the location of printers. Users can 
identify and install printers that are nearest to their location.

Ganglia: You can access various real-time monitoring statistics for all of the Ganglia-enabled 
machines on your network segment.
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Accounting With iPrint

Print Accounting: Novell iPrint integrates with third-party print accounting solutions to provide full 
support for accounting the print jobs including tracking all the print jobs and keeping a tab on the 
paper consumption. The print accounting feature enables the print administrator to have a clear 
understanding of who is printing what and when, and apply charge back capabilities if required.

Direct Print Accounting: A printer that is enabled for iPrint Direct sends print jobs directly to the 
printer instead of sending the job to the print server first. The print job is sent to the printer in LPR or 
raw 9100 format, depending on the setting in the gateway autoload command for the printer. Although 
this greatly reduces server communication, the ability to audit print jobs is lost. However, if you are 
running a third-party print accounting solution, Novell iPrint client can integrate with the third-party 
print accounting solution to provide support for accounting print jobs to direct printers.

To install and configure third-party print accounting solution, refer to their documentation.

Identity Source

It works with LDAP directories such as Active Directory and eDirectory. Novell iPrint makes secure 
printing easy by integrating its data store with your identity directory. 

iPrint Appliance

Print and mobile server are the main components of appliance which handle all print jobs and all print 
infrastructure. 

Renderers

 “Local Renderer” on page 15

 “Remote Renderer” on page 15

Local Renderer

iPrint Appliance is bundled with an in-built document renderer (local renderer). The local renderer 
converts documents to the PDF format, then converts them to the print ready format using CUPS. 
The renderer supports Open Office, Microsoft Office and image formats, and also has a 
multithreading feature. 

Remote Renderer

iPrint Appliance ships with a remote renderer. For desktop-quality printing, it is highly recommended 
that you install the remote renderer. You can download the remote renderer from the iPrint Appliance 
Management Console.

The remote renderer provides high quality rendering for Microsoft Office and PDF document formats. 

Printers

Users can send print jobs through iPrint to both new and legacy printers from all the major print 
vendors.
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iPrintman

A Command line tool that allows you to manage your print environment. You can create and manage 
your printers, upload printer drivers, and so forth.
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2 2What’s New or Changed in iPrint 
Appliance

This section describes enhancements and changes to Novell iPrint Appliance.

 Section 2.1, “What’s New (iPrint Appliance 1.1 Patch 4),” on page 17

 Section 2.2, “What’s New (iPrint Appliance 1.1 Patch 3),” on page 17

 Section 2.3, “What’s New (iPrint Appliance 1.1 Patch 2),” on page 17

 Section 2.4, “What’s New (iPrint Appliance 1.1 Patch 1),” on page 19

 Section 2.5, “What’s New (iPrint Appliance 1.1),” on page 20

2.1 What’s New (iPrint Appliance 1.1 Patch 4)

2.1.1 iPrint Client 6.01 for Mac

The iPrint Client is upgraded to version 6.01 and is available for Mac 10.11 (El Capitan). This client is 
also available on Mac OS X 10.8, OS X 10.9, and OS X 10.10. The users can now install printers 
using the Google Chrome browser and get an improved installation experience with the Safari and 
Firefox browsers. For more information, see Section 9.1, “Installing the iPrint Client,” on page 147.

2.2 What’s New (iPrint Appliance 1.1 Patch 3)

2.2.1 iPrint Client 6.2.0 for Windows

 The iPrint Client is upgraded to version 6.2.0 and is available for Windows 10.This client is also 
available for Windows 8.x, Windows 7, Windows Vista, Windows Server 2008 R2, and Windows 
Server 2012 R2. For more information, see Section 9.1, “Installing the iPrint Client,” on 
page 147.

 Updated accounting APIs to perform cancellation of jobs silently.

2.2.2 Additional Updates

 Increased ability to upload large printer drivers using iManager.

 Paused jobs of a direct printer are no longer lost even if the printer agent is redirected or driver/
profile update is applied.

2.3 What’s New (iPrint Appliance 1.1 Patch 2)
 Section 2.3.1, “iPrint Client 6.0.0 for Mac,” on page 18

 Section 2.3.2, “iPrint Client 6.1.0 for Windows,” on page 18

 Section 2.3.3, “iprintman Enhancements,” on page 18
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 Section 2.3.4, “Log File,” on page 18

 Section 2.3.5, “Email Printing,” on page 18

 Section 2.3.6, “Additional Updates,” on page 19

2.3.1 iPrint Client 6.0.0 for Mac

The iPrint Client is upgraded to version 6.0.0. and is available for Mac OS X 10.8 or later. The users 
can now install printers using the Google Chrome browser and get an improved installation 
experience with the Safari and Firefox browsers. For more information, see Section 9.2.2, “Using the 
iPrint Printer List Web Page on Macintosh,” on page 160.

2.3.2 iPrint Client 6.1.0 for Windows

The iPrint Client is updated so that users can now install printers using the latest Google Chrome 
browser. This client is available for Windows 8.x, Windows 7, Windows Vista, Windows Server 2008 
R2, and Windows Server 2012 R2. For more information, see Section 9.2.1, “Using the iPrint Printer 
List Web Page on Windows,” on page 156.

2.3.3 iprintman Enhancements

The following pool and profile enhancements are made to the iprintman command:

 Pool Options

List: Lists the pools (--list) and printers in a pool (--info).

Manage printer pools: Creates (--create), modifies (--modify), and deletes (--delete) a 
printer pool.

Manage printers in a pool: Adds (--add-printer) or removes (--remove-printer) printers 
from the pool.

 Profile Options
List driver profiles: Lists (--list) the driver profiles on the server.

Import driver profiles: Imports (--import) the driver profiles from one server to another.

Overwrite: Overwrites (--overwrite) the existing profiles on the server.

2.3.4 Log File 

Log file is now available to capture the patch installation details. In the Field Test Patch page, click 
Download Log File to download the file. 

For more information, see Section 7.9, “Field Patch,” on page 89.

2.3.5 Email Printing

Supports printing of images that are part of the email message body.
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2.3.6 Additional Updates

 Printer status is ready for direct printers even if SNMP is disabled on the printer.

 Localization fixes across the components.

2.4 What’s New (iPrint Appliance 1.1 Patch 1)
 Section 2.4.1, “Flexible Communication Options,” on page 19

 Section 2.4.2, “New iPrint Client 6.0.0,” on page 19

 Section 2.4.3, “LDAP,” on page 19

 Section 2.4.4, “Renderer,” on page 20

 Section 2.4.5, “Email Printing,” on page 20

 Section 2.4.6, “Additional Updates,” on page 20

2.4.1 Flexible Communication Options

In addition to secure communication, iPrint Appliance now accepts non-secure communication from 
the Remote Renderer. In the Management Console Renderers's page, a new Settings icon has been 
added to select secure communication. If this option is not selected, both secure and non-secure 
communication will be supported. 

For more information, see Section 6.2.2, “Secure and Non-secure Communication Support (Remote 
Renderer),” on page 72. 

2.4.2 New iPrint Client 6.0.0

A new iPrint client has been released for Windows Vista, Windows 7, Windows 8.x, Windows Server 
2008 R2, and Windows Server 2012 R2 with the following features:

 Direct Print Accounting Support: Supports print accounting for direct printers with third-party 
print accounting solutions such as PaperCut. For more information, see “Accounting With iPrint” 
on page 15.

 Simplified Printer Installation:  Users can now install printers using the Google Chrome 
browser prior to version 42. Users also get an improved installation experience with the Firefox 
browsers. In addition, on the Internet Explorer browser, you no longer need to run as an 
administrator to install printers on the Windows operating systems. For more information, see 
Section 9.2.1, “Using the iPrint Printer List Web Page on Windows,” on page 156.

If you are installing printers using the Google Chrome browser version 42 and later, see TID 
7016444 on the Novell Support Site.

Henceforth, any updates to these browsers will not impact the installation of the iPrint clients.

2.4.3 LDAP

 Large number of user and group objects are successfully imported from the source LDAP 
directory (eDirectory or Active Directory) to the iPrint Appliance server.

 Modifications and deletions to the configuration on the source LDAP directory is synced 
successfully to the Appliance server.

 The synchronization of User and Group Objects is enhanced.
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 Users renamed on the source LDAP directory are successfully imported to the Appliance. 

 eDirectory users now successfully authenticate to the iPrint Appliance server.

2.4.4 Renderer

 Upgrade issues related to renderers are resolved.

 Remote renderer processes print job with the latest driver associated with the printer.

 Secure configuration of Renderer is allowed only if the certificate files are of PKCS12 (file 
extensions.pfx or .p12) type.

2.4.5 Email Printing

 The print command for email printing is simplified. You can now specify only the printer name in 
the subject line to print your mail and its attachments. For example, printername#Test Mail. 

 A new option audit_common_name is added to the /etc/opt/novell/iprintmobile/conf/
iprintmobile.conf file.You can set this value audit_common_name=true to send only the 
Common Name from the FDN.

By default, FDN value is sent for Accounting or Auditing of the LDAP imported users. 

2.4.6 Additional Updates

 You can successfully print from a Linux server using the LPR protocol.

 Migration is now successful even if the OU includes “&” sign.

 No erroneous messages are displayed when printers are migrated. 

 Print jobs are successful and audit logs are updated when the job file size changes.

2.5 What’s New (iPrint Appliance 1.1)
iPrint Appliance 1.1 provides the following key features:

 Section 2.5.1, “User Enhancements,” on page 20

 Section 2.5.2, “Administration Enhancements,” on page 20

2.5.1 User Enhancements

For a list of iPrint user enhancements, see “What’s New in iPrint”in the Novell iPrint 1.1 User Guide.

2.5.2 Administration Enhancements

 Local and remote renderers: 

 Multi-driver support: You can now configure the local and remote renderer to use multiple 
drivers for various mobile-enabled printer agents. 

 Web-based management: You can now manage remote renderers by using Management 
Console.
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 Built-In PDF renderer: The remote renderer is now bundled with an built-in PDF renderer. 
Until last release of iPrint Appliance, Adobe Acrobat Pro was mandatory to render PDF 
documents using the remote renderer. 

For more information, see Chapter 6, “Document Rendering,” on page 71.

 Interface for applying software patches: An interface is available to apply software patches. 
For more information, see Section 7.9, “Field Patch,” on page 89.

 Interface for uploading configuration files: You can upload configuration files to Novell 
Support via FTP, or to download the configuration files so that you can send them by an 
alternative method. For more information, see Section 7.8, “Support,” on page 88.

 Migration of iCM and ACL: iPrint Client Management (iCM) settings and Access Control Lists 
(ACL) are now automatically migrated from OES environment to iPrint Appliance during the 
printer import process. For more information, see Section 5.4.1, “Migrating Printers from an OES 
iPrint System,” on page 50.

 Ability to bulk import printers:  You can now bulk import printers into iPrint Appliance through 
a csv file. For more information, see Section 5.4.3, “Bulk Printer Import Using a CSV File,” on 
page 57.

 Printer rename:  You can now rename a printer from the Printers page. Select a printer you 
want to rename, click the Configure menu, then click Rename Printer. For more information, see 
“Printer Rename and Printer Refresh” on page 96.

 Printer refresh: To refresh the printers list, click the Reload button in the upper right of the 
Available Printers window. For more information, see “Printer Rename and Printer Refresh” on 
page 96.

 IPP page enhancements:  IPP page is enhanced for better user experience.

 MobileIron integration:  iPrint App is now enabled for MobileIron. For more information, see 
Chapter 10, “Mobile Device Management (MDM),” on page 187.

 Samsung KNOX certified: Enhanced security for Android devices while maintaining user-
friendly, secure mobile printing in your corporate environment.
What’s New or Changed in iPrint Appliance 21



22 Novell iPrint Appliance 1.1 Administration Guide



3 3Planning Your iPrint Appliance 
Environment 

This section describes the requirements for installing iPrint Appliance.

 Section 3.1, “Server Requirements,” on page 23

 Section 3.2, “Ports Requirements,” on page 25

 Section 3.3, “Remote Renderer Requirements,” on page 28

 Section 3.4, “AirPrint Requirements,” on page 28

 Section 3.5, “Mobile Platform Requirements,” on page 29

 Section 3.6, “Upgrade Requirements,” on page 29

3.1 Server Requirements
 iPrint Appliance works with any virtualization software that can run the .ovf, .vmx , or .xen file 
formats. However, iPrint Appliance works best with the virtualization software versions listed below. 

 Virtualization software:

 Hyper-V: Windows Server 2012 Hyper-V and Windows Server 2008 Hyper-V

 Xen 4.2.2_04-0.7.5 on SLES 11 SP2 and SLES 11 SP3

 VMware ESX 4.x, ESXi 4.x, ESXi 5.x or higher

 A VMware vSphere client 4.x or VMware vSphere client 5.x for accessing the host server and 
appliance for initial configuration.

 VMware Workstation 9 on Windows 7 and SLES. Though VMware Workstation 9 is certified, 
VMware Workstation 8 works with no major issues.

 Microsoft Internet Explorer 9 or 10, or the latest version of Mozilla Firefox or Google Chrome, or 
Safari on Mac, for configuring and managing iPrint Appliance after installation.

 Directory service:

 NetIQ eDirectory 8.8 or later

 Active Directory configured on Windows Server 2012 R2 Standard Edition

 Active Directory configured on Windows Server 2008 R2 Enterprise Edition 

 IP address details for iPrint Appliance, including:

 Static IP address

 Network mask

 Gateway IP address

 DNS host name associated with the IP address

 IP address of a DNS server

 The IP address assigned to the iPrint Appliance and remote renderer must have DNS host entry 
in the DNS server. Ensure that the DNS entries are in the same domain.
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If you do not have a DNS server to resolve the hostnames, you can use the hosts file to resolve 
the same as follows:

 Ensure that the hosts file is updated with the iPrint Appliance and remote renderer details 
(IP and hostname) in both the iPrint Appliance and the remote renderer machine. The 
hosts file is located at:

iPrint Appliance: /etc/hosts

Remote renderer in the Windows machine: C:\Windows\System32\drivers\etc

 If you are using a third party certificate, ensure that the hostname of the iPrint Appliance and 
remote renderer are configured with the domain name against which the certificate is issued. For 
example, appliance.xyz.com and remoterenderer.xyz.com.

 If the iPrint Appliance and remote renderer, requires same IP address to resolve two different 
host names, then during the appliance configuration, do one of the following:

 Ensure that the /etc/hosts file of iPrint Appliance is updated with the IP address and 
hostname (domain name against which the certificate is issued) of the iPrint Appliance and 
remote renderer.

 If you have a DNS server, then ensure that the PTR record entry for hostname matches the 
domain name of the used certificate. Ensure to remove all the other hostnames from the 
hosts file.

 4 GB RAM or higher is recommended

 40 GB hard disk space is recommended

NOTE: For information about VMware system requirements, see Minimum system requirements for 
installing ESX/ESXi on the VMware support page.
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3.2 Ports Requirements
Figure 3-1   iPrint Appliance Ports Map

Desktop Clients: Open the ports on your clients to communicate with iPrint Appliance, printers and 
LDAP sources.
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636
389

5353631

Windows Renderer 

NetIQ eDirectory or
Microsoft Active Directory
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Mobile Apps: Open ports on your mobile devices to communicate with iPrint Appliance and printers.

Remote Renderer: Open the ports for various communications between iPrint Appliance and 
printers.

iPrint Appliance: Open the ports for various communications between iPrint Appliance and printers.

Mac Outbound 631 IPP To communicate with the printers

9100 RAW

515 LPR

Operating System Connection 
Type

Port Protocols Description

iOS, Android, 
Windows, 
Blackberry

Outbound 443 HTTPS To communicate with iPrint Appliance and with 
the printers

Outbound 631 IPP To communicate with the printers

80 TCP

Operating System Connection 
Type

Port Protocols Description

Windows Inbound 8080 HTTP To allow Management Console and Mobile 
server to connect with the renderer

Inbound 8443 HTTPS To allow secure communication

Outbound 9100 RAW To communicate with the printers

161 SNMP

515 LPR

Tasks Connection 
Type

Port Protocols Description

Printers Outbound 9100 RAW To communicate with the printers

161 SNMP

515 LPR

80 TCP

AirPrint Inbound 631 IPP To perform AirPrint jobs

5353 mDNS/
UDP

Outbound 5353 mDNS/
UDP

To advertise iPrint printers as iOS AirPrint printers

Operating System Connection 
Type

Port Protocols Description
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NOTE: For ports required by the 3rd party products, you must refer their documentation.

Desktop 
Clients 

Inbound 515 LPR To allow Desktop clients to communicate with the 
appliance

LDAP Import Outbound 524 NCP 
(Dclient)

To perform LDAP import and authenticate users to the 
configured LDAP sources

636 LDAPS 
(Secure)

389 LDAP 
(Non-
Secure)

Inbound 22 SSH To allow access to appliance to perform LDAP Import

636 LDAPS 
(Secure)

389 LDAP 
(Non-
Secure)

Management Inbound 9443 To allow access to iPrint Management Console

Inbound/ 
Outbound

443 HTTPS To perform iManager tasks

80 TCP

Mail Server Outbound 143 IMAP To communicate with the Mail server.

993 IMAPS 
(Secure)

110 POP3

995 POP3

25 SMTP

465 SMTP 
(Secure 
via SSL)

587 SMTP 
(Secure 
via TLS)

Ganglia 
Configuration 

Inbound 8080 
(blocked)

To configure Ganglia

8081

8443

8444

8649

Tasks Connection 
Type

Port Protocols Description
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3.3 Remote Renderer Requirements
For desktop quality printing for Microsoft Office and PDF documents, you must install a remote 
renderer. The minimum requirements are as follows:

 Install the renderer on a Microsoft Windows 64-bit system

 Windows 8.1 / Windows 8/ Windows 7 SP2 Enterprise/Windows 2012 R2/ Windows 2008 R2 
Enterprise with a dual-core processor or higher

 Microsoft Office 2013 64-bit 

 Microsoft Office 2013 32-bit 

 Microsoft Office 2010

 Adobe Acrobat XI Professional (Optional)

 Adobe Acrobat X Pro

 Microsoft .Net Framework 4 or later

 The IP address assigned to the iPrint Appliance and remote renderer must have DNS host entry 
in the DNS server. Ensure that the DNS entries are in the same domain.

If you do not have a DNS server to resolve the hostnames, you can use the hosts file to resolve 
the same as follows:

 Ensure that the hosts file is updated with the iPrint Appliance and remote renderer details 
(IP and hostname) in both the iPrint Appliance and remote renderer machine. The hosts file 
is located at:

iPrint Appliance: /etc/hosts

Remote renderer in the Windows machine: C:\Windows\System32\drivers\etc

 If you are using a third party certificate, ensure that the hostname of the iPrint Appliance and 
remote renderer are configured with the domain name against which the certificate is issued. For 
example, appliance.xyz.com and remoterenderer.xyz.com.

 If the iPrint Appliance and remote renderer, requires same IP address to resolve two different 
host names, then during the appliance configuration, do one of the following:

 Ensure that the /etc/hosts file of iPrint Appliance is updated with the IP address and 
hostname (domain name against which the certificate is issued) of the iPrint Appliance and 
remote renderer.

 If you have a DNS server, then ensure that the PTR record entry for hostname matches the 
domain name of the used certificate. Ensure to remove all the other hostnames from the 
hosts file.

3.4 AirPrint Requirements
To enable AirPrint through iPrint using multicast DNS (mDNS), your network must meet the following 
requirements:

 Section 3.4.1, “Hardware Requirements,” on page 29

 Section 3.4.2, “Network Requirements,” on page 29
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3.4.1 Hardware Requirements

 Router or Gateway with an option to forward mDNS (Apple Bonjour) multicast advertisements on 
all or selected wireless VLANs

 Wireless router that supports mDNS (Apple Bonjour) between wired and wireless machines

The wireless routers are expected to have the capability for IGMP snooping. IGMP snooping is 
required to disallow the multicast traffic on those network interfaces that are not participating in 
AirPrint's Bonjour multicast discovery.

The wireless network switches must not be interconnected for redundancy. This results in a Layer 2 
switching loop.

3.4.2 Network Requirements

 Wireless network with no interconnection

 IP Multicast network (IP Multicast must be enabled on network devices such as routers and 
switches)

3.5 Mobile Platform Requirements

Table 3-1   Mobile Operating System Support for Apps

3.6 Upgrade Requirements
You can use the Upgrade option in two scenarios:

 Upgrading iPrint Appliance from an earlier version

 Importing the configuration settings from an existing copy of iPrint Appliance

Type Version

iOS  6.x

 7.1.x

 8.x

Android  Gingerbread (2.3.x)

 Ice Cream Sandwich (4.0.x)

 Jelly Bean (4.1.x, 4.2.x, 4.3.1)

 KitKat (4.4.x)

 Lollipop (5.0.x)

BlackBerry  OS 10 (Phone)

 OS 2.1.0 (PlayBook)

Windows  Phone 8.x

 RT 8.1
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When you select the Upgrade option, you are prompted for the configuration file iprintconfig.zip. 
For creating the iprintconfig.zip, see Section 3.6.1, “Exporting the Configuration File,” on 
page 30.

IMPORTANT: If you want to use an external disk to upgrade iPrint Appliance, you must add a new 
external hard disk to the appliance before configuring the network settings.

3.6.1 Exporting the Configuration File

To create the iprintconfig.zip file, you must copy the configuration information from an existing 
iPrint Appliance.

1 On a Web browser, either use DNS or the IP Address to access the Management Console. For 
example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

Ignore the security certificate warning.

2 Specify vaadmin or root as the user name.

3 Specify the password.

The Management Console page is displayed.

4 Click the iPrint Appliance Configuration icon.

5 Under Administration, click Export Configuration.

6 Specify the eDirectory administrator Password, then click Export.

This is the password that you use for the administrator account of iPrint Appliance when using 
iManager.

On successful export, a iprintconfig.zip file is created that contains the configuration 
information. 
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4 4Installing iPrint Appliance

Before installing iPrint Appliance, see Appendix B, “Best Practices,” on page 213 to ensure a 
seamless experience with iPrint Appliance.

 Section 4.1, “Deploying iPrint Appliance and Configuring the Virtual Environment,” on page 31

 Section 4.2, “Initial Appliance Configuration,” on page 36

4.1 Deploying iPrint Appliance and Configuring the 
Virtual Environment
You must download the iPrint Appliance and configure the virtual environment where you plan to run 
the appliance. This includes configuring the system resources.

The process of downloading the iPrint Appliance and configuring the virtual environment differs, 
depending on which virtual environment you plan to use to run the iPrint Appliance.

 Section 4.1.1, “VMware Configuration,” on page 31

 Section 4.1.2, “Citrix Xen Configuration,” on page 32

 Section 4.1.3, “Xen Configuration,” on page 33

 Section 4.1.4, “Hyper-V Configuration,” on page 35

4.1.1 VMware Configuration

1 Download the iPrint software (iPrint.x86_64-version.ovf.zip) to your management 
workstation.

You can download the software from the Novell Customer Center (NCC) (https://
www.novell.com/center). Or, you can download an evaluation version of the software from the 
Novell Downloads page (http://download.novell.com).

2 Extract the iPrint.x86_64-version.ovf.zip file on your management workstation so that the 
iPrint-version file folder appears.

NOTE: On a VMware workstation, do not extract the iPrint.x86_64-version.ovf.zip file 
using the default Windows extractor. On deploying this file, you may receive an error message, 
Access is Denied. To resolve this issue, extract the file using any other third-party extractor. 

3 In the vSphere client, click File > Deploy OVF Template.

NOTE: If the virtualization software you are using does not support .ovf, you must convert the 
.ovf file to .vmx using the VMware OVF Tool available on the VMware Website.

4 Browse to and select the .ovf file in the iPrint-version file folder.

5 Click Next.

6 Click Next again.

7 In the Name field, rename the iPrint appliance to a name of your choice, then click Next.
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8 Click Next to accept the default for the disk format.

9 Click Finish.

10 (Optional) Create a separate VMware hard disk for the appliance. This is the location where you 
will store your iPrint files.

10a In the vSphere client, right-click the virtual machine that you just created, and for which you 
want to create secondary storage, then click Edit Settings.

The Virtual Machine Properties page is displayed.

10b On the Hardware tab, click Add.

The Add Hardware dialog box is displayed.

10c Select Hard Disk, then click Next.

10d Select Create a new virtual disk, then click Next.

10e In the Disk Size field, specify the amount of hard disk space that you want to allocate. 40 
GB is recommended.

10f Select a datastore, then click OK.

10g Click Next.

10h Click Finish.

11 Increase the amount of memory that VMware allocates for the iPrint appliance. 

11a In the Virtual Machine Properties window, select Memory, then increase the setting to a 
suitable size for your environment. 4 GB is recommended.

11b Click OK to exit the Virtual Machine Properties window.

12 Power on the appliance (virtual machine).

13 Continue with Section 4.2, “Initial Appliance Configuration,” on page 36.

4.1.2 Citrix Xen Configuration

1 Download the iPrint software (iPrint.x86_64-version.ovf.zip) to your management 
workstation.

You can download the software from the Novell Customer Center (NCC) (https://
www.novell.com/center). Or, you can download an evaluation version of the software from the 
Novell Downloads page (http://download.novell.com).

2 Extract the iPrint.x86_64-version.ovf.zip file on your management workstation.

3 In the Citrix XENCenter client, right-click the server on which you will install iPrint Appliance, then 
click Import. 

The Import OVF/OVA Package wizard is displayed.

4 Import Source: Browse to iPrint.x86_64-version folder and select the .ovf file.

5 Location: 

Click Next to continue with the default settings.

6 Storage:  Select one or more storage repositories (SRs) where the disk images for the imported 
VMs will be placed, then click Next.

7 Networking: To map an incoming virtual network interface to a target network, select a network 
from the list in the Target Network column, then click Next.

The Network and MAC address shown in the list of the VMs are stored as part of the definition of 
the original (exported) VM in the export file. 

8 Security: 
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If the selected OVF/OVA package is configured with security features such as certificates or a 
manifest, select Verify manifest content to verify the list of files in the package. If the packages 
are digitally signed, the associated manifest is verified automatically and so the Verify manifest 
content option is not available on the Security page.

Click Next.

9 OS Fixup Settings: Since the VMs are created on XenServer, select Don’t use Operating 
System Fixup, then click Next. 

10 Transfer VM Settings: Configure the network settings, then click Next.

10a Select a network from the list of network interfaces.

10b To configure networking settings manually, select Use these network settings and enter the 
IP address, subnet mask and gateway. 

We recommend you to provide the same IP address that you plan to use for iPrint VM 
server. However, you can also provide a temporary IP address. 

11 Review all the import settings and then click Finish to begin the import process and close the 
wizard.

The import progress is displayed in the status bar at the bottom of the XenCenter window and 
also on the Logs tab.

12 (Optional) Create a separate hard disk for the appliance. This is the location where you will store 
your iPrint files.

12a In the Citrix XENCenter client, select the virtual machine that you just created, and click on 
the Storage tab.

The Virtual Disks page is displayed.

12b Click Add.

The Add Virtual Disk dialog box is displayed.

12c In the Name field, specify the name of the virtual disk. 

12d In the Size field, specify the amount of hard disk space that you want to allocate. 40 GB is 
recommended.

12e Click Add.

13 Power on the appliance (virtual machine).

14 Continue with Section 4.2, “Initial Appliance Configuration,” on page 36.

4.1.3 Xen Configuration

1 Log in to the host server either locally or from a remote workstation.

You can use the following command to log in to the host server from a remote workstation on 
Linux:

ssh -X root@host_ip_address

You must use the -X in the command in order to display the GUI installation program. The steps 
in this section use the GUI installation program to configure the server.

2 Navigate to the /var/lib/xen/images directory on the host server.

3 Create a new directory inside the images directory where you can download the iPrint software. 

The name of this directory must be the same as the name that you plan to use for your iPrint 
virtual appliance. For example, if you plan to name the iPrint appliance iPrint1, the name of this 
new directory must also be iPrint1.

4 Change to the directory that you just created. For example, /var/lib/xen/images/iPrint1.
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5 Download the iPrint software (iPrint.x86_64-version.xen.tar.gz) to the current directory on 
the host server. For example: /var/lib/xen/images/iPrint1

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the software from this location (http://
download.novell.com/Download?buildid=9xcn1vXns5A~) on the Novell Downloads page (http://
download.novell.com).

6 Untar the iPrint.x86_64-version.xen.tar.gz file in the directory where you downloaded it.

You can use the following command to untar the file:

tar -Sxvzf iPrint.x86_64-version.xen.tar.gz

A iPrint-version directory is created, which contains a .raw file that you will use to run the 
virtual image. This process can take a few minutes.

7 From the host server, run the following command to launch the GUI configuration menu:

vm-install

The Create a Virtual Machine wizard is displayed.

8 Click Forward.

9 Select I have a disk or disk image with an installed operating system, then click Forward.

10 Leave SUSE Linux Enterprise Server 11 selected, then click Forward.

11 Rename the virtual machine by clicking Name of Virtual Machine, then specifying a new name in 
the Name field. Then click Apply. For example, iPrint1.

12 Configure the amount of memory and number of CPUs that Xen allocates for the iPrint 
appliance. 

12a On the Summary page, click Hardware, then specify the following information:

Available Memory: Displays the amount of available memory that is available on the host 
server.

Initial Memory: 4 GB is the recommended minimum amount of memory.

Maximum Memory: Set this to the same value that you set for Initial Memory.

Available Processors: Displays the number of available processors on the host server.

12b Click Apply.

13 Configure the bootable disk image:

13a On the Summary page, click Disks.

13b Click Harddisk.

13c On the Virtual Disk page, specify the following information:

Source: Click Browse, then browse to the .raw file that you untared in Step 6.

Protocol: Select file:.

Size (GB): The default size is 40.1 GB. This cannot be changed.

Create Sparse Image File: This option is not available.

Read-Only Access: Do not select this option.

13d Click OK.

14 (Optional) Create a separate Xen hard disk. You must add a hard disk to the virtual machine 
before you choose this option. If you have not already added a hard disk, click Power Off Virtual 
Machine, modify the virtual machine settings to add a hard disk, then power on the virtual 
machine.
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NOTE: If you do not add a hard disk to the virtual machine, then iPrint Appliance is installed on 
the default partition. The default partition is /sda.

14a On the Disks page, click Harddisk.

14b On the Virtual Disk page, specify the following information:

Source: This field should already contain the path to the .raw file that will be created when 
the virtual machine is created. If desired, you can rename the disk in the source field from 
disk0 to a name of your choosing.

Size (GB): Specify the amount of hard disk space that you want to allocate. 40 GB is 
recommended.

15 Click OK > Apply.

16 Click OK to save your changes and to create and power on the virtual machine.

IMPORTANT: Do not power on the appliance until you have created a separate Xen hard disk 
for the appliance, as described in Step 14.

17 Continue with Section 4.2, “Initial Appliance Configuration,” on page 36.

4.1.4 Hyper-V Configuration

1 Log in to the host server either locally or from a remote workstation.

You can use Windows Remote Desktop to log in to the host server from a remote workstation.

2 Create a new directory in the location where you want each virtual machine to reside (for 
example, C:\Users\Public\Documents\Hyper-V\Virtual Hard Disks). In a later step, you 
will download the iPrint software to this directory. 

As a best practice, give this directory the same name as the name that you plan to use for your 
iPrint virtual appliance. For example, if you plan to name the iPrint appliance iPrint1, the name 
of this new directory should also be iPrint1.

3 Download the iPrint software (iPrint.x86_64-version.vhd.zip) to the directory on the host 
server that you created in Step 2.

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the software from this location (http://
download.novell.com/Download?buildid=9xcn1vXns5A~) on the Novell Downloads page (http://
download.novell.com).

4 Extract the iPrint.x86_64-version.vhd.zip file to the directory on the host server that you 
created in Step 2.

5 Open the Hyper-V Manager.

6 In Hyper-V Manager, right-click the disk name in the Action Pane in the left-hand column of the 
Hyper-V Manager window. This is the disk where you want to create the new virtual machine. 
Then click New > Virtual Machine.

The New Virtual Machine Wizard is displayed.

7 Review the Before You Begin page, then click Next.

8 In the Name field, specify a name for the new virtual machine. For example, iPrint1.

9 Click Next.

10 In the Startup memory field, specify the amount of memory (in MB) to allocate to the virtual 
machine. 4 GB is the recommended minimum for a iPrint.

11 Click Next.
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12 On the Configure Networking page, select the networking card of your choice, then click Next.

13 Configure the bootable disk image:

13a On the Connect Virtual Hard Disk page, select Use an existing virtual hard disk, then 
browse to the .vhd file that was in the downloaded .zip file that you extracted in Step 4.

13b Click Open to select the file, then click Next.

14 Click Finish.

15 (Optional) Create a separate Hyper-V hard disk for the appliance. You must add a hard disk to 
the virtual machine before you choose this option. If you have not already added a hard disk, 
click Power Off Virtual Machine, modify the virtual machine settings to add a hard disk, then 
power on the virtual machine.

NOTE: If you do not add a hard disk to the virtual machine, then iPrint Appliance is installed on 
the default partition. The default partition is /sda.

15a In Hyper-V Manager, right-click the disk that you just created, then click Settings.

15b In the Hardware section, select IDE Controller 1, select Hard Drive, then click Add.

15c Select Virtual hard disk, then click New.

15d Review the Before You Begin page, then click Next.

15e On the Choose Disk Format page, select VHD, then click Next.

15f On the Choose Disk Type page, select Fixed size, then click Next.

15g On the Specify Name and Location page, specify the following information, then click Next:

Name: Specify a name for the hard disk. For example, iPrintDisk2.

Location: Specify the location where you want the hard drive to be located. 

16 On the Configure Disk page, select Create a new blank virtual hard disk, then specify a size for 
the hard disk. 40 GB is recommended.

17 Click Next.

18 Review the summary information, then click Finish.

19 Click Apply > OK.

20 Right-click the virtual machine, then click Start.

IMPORTANT: Do not start the appliance until you have created a separate Hyper-V hard disk for 
the appliance, as described in Step 15.

21 Right-click the virtual machine, then click Connect.

22 Continue with Section 4.2, “Initial Appliance Configuration,” on page 36.

4.2 Initial Appliance Configuration
1 After you have downloaded the iPrint appliance, configured the virtual environment, and 

powered on the appliance, click the Console tab. 

2 After the appliance starts, select your preferred keyboard layout in the Keyboard Language drop-
down, then accept the license agreement by clicking Accept. 

You can change the language in the agreement from the License Language drop-down.

The Novell iPrint Appliance Passwords and Time Zone page is displayed.
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3 On the Novell iPrint Appliance Passwords and Time Zone page, specify the following network 
information:

Root password and confirmation: The root password for your iPrint appliance.

Vaadmin password and confirmation: The preferred user to use when logging in to the 
appliance.

NTP Server: The IP address or DNS name of the reliable external Network Time Protocol (NTP) 
server your OES server uses. For example, time.example.com.

For the best results, set up NTP in accordance with the VMware best practices guidelines.

Region: Your local region.

Time Zone: Your local time zone.

4 Click Next.

5 On the Novell iPrint Appliance Network Settings page, specify the following information:

Hostname: The fully qualified DNS host name associated with the appliance’s IP address. For 
example, myiPrint.mynetwork.example.com.

IP Address: The static IP address for the appliance. For example, 172.17.2.3.

Network Mask: The network mask associated with the appliance’s IP address. For example, 
255.255.255.0.

Gateway: The IP address of the gateway on the subnet where your iPrint virtual appliance is 
located. For example, 172.17.2.254.

DNS Servers: The IP address of a primary DNS server for your network. For example, 
172.17.1.1.

Domain Search: The domain where the iPrint Appliance is located. For example, 
mynetwork.example.com.

6 Click Next.

7 Select the Hard Drive.

If you created a secondary VMware hard drive for this appliance, it is automatically detected and 
sdb is displayed as the hard drive. If you have not created a secondary VMware hard drive, sda 
is chosen as the default partition.

If you have added a secondary hard drive, specify the following options:

Hard Drive: Select the hard drive you are using.

Create a new partition: Select this option to create a new partition.

Filesystem type: Specify the type of file system.

8 Click Configure.

If you have not created a secondary hard drive, you will notice a warning message. You can 
change the settings by clicking Power Off Virtual Machine, or you can choose to continue the 
installation by clicking Continue.

The iPrint Appliance installation process begins. A message stating, “The system is ready for 
appliance configuration” is displayed. After the installation is complete, a URL and an IP address 
to access the iPrint Appliance Management Console is displayed. Using a Web browser, 
navigate to the Management Console URL.

NOTE: Ignore the WARNING message that is displayed in the command prompt.

The iPrint Appliance installation is now complete. You must configure iPrint Appliance before you can 
start printing. Continue with Chapter 5, “Configuring Print System,” on page 39.
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5 5Configuring Print System

You can configure iPrint Appliance through the iPrint Appliance Management Console (Novell iPrint 
Appliance Administration).

 Section 5.1, “Setting Up iPrint Appliance,” on page 39

 Section 5.2, “Creating Users,” on page 43

 Section 5.3, “Configuring Printer Drivers,” on page 43

 Section 5.4, “Creating Printers,” on page 49

 Section 5.5, “Configuring Printing Through Mobile Devices,” on page 59

 Section 5.6, “What’s Next,” on page 69

5.1 Setting Up iPrint Appliance
You can set up iPrint Appliance as a new copy, or you can upgrade from an earlier version.

1 On a Web browser, use either the DNS name or the IP Address to access the Management 
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

Ignore the security certificate warning, and continue to the iPrint Appliance Management 
Console. To avoid the security warning prompt every time you access the iPrint Appliance 
Management Console, you can add the certificate to the trusted certificates list on your browser.

2 Specify vaadmin or root as the user name.

3 Specify the password, then click Log in.

The Management Console page is displayed.

4 Click iPrint Appliance Configuration.

The iPrint Initial Configuration Wizard window is displayed.

5 Select New or Upgrade, then click Next.

 Section 5.1.1, “New,” on page 39

 Section 5.1.2, “Upgrade,” on page 41

 Section 5.1.3, “Post-Upgrade,” on page 42

5.1.1 New

1 Specify the following information:
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Table 5-1   iPrint Initial Configuration Wizard

General Authentication Realm: Specify the authentication 
domain. All the Windows and Mac desktop clients on 
your network authenticate against the Authentication 
Realm. 

iPrint Appliance has its own internal user store. 
Therefore, independent Authentication Realms are 
possible. The administrator can setup each appliance 
to only use its internal user store, or integrate with 
other user sources by using the LDAP Import feature. 
The administrator can set the Authentication Realm 
independently for each iPrint Appliance, or use the 
same Authentication Realm on all appliances for a 
single-sign-on ability.

DNS for Print Manager: Specify the DNS name in the 
format displayed in the box. It is recommended that 
you do not use the DNS name of iPrint Appliance. 
Specify a DNS name that follows the Print Manager.

The DNS name is important for the Windows and Mac 
desktop clients. It allows you to move the server 
without interrupting the workstations. The DNS name 
must resolve to the IP address of the Appliance. You 
must validate that the DNS address is correct and 
functional before continuing because a wrong DNS 
address can result in errors.

The DNS name is also known as a CNAME record. It 
is a DNS name tied to a service, rather than a server. If 
you choose to specify a CNAME record, ensure that 
the chosen name resolves to the IP address of iPrint 
Appliance.

Embedded Data Store The credentials in this section are used to log in to the 
iManager interface.

Administrator Username: The administrator account 
user name is pre-populated in the following format: 
cn=admin,o=iPrintAppliance. This field is not 
editable.

Administrator Password: Specify the password for 
the administrator account. Administrator password is 
the eDirectory administrator Password. It is used for 
eDirectory and iManager.

Re-type Password: Specify the password again to 
confirm.
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NOTE: If you configure a Remote Driver Store, you must manage (using iManager) the Remote 
Driver Store from the machine where the Driver Store resides. 

2 Click Finish.

After configuring iPrint Appliance, you must create printers. You can create printers using the 
Management Console. If you have an existing iPrint Appliance or OES iPrint system, you can also 
import printers. To create printers, see Section 5.4, “Creating Printers,” on page 49.

5.1.2 Upgrade

When upgrading to a new version of iPrint Appliance from an older version, ensure that the newly 
deployed version of iPrint Appliance has the same network configuration, passwords, and time zone 
as that of the older version of iPrint Appliance from which you exported the iprintconfig.zip 
configuration file. For more information about iprintconfig.zip, see Section 3.6.1, “Exporting the 
Configuration File,” on page 30.

1 On a web browser, use either the DNS name or the IP Address to access the Management 
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

Ignore the security certificate warning, and continue to the iPrint Appliance Management 
Console.

2 Specify vaadmin or root as the user name.

3 Specify the password.

The Management Console page is displayed.

4 Click iPrint Appliance Configuration.

The iPrint Initial Configuration Wizard window is displayed.

5 Select Upgrade, then click Next.

6 In the File option, click Choose File, then select the configuration file exported from a previous 
copy of iPrint Appliance.

Driver Store Local: If you want to use a local Driver Store, select 
Local. You can manage the Local Driver Store using 
iManager.

Remote: If you have an existing Driver Store 
configured with another iPrint Appliance or OES 
server, you can use that Driver Store by selecting the 
Remote option, then specifying the DNS Name/
Address, User name and Password of the server 
containing the Driver Store.

You can share the Driver Store with all your appliances 
and even your existing OES environment. This allows 
you to upload drivers to a single source and share the 
drivers with all appliances on your network. The Driver 
Store simplifies administration effort across your 
enterprise.

NOTE: Specify the admin credentials in FDN format 
(for example, cn=admin,o=companyname) of the 
server where the Driver Store resides.
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7 Specify the eDirectory Password.

NOTE: eDirectory Password is the password that you specified when exporting the configuration 
file from the previous copy of iPrint Appliance.

8 Click Finish.

IMPORTANT: If you have an existing remote renderer with the iPrint appliance, then post-
upgrade of this appliance, you must download, install, and register the new remote renderer from 
the Management Console. You must upgrade the renderer, else it remains in inactive state. 

If you are using a FireFox browser, on successful upgrade, you might not receive a completion 
message, even if the upgrade is successful.

5.1.3 Post-Upgrade

 If the iPrint Appliance you are upgrading from uses third party certificates, then post-upgrade 
perform the following steps on the iPrint Appliance 1.1:

1. Modify the passphrase of the certificate in the /etc/ssl/servercerts/passphrase.sh 
file:

#!/bin/bash
echo "changeit"

Replace the string changeit to the passphrase that you used when generating the 
certificate key.

2. Modify the SSLCertificateChainFile attribute in the /etc/apache2/vhosts.d/vhost-
ssl.conf file to iPrint Appliance 1.1 certificate chain file location. 

3. Restart the Apache service using the following command:

rcapache2 restart
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5.2 Creating Users
You can either import your users from an existing LDAP eDirectory or Active Directory source, or you 
can create local users on iPrint Appliance.

 Section 5.2.1, “LDAP Import from eDirectory or AD Source (Recommended),” on page 43

5.2.1 LDAP Import from eDirectory or AD Source 
(Recommended)

To set up iPrint Appliance and import printers, you must first import users from your LDAP source. For 
information on how to import users from an LDAP source, see Section 8.1.7, “LDAP Import,” on 
page 97.

5.3 Configuring Printer Drivers
A printer driver or PostScript Printer Description (PPD) file is software that directly supports a physical 
printer, enabling it to carry out its functions.

Hardware vendors develop printer drivers and PPD files, which are specific to each printer. Most 
printers require different printer drivers for each operating system they interact with. You can use 
iManager to view a list of printer drivers and PPD files you have uploaded to the Driver Store. You can 
add printer drivers and PPD files from diskettes, CDs, and the workstation operating system. 

iPrint Appliance ships with a default Linux driver that is used by the local renderer for mobile printing. 
To modify the default Linux driver, see Section 5.3.4, “Modifying the Default Linux Driver Used by the 
Local Renderer for Mobile Printing,” on page 48.

 Section 5.3.1, “Prerequisites,” on page 43

 Section 5.3.2, “Uploading Drivers By Using iManager,” on page 43

 Section 5.3.3, “Uploading Drivers By Using Command Line,” on page 47

 Section 5.3.4, “Modifying the Default Linux Driver Used by the Local Renderer for Mobile 
Printing,” on page 48

 Section 5.3.5, “Location Of the Linux Printer Drivers,” on page 49

5.3.1 Prerequisites

 Install iPrint Client. For more information, see Section 9.1, “Installing the iPrint Client,” on 
page 147

5.3.2 Uploading Drivers By Using iManager

iManager is a management tool that allows you to manage your print environment. You can create 
printers, printer drivers, profiles, and users.
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Supported Browsers to Upload Drivers Using iManager

NOTE: If you are running iManager from a Windows workstation, you can only add printer drivers for 
Windows. 

You cannot upload drivers from a Windows Server platform. To print documents from your Windows 
server, you must upload the drivers from the Windows workstation that can work with the server 
platform. For more information, see “Windows server and workstation Map” on page 47.

Uploading Drivers to the Driver Store

To upload printer drivers to the Driver Store:

1 In iManager, click iPrint > Manage Driver Store. 

2 Specify the name of the iPrint Driver Store to which you want to add printer drivers.

3 Select the Drivers tab. 

Workstation Supported 
Browser

Upload Linux 
Drivers 

(PPD file)

Upload Windows 
Driver

(.inf file)

Upload Mac 
Drivers 

(PPD file)

Linux Windows Mac

Linux Mozilla Firefox 2.x.x 
or later

Windows Internet Explorer 
6.0 or later

Same version as 
the workstation

Mac Not supported
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4 Use the Drivers Platform drop-down list to select the client platform for which you want to add the 
printer driver.

5 Perform one of the following actions:

 Click Add from File to add printer resources from a printer driver (.inf file or PPD) file.

Linux and Mac: The standard file format is PPD (Postscript Printer Description) file.

Windows: The standard file format is .inf file.

 Click Add from System to add drivers from the workstation where you are running iManager. 

The drivers installed on your workstation are only available to be uploaded to the Driver 
Store.

6 Select a driver, then click OK.

7 Click OK to save your changes.

To display the changes you made, click Refresh.

Deleting Drivers from the Driver Store

1 In iManager, click iPrint > Manage Driver Store. 

2 Select the Drivers tab. 

3 Read the list of existing printer drivers displayed in the Current Drivers panel. 

4 Select a driver, then click Delete.

5 Click OK to save your changes

6 Click Refresh to refresh the screen and display the changes you just made.

Associating the Driver

To set the default driver:

1 In iManager, click iPrint > Manage Printer.
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2 Specify the name of the printer to which you want to set the default driver.

3 Select the Drivers tab. 

4 Use the Drivers Platform drop-down list to select the client platform for which you want to set the 
printer driver for the selected printer.

5 In the Available drivers, select the printer driver you want to associate with the selected printer. 

This field displays a list of printer drivers that have been uploaded for this operating system. If 
you do not want a printer driver to be used, select None.

NOTE: If no printer driver is selected, you cannot print from a desktop client to that printer. For 
mobile printing, the default driver will be used to render jobs for that printer.
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Windows server and workstation Map

For example, To print from Windows 2008 server, associate the printer with Windows Vista driver. 

5.3.3 Uploading Drivers By Using Command Line

You can upload drivers from your workstation or from an iPrint Appliance server.

 “Workstation” on page 47

 “iPrint Appliance Server” on page 47

Workstation

iprntcmd is a command-line utility that helps you manage iPrint tasks on your workstation. To upload 
the drivers to the driver store, run the following commands on your workstation:

Windows Client:  Execute the following command:

iprntcmd -U <ids_address> <username> <password> <INF path>

where ids_address is the IP address or DNS name of the driver store, username and password are 
credentials of the user who has rights to add the drivers to the driver store and INF path is the path of 
the printer driver file.

Linux Client and Mac Client: Execute the following command:

iprntcmd -u <ids_uri> <PPD path>

where ids_uri is the IP address or DNS name of the driver store, and PPD path is the path of the 
printer driver file.

iPrint Appliance Server

iprntman is a command-line utility that helps you manage iPrint tasks on the iPrint Appliance server.

Linux: Execute the following command:

iprntman driver linux --upload --from-ppd <PPD path> -u <eDir username> -P <eDir 
password>

where PPD path is the path of the printer driver file, eDir username and password are credentials of 
the eDirectory user who has rights to add the drivers to the driver store.

Windows Desktop Windows Server

Windows XP (32-bit) Windows 2003

Windows Vista (64-bit) Windows 2008

Windows 7 (64-bit) Windows 2008 R2

Windows 8 or 8.1 (64-bit) Windows 2012 or 2012 R2
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5.3.4 Modifying the Default Linux Driver Used by the Local 
Renderer for Mobile Printing

iPrint Appliance ships with a default Linux driver that is used by the local renderer for mobile printing. 
Remote renderer does not include any driver, you must upload the drivers available in the driver 
store.

To modify the default Linux driver:

1 On a Web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify root or vaadmin as the user name.

3 Specify the password for the administrator.

The Management Console page is displayed.

4 Click iPrint Appliance Configuration.

5 Under Administration, click Renderers.
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6 On the Renderers page, select the iPrint Local Renderer, then click Edit.

7 In the Default Printer Driver drop-down list, select the driver that you want to set as default for the 
local renderer. 

NOTE: The drivers from the driver store are listed in the Default Printer Driver field. 

If a printer does not have a driver associated to it, the default printer driver is automatically used 
to print the documents.

5.3.5 Location Of the Linux Printer Drivers

iPrint Appliance ships with a default Linux driver that is uploaded to the Driver Store and used by the 
local renderer for mobile printing. 

If you want to modify the default Linux driver, the appliance is also bundled with additional Linux 
printer drivers. To associate the drivers, you must upload the drivers to the Driver Store. The location 
of the drivers is /usr/share/cups/model and /usr/share/cups/model/manufacturer-PPDs/
hplip. 

To extract the relevant driver, execute the following command:

gunzip <path to ppd.gz>

For example, gunzip /usr/share/cups/model/epson24.ppd.gz

Using iManager or CLI, you can upload the drivers to the Driver Store.

You can also download the Linux drivers from the OPEN PRINTING (http://www.openprinting.org/
printers) website and then upload to the Driver Store for association.

5.4 Creating Printers
Before configuring the printer, you must create printers on iPrint Appliance. You can use any one of 
the following methods to add printers to iPrint Appliance.

 Section 5.4.1, “Migrating Printers from an OES iPrint System,” on page 50

 Section 5.4.2, “Creating Printers Using iManager,” on page 56

 Section 5.4.3, “Bulk Printer Import Using a CSV File,” on page 57
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5.4.1 Migrating Printers from an OES iPrint System

During process of migration iCM settings and ACLs are automatically migrated to the iPrint Appliance 
and depending on your selection printers, drivers, driver profile, and printer configuration details are 
migrated. 

Prerequisites

 All users are migrated from OES to iPrint Appliance by using LDAP Import. For information on 
how to import users from an LDAP source, see Section 8.1.7, “LDAP Import,” on page 97.

 Enable SSH service on the appliance. To enable SSH, see Section 7.6, “System Services,” on 
page 87. By default, the ssh service is disabled. 

Using iPrint Appliance you cannot launch the Migration GUI. You must connect from another 
computer to the iPrint Appliance, then launch the Migration GUI using SSH (Windows) or terminal 
(Linux or Mac). 

Migrating Printers

1 Launch the Migration Tool either from your Windows, Linux or Mac.

1a To connect to the iPrint Appliance by using Windows (SSH):

1a1 Launch SSH Client and connect to the iPrint Appliance. You must have X server 
running on your computer.

1b To connect to the iPrint Appliance by using Linux or Mac:

1b1 Launch the terminal, then run the command ssh -X <iPrintApplianceIPaddress>.

2 Log in as the root user and at the command prompt, enter miggui.

3 (Optional) Click Save Project. If you save a project, the next time you want to import printers, you 
can use the saved file to retrieve your preferences instantly.

4 Specify the credentials to authenticate to the source and iPrint Appliance server.

If the source server is OES 2 SP3 or OES 11, specify the password for authentication in the root 
Password field.
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5 Click Add.

6 Select Novell iPrint, then click OK.

7 In the Configure Service dialog box, click Yes. The iPrint configuration windows is displayed.
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8 Configure the following parameters to proceed with the migration process: 

Print Objects Parameter  Description

Print Managers Source Print Manager Specify the active Print Manager on the source server. The 
source Print Manager can be either an NDPS manager (for 
NetWare 6.5) or iPrint Manager (OES 2 SP3 or OES 11). To go 
directly to a context of your choice, specify the context in the 
search base and click Search. The objects in the specified 
context are displayed.
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Target Print Manager The Target Print Manager field is populated with the name of 
the active Print Manager running on the target server. This field 
is editable; you can also specify a different name for the active 
Print Manager. To go directly to a context of your choice, 
specify the context in the search base and click Search. The 
objects in the specified context are displayed.

Click Get Printers to select printer objects from the source Print 
Manager.

Printer Objects Source printers Displays all printers of the active Print Manager available on 
the source server. The printers that already exist on the target 
server are indicated by an asterisk (*).

Select All Selects all the printers listed in the Printer Objects dialog box.

NOTE: When you apply a new filter or modify an existing filter 
and click Select All, only printers that are displayed after 
applying the filter are selected. When you manually select all 
printers, the selected printers are migrated.

Filter Specify the search pattern in the Filter field. This displays the 
printers in the Printer Agents list. This field is case sensitive.

Create target 
printer objects 
in

Context same as 
source printer context

Select this option to use the same context as the source 
printers on the target server. 

Target context This option is selected by default. It allows you to create source 
printers under a different context on the target server. This 
option does not maintain the context hierarchy of the source 
printer.

To go directly to a context of your choice, specify the context in 
the search base and click Search. The objects in the specified 
context are displayed.

Do Not Migrate Existing 
Target Printers

If the printer names on the source server match the printer 
names on the target server, the target printer properties and 
attributes are overwritten by the source printer properties and 
attributes. 

The printers that already exist on the target server are 
represented by an asterisk (*).

Print Objects Parameter  Description
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Other Options Parameter  Description

Source Driver 
Store 

The Source Driver 
Store is not on the 
same server as the 
Source Print Manager

If the source Driver Store is running on a server different from 
the source Print Manager's server, this check box is selected.

Specify the IP address or the DNS Name and the root 
password of the server on which the source Driver Store is 
located.
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Migrate the following 
additional Source Print 
Brokers to the Target 
Driver Store

This section lists the names and IP/DNS addresses of the 
source Print Broker volumes that must be migrated to the target 
Driver Store.

Click the plus button (+) and specify the IP address or the DNS 
name of the Source Broker. Select the Source Broker volume 
from the drop-down list and click OK. The list is populated with 
the IP address or DNS name of the Source Broker and Broker 
volume name. You can add multiple Source Brokers to the list.

To remove the Source Broker from the list, select the IP 
address or DNS name and click the minus button (-). You can 
remove one Broker at a time.

Target Driver 
Store

Target Driver Store is 
remote

If the Driver Store is running on the remote server (other than 
the target server), the Target Driver Store is remote check box 
is enabled.

Specify the IP address or the DNS name of the remote server 
and the root password of the remote server in the 
corresponding entry fields.

Printer Drivers Do not Migrate Printer 
Drivers and the 
association of the 
Printer Agents with the 
Driver

Selecting this option ensures that printer drivers and the 
association of Printer Agents with the drivers are not migrated.

Migrate Printer Driver if 
the driver is not present 
in the target Driver 
Store

Selecting this option migrates the printer drivers for the 
selected driver platforms from the Select Driver Platforms to 
Migrate list, if they are not present in the target Driver Store. 
This also migrates all the associations of the Printer Agents 
with the driver.

NOTE: The default driver platform selection is All.

Migrate all Printer 
Drivers. This overwrites 
the Printer Driver on 
the target Driver Store

Selecting this option overwrites the target drivers for the driver 
platforms you have selected from the Select Driver Platforms to 
Migrate list, if the driver names in the target Driver Store are the 
same as the source Driver Store. This also migrates all the 
associations of the Printer Agents with the driver.

NOTE: The default Driver Platform selection is All.

Printer Driver 
Profile

Migrate Printer Driver 
Profile

If the profiles are the same on the target server as the source 
server, the target profiles are overwritten.

iPrint.ini File Migrate iPrint.ini File If you migrate printer agents from two or more print managers, 
the iPrint.ini file on the target server is replaced by the 
iPrint.ini file of the last source server.

NOTE: After migration, if the target server's iprint.ini file is 
overwritten by the source server's file, and if the target server's 
iprint.ini file had new parameters that were erased, you 
can restore them by copying the parameters manually from the 
iprint.bak file. The iprint.bak file is a backup of the 
target server's iprint.ini file. After migration, the 
iprint.bak file is saved in the /var/opt/novell/
iprint/htdocs directory.

Other Options Parameter  Description
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9 Click OK to finish the configuration and go back to the migration screen.

10 Click Migrate to begin the migration process.

Using iManager, you can verify the details of the migrated printers.

5.4.2 Creating Printers Using iManager

1 On the iPrint Appliance Management Console page, select the iPrint Printer Configuration 
(iManager) tool to connect to iManager.

2 Log in to iManager using the eDirectory admin credentials of iPrint Appliance.

Ignore the security certificate warning, and continue to the iPrint Appliance Management 
Console. If you add the certificate to the trusted certificates list, the security warning is not 
displayed.

3 Click iPrint > Create Printer.

4 Specify the Target printer details.

Printer Name: Defines the label by which the new printer is identified. You can include 
uppercase and lowercase letters, numbers, spaces, and underscore in the label. Do not use any 
other characters.

Container Name:  The eDirectory container where the printer reference resides. By default, the 
value is “iPrintAppliance”. We do not recommend changing the default value.

Print Manager name: The name of the Print Manager that handles the incoming print jobs.

DNS name or IP address:  The IP address of a printer uniquely identifies it on the network and 
allows other networked machines to communicate with it. A DNS name can also be applied to 
the printer, which can be translated into the printer's IP address.

Specify the IP address (v4) or the DNS name of the target printer.

Location: Indicates the printer's location. The value of this field is displayed when selecting a 
printer.

Description: Describes the printer. The value of this field is displayed when selecting a printer.

LPR Printer Name: Specify an LPR printer name. If the LPR protocol is selected, other optional 
parameters can also be specified. With most modern printers, the name can be set to 
PASSTHROUGH. With some older printers (1990's & prior), there might be a different printer 
name.

RAW Port Number: If the RAW protocol is selected, a port number is required. Most printers are 
configured, by default, to use port 9100 for RAW protocol communications.

iPrint Appliance supports printer communications using either the Line Printer Remote (LPR) or 
RAW protocols.

The LPR protocol is the most common printing protocol and is generally more flexible than the 
RAW protocol. A printer that supports the LPR protocol is sometimes referred to as a TCP/IP 
printer. The LPR protocol has limited error reporting capabilities, which is often limited to “Printer 
Error” with no details.

The RAW protocol is often the default protocol on non-Windows systems. Most printers that 
support the RAW protocol use port 9100. The LPR protocol can generally be substituted for the 
RAW protocol if the RAW protocol does not respond to a print job.

5 Click Next.

6 Specify the drivers for the printer.

iPrint Appliance supports both driver and driverless printing. For mobile device printing, drivers 
are not required. The selectable drivers for each operating system are available in the Novell 
iPrint Appliance Driver Store.
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7 To re?edit the printer?specific options after the new printer has been created, click Modify. To 
create another printer, click Repeat Task. To continue, click OK.

NOTE: In iManager, you might see a Partition and Replicas option. This feature is not required 
for iPrint Appliance, so it is not supported. We recommend that you do not use it on the iPrint 
Appliance eDirectory.

IMPORTANT: In iManager, do not create or delete Print Manager objects. Always use the 
default Print Manager object.

IMPORTANT: By default, iPrint Appliance supports only PostScript printers. For non-PostScript 
printers like PCL, or for printers that do not work with the default PostScript driver, you must associate 
appropriate drivers to the printers. 

5.4.3 Bulk Printer Import Using a CSV File

You can import printers into iPrint Appliance through a csv file. On successful import the printers 
resides in the container O=iPrintAppliance.

You must create a csv file, then import the csv file into iPrint Appliance. The csv file must contain the 
following fields in the same order:

PrinterName,PrinterIP,Location,Description,Win95_98_Driver,Winnt_Driver,Win2k_Driv
er,Winxp_Driver,Linux_Driver,Mac_Driver,Vista32_Driver,Vista64_Driver,Win732_Drive
r,Win764_Driver,Win832_Driver,Win864_Driver,Win1032_Driver,Win1064_Driver,Enable 
DirectPrinting,Secure Printing,Enable Auditing,LPR/RAW,Raw Port

NOTE: You cannot enable both direct printing and auditing. If enabled, both options are disabled 
when creating the printers.

Table 5-2   Parameter Description of CSV File 

Parameter Description Value

(Mandatory/Optional)

PrinterName Name of the printer that you want to import Mandatory

PrinterIP IP Address assigned to this printer

NOTE: Specify only the IP address. Printer 
creation fails if DNS name is specified. 

Mandatory

Location Location of the printer Optional

Description Details of the printers like make, model, and so 
forth.

Optional

Win95_98_Driver Driver associated with this printer for Windows 95 
and Windows 98 platform.

Optional

Winnt_Driver Driver associated with this printer for Windows 
NT platform.

Optional

Win2k_Driver Driver associated with this printer for Windows 
2000 platform.

Optional
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IMPORTANT: In the csv file, you must specify at least one driver for each printer. For all optional 
parameters, you must include a empty string. 

Winxp_Driver Driver associated with this printer for Windows 
XP platform.

Optional

Linux_Driver Driver associated with this printer for Linux 
platform.

Optional

Mac_Driver Driver associated with this printer for Mac 
devices.

Optional

Vista32_Driver Driver associated with this printer for Windows 
Vista 32-bit platform.

Optional

Vista64_Driver Driver associated with this printer for Windows 
Vista 64-bit platform.

Optional

Win732_Driver Driver associated with this printer for Windows 7 
32-bit platform.

Optional

Win764_Driver Driver associated with this printer for Windows 7 
64-bit platform.

Optional

Win832_Driver Driver associated with this printer for Windows 
8.x (32-bit) platform.

Optional

Win864_Driver Driver associated with this printer for Windows 
8.x (64-bit) platform.

Optional

Win1032_Driver Driver associated with this printer for Windows 10 
32-bit platform. Windows 10 uses the same driver 
as Windows 8.x.

Optional

Win1064_Driver Driver associated with this printer for Windows 10 
64-bit platform. Windows 10 uses the same driver 
as Windows 8.x.

Optional

DirectPrinting Enable direct printing for this printer. Value is yes 
or no. By default, this option is disabled. You 
cannot enable both direct printing and auditing. 

Optional

Secure Printing Enable secure printing for this printer. Value is 
yes or no. By default, this option is disabled.

Optional

Enable Auditing Enable auditing of this printer. Value is yes or no. 
By default, this option is disabled.

Optional

LPR/RAW Protocol to be used by this printer. Value is LPR 
or RAW. By default, the value is LPR.

Optional

Raw Port If you have selected RAW protocol, specify the 
port number. 

Optional

Parameter Description Value

(Mandatory/Optional)
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Example of a CSV file

If you have to migrate 2 printers (printer1 and printer2) for a Windows 8 32-bit platform. The csv file 
includes:

printer1,10.0.0.1,1st_floor,HP LaserJet 4100,,,,,,,,,,,HP LaserJet 4100 PCL 5
,,,,no,yes,yes,LPR,

printer2,10.0.0.2,2st_floor,HP LaserJet 4100,,,,,,,,,,,HP LaserJet 4100 PCL 5
,,,,no,yes,yes,RAW,9100

After you create the csv file, upload the file to iPrint Appliance.

Uploading the CSV File

1 On a Web browser, specify either the DNS name or the IP address. For example, https://
10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify the Username and Password, then click Log in.

3 Click the iPrint Appliance Configuration icon.

4 Click Printers.

5 Click the Bulk Printer Upload button in the upper-right corner of the Available Printers window.

6 Navigate to the csv file, select it, then click OK to begin the printer import process.

Printing is configured for desktops and laptops. To understand how to manage the iPrint client.

To enable printing from mobile devices, proceed to Section 5.5, “Configuring Printing Through Mobile 
Devices,” on page 59.

5.5 Configuring Printing Through Mobile Devices
You can configure printers to accept print jobs through mobile devices, AirPrint or email.

 Section 5.5.1, “Configuring for Mobile Printing,” on page 59

 Section 5.5.2, “Airprint Through iPrint Using mDNS,” on page 60

 Section 5.5.3, “Configuring for Email Printing,” on page 64

 Section 5.5.4, “Generating QR Code for Printer,” on page 69

5.5.1 Configuring for Mobile Printing

1 On a Web browser, use either the DNS name or the IP Address to access the Management 
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

Ignore the security certificate warning, and continue to the iPrint Appliance Management 
Console. If you add the certificate to the trusted certificates list, the security warning is not 
displayed.

2 In the Novell iPrint Appliance Administration login page, enter the user name as vaadmin, enter 
the password that you specified for vaadmin, then click Log in. 

3 Click the iPrint Appliance Configuration icon.

4 Under Administration, click Printers. 
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The Printers screen lists all printers created with iManager that are currently managed by iPrint 
Appliance. You can enable the printers for Mobile, AirPrint, and Email printing for iPrint 
Appliance.

5 Select the printer that you want to configure. You can choose multiple printers at a time by 
holding the Ctrl key. 

The AirPrint, Mobile and Configure drop-down menus are activated.

6 To configure the printers for Mobile and Email printing, click the Mobile drop-down menu, then 
select Enable.

7 The selected printer is enabled for Mobile printing.

5.5.2 Airprint Through iPrint Using mDNS

AirPrint is a framework that facilitates driverless printing. The framework was invented by Apple Inc. 
iOS applications (apps) that implement AirPrint technology allow users to send print jobs to AirPrint 
enabled printers. With iPrint Appliance, you can “AirPrint enable” any iPrint printer.

This section describes the benefits and key features of AirPrint through iPrint:

 “iOS Wireless Printer Discovery” on page 61

 “Multicast DNS” on page 61

 “AirPrint through iPrint” on page 61

 “Benefits” on page 61

 “Supported iOS Devices” on page 61

 “AirPrint Deployment Considerations in iPrint Appliance” on page 62

 “AirPrint Deployment Scenario in iPrint” on page 62

 “Enabling AirPrint through iPrint” on page 63

 “Disabling AirPrint through iPrint” on page 64
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iOS Wireless Printer Discovery

iOS devices have an inherent service discovery mechanism called Bonjour. Bonjour has the wireless 
service identifying capability known as mDNS (multicast DNS). iPrint uses the Linux Avahi daemon 
service to advertise iPrint printers to the iOS devices on a wireless network.

Multicast DNS

Domain Name Service provides translation from a Web address (starting with www) to the Internet 
Protocol (IP) addresses. mDNS (Multicast DNS protocol) is a method of network neighborhood 
resource discovery. mDNS forwards the DNS message to many endpoints on a network. Each device 
connected to an mDNS enabled network sends out a message detailing its name, function, and 
capabilities. On the receiving device, the information is stored so that it can route requests when an 
application requests a service, such as printing.

mDNS is useful in wireless networks. By monitoring mDNS advertisements, clients can learn the 
location of the service, then connect to it in the same way as any other service. mDNS transforms the 
manual process of configuring IP addresses and port numbers that provides a zero configuration 
experience where a user references the service using human-friendly types and names.

AirPrint through iPrint

When iOS devices such as iPhone, iPad, and iPod touch connect to the wireless network, they are 
automatically assigned an IP address. This opens an opportunity to exploit the IP network service for 
printer discovery, and submit the print job. iOS devices convert Microsoft Office files, images, and 
Web pages into PDF; construct an IPP print request; and send the print request to the AirPrint 
enabled IPP printer. The AirPrint enabled IPP printer renders the PDF or image file into a printer-
specific language such as post script. The printer consumes this data and the document is printed. 
This is called AirPrint.

Many printers are not compatible with AirPrint. iPrint hides the printer’s capabilities, and advertises 
the printer as an AirPrint enabled printer. This allows iPrint to extend the enterprise print service into 
the wireless network to exploit the iOS devices’ inherent print capability, and provides additional 
advantages to consume iPrint features.

Benefits

AirPrint through iPrint offers significant benefits over other printing models:

 Any iPrint printer can be enabled for AirPrint regardless of the printer’s inherent AirPrint support.

 AirPrint enabled printers are also listed in the iOS device.

 AirPrint enabled printers can make use of the iPrint server’s features.

Supported iOS Devices

Supported iOS devices include iPhone, iPad, and iPod touch with iOS 5 and above.

NOTE: Secure printing to iPrint printers through AirPrint is supported only on iOS 6.x and later 
versions.
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AirPrint Deployment Considerations in iPrint Appliance

The mDNS protocol operates on service announcements and queries, which allow devices to 
advertise specific applications, such as printing services. Each query or advertisement is sent to an 
mDNS multicast address for delivery to all clients on the subnet. Apple's Bonjour protocol relies on 
Multicast DNS (mDNS) operating at UDP port 5353. iOS devices listen for services on these reserved 
group addresses:

 IPv4 Group address - 224.0.0.251

The addresses used by the mDNS protocol are link-local multicast addresses and are valid on the link 
local domain. Hence, routers might have to be enabled, in order to forward the multicast 
advertisement to various subnetworks.

AirPrint Deployment Scenario in iPrint

The deployment scenarios are confined to the wireless-based LAN network because iOS devices can 
only communicate over the wireless medium for the printer discovery and print services. The 
deployment scenario varies based on how wireless is configured in the organization. The preferred 
scenario is to deploy iPrint’s AirPrint mDNS services led by the router, which has the ability to route 
the mDNS packets (link local Bonjour advertisement) into the various wireless sub networks in the 
organization. See Figure 5-1.

Intra VLAN Configuration

Wireless routers span across multiple wired networks, and have hot spots on every network. The 
mDNS service advertises printers on the wireless network, and the iOS device builds a list of 
available print services by listening to these advertisements. AirPrint client's users can select a target 
printer from the received list of advertised printers.
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Figure 5-1   Logical Network Segment Configuration

In this configuration, the mDNS advertisement is instantly injected into the network. In the above 
configuration, printer 'A' is visible to VLAN 100 wireless users, and printer 'B' is visible to VLAN200 
wireless users. The printers are not visible across the VLANs.

Enabling AirPrint through iPrint

To enable AirPrint through iPrint:

1 On a Web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify the user name and password, then click Log in.

3 Click iPrint Appliance Configuration.

4 Under Administration, click Printers.

5 Select a printer for which you want to enable AirPrint.

The AirPrint and Mobile drop?down menus are activated.

6 Click the AirPrint drop-down menu, then click Enable Advertising.
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iPrint AirPrint is now enabled on the iPrint printer. You can print to an iPrint AirPrint enabled printer 
from any iOS device.

Disabling AirPrint through iPrint

To disable AirPrint through iPrint:

1 On a Web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify the user name and password, then click Log in.

3 Click iPrint Appliance Configuration.

4 Under Administration, click Printers.

5 Select a printer for which you want to disable AirPrint.

The AirPrint and Mobile drop?down menus are activated.

6 Click the AirPrint drop-down menu, then click Disable Advertising.

IMPORTANT: If a printer is shut down or redirected to another printer, you must disable AirPrint 
advertising. This ensures that users do not receive errors when trying to print to non-functional 
printers.

5.5.3 Configuring for Email Printing

iPrint Appliance contains an email printing feature. Using email printing, you can print documents 
from any device capable of sending emails. You can print emails by specifying email printing 
commands in the subject line of the email. You can also print documents by emailing them to your 
printer as attachments.

When you enable email printing, the email address you provide becomes the global print email 
address. You can also configure a printer for private email printing by providing a specific email 
address to each printer.

NOTE: To enable private email printing, you must first enable the email printing feature.

The difference between global email printing and private email printing is:

 Global Email Printing: When you enable email printing, you are prompted to specify an email 
address. This email address is the global print email address. When configured for email 
printing, iPrint Appliance becomes a client to an email server. The global email account inbox is 
polled for incoming print jobs, which are then routed to the intended printer.

 Private Email Printing: With private email printing, you can assign a specific email address to 
each printer. When a user sends an email printing request, the print job is sent directly to the 
printer. Users do not need to specify any print commands in the subject line of the email.

Email printing is not enabled by default. You can enable email printing through the Management 
Console. You must create a unique email address for iPrint Appliance to receive and process print 
requests.
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IMPORTANT: If you enable auditing for email print jobs, the email address of the user is logged in the 
iPrint audit logs. If the same email address is populated for the user object in the LDAP source, then 
the user FDN is logged instead of email address. This is important if you are using an accounting 
software to ensure that jobs are tracked or accounted correctly.

 “Enabling Email Printing” on page 65

 “Email Printing Commands” on page 66

Enabling Email Printing

1 On a Web browser, use either the DNS name or the IP address of iPrint Appliance to access the 
Management Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify the user name and password, then click Log in.

3 Click iPrint Appliance Configuration.

4 Under Administration, click Mobile Configuration.

5 Choose Enable email-based printing.

This email address is the global print email address.

6 Specify the following information:

Email address: Specify the full email address that is used to queue global print jobs. The global 
email address must be unique for each copy of iPrint Appliance that you deploy.

WARNING: You must create an exclusive email account to be used for iPrint Appliance. If you 
provide an existing email address (for example, your official email address), the iPrint Appliance 
mobile server immediately starts processing all existing emails in the inbox, replies to every mail 
with a response, then deletes all the received emails.

Account Username:  Specify the user name for iPrint Appliance to log in to the email server to 
access the global email account. Account Username must be the user name of the email 
address that you specified in the Email address field.

Account Password: Specify the password for iPrint Appliance to log in to the email server to 
access the global email account.

Re-type Password: Specify the password again to confirm.

Incoming Mail Server: Specify the address of the incoming email server for the email account. 
For example, imap.example.com.

jobs. The default POP3 and IMAP protocol ports are listed below:

Incoming Server Type: iPrint Appliance supports IMAP and POP for incoming print jobs. Select 
the protocol that your email server supports. For more information, see Section A.1, “Incoming 
Mail Server Parameters,” on page 211.

Outgoing (SMTP) Mail Server: Specify the address of the outgoing email server for the email 
account. For example, smtp.example.com. The iPrint Appliance uses SMTP protocols to send 
email back to users who submit email-based print jobs in order to report their job status. For 
more information, see Section A.2, “Outgoing Mail Server Parameters,” on page 212.

Enable Mail-body Printing: With email-based printing, attachments are always printed. This 
option allows the email message body to also be printed.

Polling Interval: Configures the interval (in seconds) at which emails are fetched from mail 
servers.

7 Click Save.
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IMPORTANT: When using email printing, the print command in the subject line might trigger spam 
filters. To avoid this issue, configure your email system to allow print-specific emails. Include the 
approved print users in the spam filter of your email system to prevent unwanted print requests.

Enabling Private Email Printing

1 On a Web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the iPrint Appliance Configuration icon.

3 Under Administration, click Printers.

4 Select a printer, click the Configure drop-down menu, then click Private Email Settings.

5 Specify the following information, then click OK.

Email Printing Commands

You can print the body of the email and the attachments by using a few simple print commands in the 
subject line of your email.

 “Basic Print Commands” on page 66

 “Additional Print Commands” on page 68

Basic Print Commands

help 

Provides information on email printing commands.

list printers 

To get the names of the available printers, send an email to the iPrint server address (for 
example, iprint@novell.com) with the subject line list printers.

Account  Email Address: Specify the full email address of the mailbox to be polled for the 
print jobs. When an email-based job arrives, the print job is processed to the 
printer. For example, print@example.com.

 Username: Specify the user name to be used by iPrint Appliance to log in to the 
email server to access the private printer email account. For example, iprint.

 Password: Specify the password for iPrint Appliance to log in to the email 
server to access the private printer email account.

 Retype Password: Confirm the account password.

Server  Incoming Mail Server: Specify the address of the incoming email server for the 
email account. For example, imap.example.com. 

 Outgoing Mail Server: Specify the address of the outgoing email server for the 
email account. For example, smtp.example.com.

 Access Method: iPrint Appliance supports two different protocols to poll for 
incoming print jobs. Select POP or IMAP depending on the protocol that your 
email server supports.
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print printer=<printer_name> 

Prints your email and its attachments to the specified printer. For example, print 
printer=hp#Test Mail.

If you print to a specific printer by using the printer’s email address, the print printer 
command is ignored.

hold printer=<printer_name> 

Queues your email along with its attachments and sends you the job ID as acknowledgement.

resume 

Resumes the printing of a job that you put on hold. There are two ways to print a job on hold: 

 Send an email with subject resume followed by the job ID. For example, resume 10

 Send an email with the original subject line prefixed with resume. For example, 
resume#Test Mail

cancel 

Cancels a job that you put on hold. There are two ways to cancel a job on hold: 

 Send an email with subject cancel followed by the job ID. For example, cancel 10

 Send an email with the original subject line prefixed with cancel. For example, 
cancel#Test Mail

status 

Displays the status of a job. There are two ways to check the status of a job:

 Send an email with subject status followed by the job ID. For example, status 10

 Send an email with the original subject line prefixed with status. For example, 
status#Test Mail

move 

Moves a job to a new printer. There are two ways to move a job to a new printer:

 Send an email with subject move, the job ID, and the name of the new printer. For example, 
move 10 printer=<PrinterName>

 Send an email with the original subject line prefixed with move, the name of the new printer, 
and #. For example, move printer=<PrinterName>#Test Mail

list jobs 

Lists the details of the held jobs.

default printer 

Displays the default printer.

default printer=<PrinterName> 

Sets a particular printer as your default printer. After you set the default printer, you do not need 
to include the printer name while printing to the default printer. You only need to use the print 
command followed by the email subject. For example, print#Test Mail.

NOTE: If a printer name contains spaces, enclose the printer name within double (") or single (') 
quotes. For example, print printer='HP PRINTER'.
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NOTE:  To separate the email subject from the command, use #. For example, print 
printer=hp#Test Mail.

Additional Print Commands

In addition to the basic print commands listed above, you can use these commands to refine your 
printing:

portrait [portrait=yes/portrait=y (or) portrait=no/portrait=n] 

Prints your email content in portrait orientation. For example, print printer=hp 
portrait=y#Test Mail

landscape [landscape=yes/landscape=y (or) landscape=no/landscape=n] 

Prints your email content in landscape orientation. For example, print printer=hp 
landscape=y#Test Mail

color [color=yes/color=y (or) color=no/color=n] 

Prints your email content in color. For example, print printer=hp landscape=y 
color=y#Test Mail.

pages 

Prints a given range of pages in your email. For example, the command print printer=hp 
landscape=y color=y pages=1-3#Test Mail prints pages 1, 2, and 3.

copies  

Prints the specified number of copies of your email and its attachments. For example, the 
command print printer=hp landscape=y color=y pages=1-3 copies=5#Test Mail prints 
5 copies of pages 1, 2, and 3.

duplex [duplex=yes/duplex=y (or) duplex=no/duplex=n] 

Prints your email and its attachments on both sides of the printing paper. For example, the 
command print printer=hp landscape=y color=y pages=1-3 copies=5 
duplex=y#TestMail prints 5 copies of pages 1, 2, and 3 in duplex mode.

media 

Prints your email and its attachments with the specified paper type. The default paper type is 
“LETTER.” You can change the default paper type by using the iPrint Appliance Management 
Console. The other available print paper types are A3, A4, and other common paper types. For 
example, the command print printer=hp landscape=y color=y pages=1-3 copies=5 
duplex=y media=A3#Test Mail prints 5 copies of pages 1, 2, and 3 in duplex mode, on an A3 
size paper.

mailbody [mailbody=yes/mailbody=y (or) mailbody=no/mailbody=n] 

Prints either your email and its attachments or only the attachments from your email without the 
email body. For example, using the command print printer=hp landscape=y color=y 
mailbody=n#Test Mail prints only the email attachments in landscape mode.

NOTE: If you do not specify any of the additional commands, your print job is carried out according to 
the default preferences set by your administrator.

IMPORTANT: When printing to a specific printer using the printer’s private email address, you do not 
need to specify the printer’s name in the command. You can also leave the subject line empty. 
Printing is carried out according to the default print options set by the administrator. 
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However, you must specify the print command in the following scenarios:

 The administrator changes the subject_optional_for_printer_specific_emails to False in 
the iPrint Appliance Server Configuration file located at /etc/opt/novell/iprintmobile/
conf/iprintmobile.conf.

 If you want to customize the print options, you must specify the print command, along with the 
required print options. For example, print landscape=y color=y pages=1-3 copies=5 
duplex=y media=A3#Test Mail.

5.5.4 Generating QR Code for Printer

User can scan a QR code to select a specific printer on their mobile device. To generate the QR code 
for the printer, perform the following steps:

1 Create a QR code using any QR code generator. 

The generator might include multiple formats, ensure to use Plain text format. 

The format to use is ipp://<server ip or dns>/ipp/<printer name>

where the printer name is case-sensitive.

2 Print the generated QR code and paste it on the printer. 

5.6 What’s Next
iPrint Appliance is now configured for printing through desktop, laptops, and mobile devices. You can 
start printing to iPrint printers.

 For desktop-quality printing on your mobile devices, it is highly recommended that you install the 
remote renderer. You can download the remote renderer from the iPrint Appliance Management 
Console. To install and configure the remote renderer, see Section 6.3, “Installing and 
Configuring a Remote Renderer,” on page 74.

 For managing iPrint Appliance, see Chapter 8, “Managing Print System,” on page 93.
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6 6Document Rendering

iPrint Appliance provides a client-independent and driverless printing environment to mobile users.

 Section 6.1, “What Is a Renderer?,” on page 71

 Section 6.2, “Key Features,” on page 72

 Section 6.3, “Installing and Configuring a Remote Renderer,” on page 74

 Section 6.4, “Upgrading the Remote Renderer,” on page 78

 Section 6.5, “Managing the Remote Renderer,” on page 79

 Section 6.6, “Remote Renderer Commands,” on page 80

6.1 What Is a Renderer?
iPrint now supports printing from mobile devices that have limited abilities to convert documents into 
print-ready formats. On desktop platforms, the documents are usually converted to print-ready 
formats by the application, driver, and the spooler subsystems. This functionality is primitive or non-
existent in many of the mobile devices and hence must be provided by the Print Service. To facilitate 
this, iPrint now provides Rendering and Conversion capabilities in the product and can convert and 
render most of the documents that are submitted by a mobile device, email, or other submission 
methods. 

This conversion (rendering) is performed on the iPrint Appliance using our built-in solution known as 
Local Renderer. Printing quality varies, depending on the document complexity so for enhanced 
desktop-quality printing, you can use the Remote Renderer on a Windows platform. 

You can view the Local renderer and list of remote renderers in the Management Console > iPrint 
Appliance Configuration, Renderers page.

The renderers support broad range of document formats. For more information, see Section C.7, 
“Supported Document Formats By the Local Renderer and Remote Renderer,” on page 217.

6.1.1 Local Renderer

iPrint Appliance is bundled with a built-in document renderer known as Local Renderer. The renderer 
converts documents to the PDF format, and then converts them to the print-ready format using 
CUPS. The renderer supports multiple formats, has a multithreading feature, and provides limited 
support for Microsoft Office formats. If a printer does not have a driver associated with it, the default 
printer driver PostScript 3 is automatically used to print documents.
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6.1.2 Remote Renderer

iPrint Appliance also ships with a Remote Renderer. For enhanced desktop-quality printing, you can 
use the Remote Renderer. The remote renderer can be downloaded from the iPrint Appliance 
Management Console and installed on a Windows 64-bit computer.

The remote renderer provides high quality rendering for different formats. The remote renderer job 
might take some additional time to complete the print jobs in comparison to the local renderer. If you 
do not want to use the built-in PDF renderer, you can also install Adobe Acrobat Pro for PDF 
rendering. However, printing PDF using a built-in pdf renderer there can be some minor print quality 
differences such as color shade difference in the PDFs.

The remote renderer communicates with iPrint Appliance for document conversion. Although, it is not 
a mandatory requirement for iPrint Appliance, the remote renderer is recommended for desktop 
quality printing.

6.2 Key Features
 Section 6.2.1, “Multidriver Support,” on page 72

 Section 6.2.2, “Secure and Non-secure Communication Support (Remote Renderer),” on 
page 72

 Section 6.2.3, “Automatic Printer Driver Updates,” on page 73

 Section 6.2.4, “Printer Rename and Redirection (Remote Renderer),” on page 73

6.2.1 Multidriver Support

On iPrint Appliance 1.1, you can configure the local and remote renderer to use multiple drivers for 
different mobile enabled printer agents. The renderer installs the unique drivers associated with 
various mobile enabled printer agents, on the renderer machine. During the rendering of jobs, the 
correct printer driver is selected based on the printer agent to which the job is being submitted for 
rendering.

If a printer agent does not have any driver associated with the renderer platform, the renderer uses 
the default driver for rendering the jobs sent to those printer agents. You can select a default driver 
when adding a renderer from the Management Console. The Management Console also provides an 
option to change the default drivers.

For information on how to upload printers to the Driver Store, see Section 5.3, “Configuring Printer 
Drivers,” on page 43.

6.2.2 Secure and Non-secure Communication Support (Remote 
Renderer)

On iPrint Appliance 1.1, the remote renderer can communicate over secure and non-secure channels 
with the iPrint Appliance. By default, the iPrint Appliance is set to communicate in both secure and 
non-secure modes.

Secure Communication Mode: When this mode is used, only the secure remote renderers can 
communicate with the iPrint Appliance. For information on how to configure the iPrint Appliance and 
renderer in a secure mode, see “Secure Communication Mode” on page 76.
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Non-secure Communication Mode:  When this mode is used, both secure and non-secure remote 
renderers can communicate with the iPrint Appliance. For information on how to configure the iPrint 
Appliance and renderer in a non-secure mode, see “Non-secure Communication Mode” on page 77.

Non-secure communication mode is desirable in the following scenarios:

 Experiencing problems with third-party certificates

The iPrint Appliance handles third-party certificates well when working with secure web tools and 
authentications from the iPrint Mobile App. However, some third-party certificates can be 
problematic when registering a remote renderer; in these situations, non-secure communication 
mode is convenient because certificates are not used for the remote renderer registration.

 Domain suffix for the iPrint Appliance and the remote renderer does not match

Secure communication mode requires both the iPrint Appliance and the remote renderer to have 
matching DNS domain suffixes. For example, iprintserver.company.com and 
remoterenderer.cityname.company.com will cause the remote renderer registration to fail if the 
secure communication mode is selected. The non-secure communication mode ignores the 
DNS suffix matching requirement.

You can verify the mode of the renderer in the Renderers page under the Secure Mode column.

 If the Secure Mode column displays false, then the renderer is in a non-secure communication 
mode.

 If the Secure Mode column displays true, then the renderer is in a secure communication mode.

6.2.3 Automatic Printer Driver Updates

The local and remote renderer on iPrint Appliance 1.1 supports the Automatic Driver Update feature. 
When a printer driver is updated on the Drive Store, or if the association of a particular printer agent is 
changed, the driver is automatically updated on the renderer. 

Local Renderer:  The driver update and driver association changes takes effect only after 1 hour 
because the value set for driver_update_interval is 1 hour in the iprintmobile.conf file. After 
the default driver time interval, the first print job is rendered by the old driver and the subsequent jobs 
are rendered by the new driver. 

You can modify the driver_update_interval value in the iprintmobile.conf file.

Remote Renderer: All the jobs submitted for printing is rendered by the driver that is currently 
associated with the printer. However, the first print job that is sent for printing after the driver 
association change may take some time to be rendered depending on the size of the driver. This is 
because the remote renderer installs the driver first and then processes it for rendering.

6.2.4 Printer Rename and Redirection (Remote Renderer)

If a printer is renamed or redirected through the Management Console, the remote renderer 
automatically updates its configuration to associate the correct printer drivers with the printer.

When you redirect a printer, the printer driver associated with the destination printer is used for 
rendering.
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6.3 Installing and Configuring a Remote Renderer
For desktop quality printing for Microsoft Office and PDF documents, you must install a remote 
renderer on a Microsoft Windows 7, Windows 8.1, Windows 2008 R2, Windows 2012, or Windows 
2012 R2 64-bit system with a dual-core processor or higher.

During the remote renderer configuration process, when prompted for service configuration 
credentials, local users must specify the credentials of an account with Windows admin and domain 
users must specify the user name in [domainname]\[username] format.

 Section 6.3.1, “Prerequisites,” on page 74

 Section 6.3.2, “Assigning Log On as a Service Rights,” on page 74

 Section 6.3.3, “Downloading the Remote Renderer,” on page 75

 Section 6.3.4, “Installing and Configuring the Remote Renderer,” on page 75

 Section 6.3.5, “Registering the Remote Renderer,” on page 76

 Section 6.3.6, “Secure Communication Mode,” on page 76

 Section 6.3.7, “Non-secure Communication Mode,” on page 77

6.3.1 Prerequisites

Before installing and configuring the remote renderer, ensure that you have met the requirements 
listed in Section 3.3, “Remote Renderer Requirements,” on page 28 and the following prerequisites:

 At least one printer driver is uploaded to the Driver Store for the Windows platform on which you 
are setting up the renderer. This is required because when you add a remote renderer from the 
Management Console, you must designate one driver as the default driver for the renderer.

NOTE: It is recommended that you upload a universal printer driver such as HPUPD, and set 
that as the default driver.

 You must assign Log on as a service rights to the account with which you want to set up the 
renderer.

6.3.2 Assigning Log On as a Service Rights

Before configuring the remote renderer, you must assign the Log on as a service rights to the account 
with which you want to set up the renderer, on the local machine.

1 On your Windows computer, Go to Start > Control Panel.

2 In the upper-right corner of the Control Panel window, click the View by drop-down menu, then 
select Large icons.

3 Go to Administrative Tools > Local Security Policy.

4 In the left pane, double-click Local Policies.

5 Click User Rights Assignment.

6 In the right pane, under Policy, double-click Log on as a service.

7 Click Add User or Group.

8 Specify the user name in the Enter the object names to select box, then click Check Names.

9 Click OK after the user is displayed.
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10 Click OK.

11 Click OK, then close the Local Security Policy window.

6.3.3 Downloading the Remote Renderer

1 On a web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify root or vaadmin as the user name.

3 Specify the password that you provided for root or vaadmin.

The Management Console page is displayed.

4 Click iPrint Appliance Configuration.

5 Under Administration, click Renderers.

6 Click the icon next to the Download remote rendering agent in the upper-right corner of the 
screen.

NOTE: The remote renderer installation interface is not available in Slovak, Hungarian, 
Netherlands Dutch, or Catalan languages

A zip file named iPrintRendererBundle.zip is downloaded. This zip file contains a setup.exe file, 
iPrintRendererSetup.msi file, readme.txt, and a device.pfx certificate file.

Continue with installing and configuring the remote renderer.

6.3.4 Installing and Configuring the Remote Renderer

1 Unzip the iPrintRendererBundle.zip file, then launch the setup.exe file. Follow the on-
screen prompts to complete the installation procedure.

2 When the installation is complete, launch the command prompt in the Run as administrator 
mode.

3 Run the command iPrntRendCmd -c to configure the remote renderer.

3a If you want to configure the remote renderer over a secure channel and if you are using a 
self-signed digital certificate, copy the device.pfx file into the 
C:\NDPS\Renderer\certificates\ folder.

3b If you want to configure the remote renderer over a secure channel and if you are using a 
third-party certificate, copy the PKCS12 file of type .pfx or .p12 into the 
C:\NDPS\Renderer\certificates\ folder.
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4 When prompted for Do you want to configure the remote renderer over secure channel, 
depending on your requirement, specify Yes or No. 

4a When you specify Yes, the renderer is configured in a secure mode. You need to perform 
additional steps, if you need iPrint Appliance to accept only secure communications. For 
more information, see Section 6.3.6, “Secure Communication Mode,” on page 76.

4b When you specify No, the renderer is configured in a non-secure mode. You need to 
perform additional steps to ensure that iPrint Appliance accepts non-secure 
communications. For more information, see Section 6.3.7, “Non-secure Communication 
Mode,” on page 77.

5 When prompted for credentials, specify your credentials.

On successful configuration, you must register the Remote Renderer.

6.3.5 Registering the Remote Renderer

1 On the Management Console, click iPrint Appliance Configuration.

2 Under Administration, click Renderers.

3 Click New.

4 In the Renderer Host/IP address box, specify the hostname or IP address of the renderer 
system, then click Connect.

5 Under Options, specify a name for the renderer in the Renderer Name box.

6 Select the document formats you want the remote renderer to render.

7 Choose the Default Printer Driver, then click Register.

After you click the Register button, a success message is displayed, but the remote renderer is still 
configuring. The configuration time depends on the number of unique drivers associated with mobile 
enabled printers. During that period, the renderer is in the Configuring state. After the configuration is 
complete, the renderer changes to the Active state. When the status of the remote renderer displays 
Active, it means that the registration is successful. Refresh the page after a couple of minutes to 
check the status.

6.3.6 Secure Communication Mode

By default, the iPrint Appliance accepts both secure and non-secure communication.To set only 
secure communication mode, you must ensure that the renderer is secure and the iPrint Appliance 
accepts only secure communications. 

On the Windows computer, run the iPrntRendCmd -c command to configure secure remote renderer. 
On configuring the renderer to a secure mode, you can verify the status in the Management Console, 
Renderers page under the Secure Mode column, the value displayed is true.

To configure iPrint Appliance to accept only secure communications, modify the secure 
communication settings in the Management Console as follows:

1 On a web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify the root or vaadmin name that you provided as the user name.

3 Specify the password that you provided for the root or vaadmin.

The Management Console page is displayed.

4 Click iPrint Appliance Configuration.
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5 Under Administration, click Renderers. All the available renderers are displayed.

6 Click the Secure settings for renderers icon.

The Secure Communication Settings window is displayed.

7 Select the Use Secure Mode Only check box, then click OK. The iPrint Appliance will now accept 
only secure communications. The non-secure renderers will fail to communicate with the iPrint 
Appliance and no jobs can be rendered by those renderers. 

6.3.7 Non-secure Communication Mode

By default, the iPrint Appliance accepts both secure and non-secure communication but if the iPrint 
Appliance is modified to accept only secure communications, then you must modify the iPrint 
Appliance to accept both secure and non-secure communications.

On the Windows computer, run the iPrntRendCmd -c command to configure the non-secure remote 
renderer. On configuring the renderer to a non-secure mode, you can verify the status in the 
Management Console, Renderers page under the Secure Mode column, the value displayed is false.

Modify the secure communication settings in the Management Console for iPrint Appliance to accept 
both secure and non-secure communications:

1 On a web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify the root or vaadmin name that you provided as the user name.

3 Specify the password that you provided for the root or vaadmin.

The Management Console page is displayed.

4 Click iPrint Appliance Configuration.

5 Under Administration, click Renderers. All the available renderers are displayed.

6 Click the Secure settings for renderers icon.

The Secure Communication Settings window is displayed.
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7 Deselect the Use Secure Mode Only check box, then click OK. The iPrint Appliance will now 
accept both secure and non-secure communications. 

6.4 Upgrading the Remote Renderer
If you have upgraded your iPrint Appliance, you must also upgrade the remote renderer. Before 
upgrading the remote renderer, ensure that you have applied the patch and updated the iPrint 
Appliance server.

NOTE: Upgrading the remote renderer from iPrint Appliance 1.0 or 1.0.1 to iPrint Appliance 1.1 is not 
supported.

6.4.1 Upgrading from 1.1 to 1.1 Patch 1

If you have upgraded your iPrint Appliance from 1.1 to iPrint Appliance 1.1 Patch 1, you must also 
upgrade the remote renderer. To upgrade the remote renderer from iPrint Appliance 1.1 to iPrint 
Appliance 1.1 Patch 1:

1 Follow the steps from Section 6.3.3, “Downloading the Remote Renderer,” on page 75 to 
Section 6.3.4, “Installing and Configuring the Remote Renderer,” on page 75.

When the procedure is complete, the iPrint remote renderer is updated and is ready to be used.

6.4.2 Upgrading from 1.0 or 1.0.1 to 1.1 Patch 1

If you have upgraded your iPrint Appliance from 1.0 or 1.0.1 to iPrint Appliance 1.1 Patch 1, you must 
also upgrade the remote renderer. To upgrade the remote renderer from iPrint Appliance 1.0 or 1.0.1 
to iPrint Appliance 1.1 Patch 1:

1 Follow the steps from Section 6.3.3, “Downloading the Remote Renderer,” on page 75 to 
Section 6.3.5, “Registering the Remote Renderer,” on page 76.

When the procedure is complete, the iPrint remote renderer is updated and is ready to be used.
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6.5 Managing the Remote Renderer
You can manage the remote renderer through the Management Console. 

1 On a web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify root or vaadmin as the user name.

3 Specify the password that you provided for root or vaadmin.

The Management Console page is displayed.

4 Click iPrint Appliance Configuration.

5 Under Administration, click Renderers.

On the Renderers page, you can perform the following actions:

 Section 6.5.1, “Add a Renderer,” on page 79

 Section 6.5.2, “Edit a Renderer,” on page 79

 Section 6.5.3, “Delete a Renderer,” on page 79

 Section 6.5.4, “Activate or Deactivate a Renderer,” on page 80

6.5.1 Add a Renderer

1 On the Renderers page, click New.

2 In the Renderer Host/IP address box, specify the hostname or IP address of the renderer 
system, then click Connect.

3 Under Options, specify a name for the renderer in the Renderer Name box.

4 Select the document formats you want the remote renderer to render.

NOTE: The PDF Formats option along with the In-built PDF renderer is selected by default. If 
you want to use Adobe Acrobat, you must ensure that Adobe Acrobat Pro is installed on the 
renderer machine before selecting the Adobe Acrobat option. Similarly, if you want to enable the 
remote renderer to render Microsoft Office formats, you must ensure that Microsoft Office is 
installed on the renderer machine before selecting the Office Formats option.

5 Choose the Default Printer Driver, then click Register.

6.5.2 Edit a Renderer

You can change a remote renderer’s name, the document rendering options, and the default printer 
driver using the Edit feature on the Renderers page.

1 On the Renderers page, select a renderer which you want to edit, then click Edit.

2 Change the rendering options, then click Commit.

6.5.3 Delete a Renderer

1 On the Renderers page, select a renderer that you want to delete, then click Delete.

Deleting a renderer unregisters the renderer from iPrint Appliance.
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6.5.4 Activate or Deactivate a Renderer

1 On the Renderers page, select a renderer that you want to activate or deactivate, then click 
Activate/De-Activate.

If the renderer is in an Active state, it is deactivated. If the renderer is in an Inactive state, it is 
activated.

If the renderer is in an Inactive state, it will not render any job.

Deactivating a renderer does not unregister the renderer from iPrint Appliance.

6.6 Remote Renderer Commands
The management of remote renderer is supported from the Management Console. You can 
additionally use the command line interface by launching the command prompt in the Run as 
administrator mode and executing the iPrntRendCmd command for the following operations:

Command Description

-h | --help Shows the various available commands with their syntax.

-v | --version Shows the current version of the remote renderer.

-c | --
configureservice

Configures the remote renderer service for the specified user. It also provides the option of 
choosing between secure and non-secure communication mode with the iPrint Appliance. 

-u |  --
unregisterrenderer 
<iPrint Appliance 
server Fully 
Qualified Domain 
Name or IP 
address>

Unregisters the remote renderer from the iPrint Appliance server. Afterward, the remote 
renderer stops accepting jobs from the iPrint Appliance server for conversion. The iPrint 
Rendering service is running, but does not receive rendering jobs from the iPrint Appliance 
server.

-rt | --
reregisterrenderer 
<iPrint Appliance 
server Fully 
Qualified Domain 
Name or IP 
address>

Installs both self-signed and unsigned drivers for remote renderers. 

-s | --
rendererstatus

Displays the status of the iPrint Windows Rendering service.

-l | --
launchrenderer

Starts the iPrint Windows Rendering service. After registration, the rendering service starts 
automatically.

-q |--stoprenderer Stops the iPrint Windows Rendering service.

-t |  --
testconverttops 
<input file 
location> <output 
file location>

Tests the conversion locally.

-ls | --listservers Lists the iPrint Appliance registered with the remote renderer.
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7 7Managing iPrint Appliance

The Novell iPrint Appliance Management Console allows you to administer iPrint Appliance, and to 
change configuration settings, such as administrative passwords, network settings, and certificate 
settings.

To access the Appliance System Configuration page:

1 On a Web browser, specify either the DNS name or the IP address. For example, https://
10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify the Username and Password, then click Log in.

3 Click the Appliance System Configuration icon.

The Appliance System Configuration page displays the following options:

 Section 7.1, “Administrative Passwords,” on page 81

 Section 7.2, “Network,” on page 82

 Section 7.3, “Time,” on page 82

 Section 7.4, “Digital Certificates,” on page 83

 Section 7.5, “Ganglia Configuration,” on page 86

 Section 7.6, “System Services,” on page 87

 Section 7.7, “Firewall,” on page 88

 Section 7.8, “Support,” on page 88

 Section 7.9, “Field Patch,” on page 89

 Section 7.10, “Storage,” on page 89

 Section 7.11, “Logging,” on page 90

 Section 7.12, “Shutting Down and Restarting iPrint Appliance,” on page 90

 Section 7.13, “Signing Out of iPrint Appliance,” on page 91

7.1 Administrative Passwords
1 On a Web browser, use either the DNS name or the IP address to access the Management 

Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the Appliance System Configuration icon.

3 Click Administrative Passwords.

4 Specify new passwords for the root and vaadmin administrators.

If you are changing the root password, you must first specify the current root password.
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5 (Optional) Select or deselect Allow root access to SSH. When this option is selected, the root 
user is able to SSH to the appliance. If this option is not selected, only the vaadmin user can 
SSH to the appliance.

6 Click OK.

IMPORTANT: To change the eDirectory admin password, launch the terminal and run the script 
iprint_edir_change_passwd.sh.

7.2 Network
1 On a Web browser, use either the DNS name or the IP address to access the Management 

Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the Appliance System Configuration icon.

3 Click Network.

4 In the DNS Configuration section, you can modify the name servers, search domains, and 
gateway settings for your Novell iPrint Appliance network.

If the Search Domains field is left blank, it is auto-populated with the domain of the appliance 
hostname. For example, if the hostname of the appliance is iprint.mycompany.com, the 
domain is auto-populated with mycompany.com.

5 In the NIC Configuration section, you can modify the IP address, hostname, and network mask 
of any Network Interface Controller (NIC) associated with the appliance. (If you configured 
multiple NICs for the Novell iPrint Appliance, you can configure the additional NICs.)

5a In the NIC Configuration section, click the ID of the NIC.

5b Edit the IP address, hostname, or network mask.

If you change the IP address, you must restart the appliance in order for the change to be 
reflected

5c Click OK.

6 (Optional) In the Appliance Administration UI (port 9443) Access Restrictions section, specify the 
IP address of any networks for which you want to allow access to the iPrint Appliance. Leave this 
section blank to allow any network to access the iPrint Appliance.

IMPORTANT: Post iPrint Appliance configuration, do not change any Network settings. 

7 Click OK.

7.3 Time
1 On a Web browser, use either the DNS name or the IP address to access the Management 

Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the Appliance System Configuration icon.
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3 Click Time.

4 Change the time configuration options as necessary:

NTP Server: Specify the NTP server that you want to use for time synchronization.

Region: Select the region where your Novell Appliance is located.

Time Zone: Select the time zone where your Novell Appliance is located.

5 Click OK.

7.4 Digital Certificates
The Novell Appliance ships with a self-signed digital certificate. Instead of using this self-signed 
certificate, you should use a trusted server certificate that is signed by a trusted certificate authority 
(CA) such as VeriSign or Equifax.

The certificate works for both the Novell iPrint Appliance and the iPrint remote renderer (ports 9443 
and 8443). You do not need to update your certificate when you update the iPrint Appliance software.

Complete the following sections to change the digital certificate for your Novell Appliance. You can 
use the digital certificate tool to create your own certificate and then have it signed by a CA, or you 
can use an existing certificate and key pair if you have one that you want to use.

 Section 7.4.1, “Using the Digital Certificate Tool,” on page 83

 Section 7.4.2, “Using an Existing Certificate and Key Pair,” on page 85

 Section 7.4.3, “Activating the Certificate,” on page 85

 Section 7.4.4, “Managing Certificates,” on page 85

7.4.1 Using the Digital Certificate Tool

 “Creating a New Self-Signed Certificate” on page 83

 “Getting Your Certificate Officially Signed” on page 84

Creating a New Self-Signed Certificate

1 On a Web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the Appliance System Configuration icon.

3 Click Digital Certificates.
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4 In the Key Store drop-down list, ensure that Web Application Certificates is selected.

5 Click File > New Certificate (Key Pair), then specify the following information:

Alias: Specify a name that you want to use to identify and manage this certificate.

Validity (days): Specify how long you want the certificate to remain valid.

Key Algorithm: Select either RSA or DSA.

Key Size: Select the desired key size.

Signature Algorithm: Select the desired signature algorithm.

Common Name (CN): This must match the server name in the URL in order for browsers to 
accept the certificate for SSL communication.

Organizational Unit (OU): (Optional) Small organization name, such as a department or 
division. For example, Purchasing.

Organization (O): (Optional) Large organization name. For example, Novell, Inc.

City or Locality (L): (Optional) City name. For example, Provo.

State or Province (ST): (Optional) State or province name. For example, Utah.

Two-letter Country Code (C): (Optional) Two-letter country code. For example, US

6 Click OK to create the certificate.

After the certificate is created, it is self-signed.

7 Make the certificate official, as described in “Getting Your Certificate Officially Signed” on 
page 84.

Getting Your Certificate Officially Signed

1 On the Digital Certificates page, select the certificate that you just created, then click File > 
Certificate Requests > Generate CSR.

NOTE: Web Application Certificates should be selected in key store for selecting a certificate for 
officially sign the certificate.

2 Complete the process of emailing your digital certificate to a certificate authority (CA), such as 
Verisign. 

The CA takes your Certificate Signing Request (CSR) and generates an official certificate based 
on the information in the CSR. The CA then mails the new certificate and certificate chain back 
to you.

3 After you have received the official certificate and certificate chain from the CA: 

3a Revisit the Digital Certificates page.

3b Click File > Import > Trusted Certificate. Browse to the trusted certificate chain that you 
received from the CA, then click OK.

3c Select the self-signed certificate, then click File > Certification Request > Import CA Reply.

3d Browse to and upload the official certificate to be used to update the certificate information.

On the Digital Certificates page, the name in the Issuer column for your certificate changes 
to the name of the CA that stamped your certificate.

4 Activate the certificate, as described in Section 7.4.3, “Activating the Certificate,” on page 85.
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7.4.2 Using an Existing Certificate and Key Pair

When you use an existing certificate and key pair, use a .P12 key pair format.

1 Go to the Digital Certificates page by clicking Digital Certificates from the Novell Appliance 
Configuration.

2 On the Digital Certificates page, in the Key Store drop-down menu, select JVM Certificates. 

3 Click File > Import > Trusted Certificate. Browse and select your existing certificate, then click 
OK.

4 Click File > Import > Trusted Certificate. Browse and select your existing certificate chain for the 
certificate that you selected in Step 3, then click OK.

5 Click File > Import > Key Pair, then browse to and select your .P12 key pair file, specify your 
password if needed, then click OK.

6 Continue with Section 7.4.3, “Activating the Certificate,” on page 85.

7.4.3 Activating the Certificate

1 On the Digital Certificates page, in the Key Store drop-down menu, select Web Application 
Certificates. 

2 Select the certificate that you want to make active, click Set as Active, then click Yes.

3 Verify that the certificate and the certificate chain were created correctly by selecting the 
certificate, then clicking View Info.

NOTE: When you activate a certificate, the Set as Active button might still be enabled for that 
certificate. You can ignore it, as it does not affect the certificate activation.

7.4.4 Managing Certificates

All certificates that are included with the IBM Java package that is bundled with the version of SLES 
that iPrint Appliance ships with, are installed when you install iPrint Appliance.

You can use the Digital Certificates tool on the iPrint Appliance to remove certificates that are not 
used by your organization, if you are concerned about keeping them.

Also, you can use the Digital Certificates tool on the iPrint Appliance to maintain the certificate store 
by removing certificates that have expired and then installing new certificates as needed, according to 
your organization’s security policies.

To access the Digital Certificates tool:

1 Click Digital Certificates in the Novell Appliance Configuration page.

iPrint Appliance uses only the certificates that relate to LDAP and SMTP. In the Key Store drop-down 
menu, under Web Application Certificates, a self-signed certificate is displayed. This certificate is 
required for iPrint Appliance, and must not be deleted.

In the Key Store drop-down menu, under JVM Certificates, you can delete all the certificates except 
the edir_root_ca certificate, and any other LDAP or SMTP certificates that you might have imported.
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7.5 Ganglia Configuration
Ganglia is a scalable, distributed monitoring system that allows you to gather important information 
about your iPrint Appliance system. The default metrics that you can monitor are CPU, disk, load, 
memory, network, and process.

1 On a Web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the Appliance System Configuration icon.

3 Click Ganglia Configuration.

4 As necessary, change the following Ganglia configuration options:

Enable Full Monitoring Services: Select this option to receive and store metrics from other 
appliances, and to allow the Ganglia Web Interface to run on the same machine as the iPrint 
appliance.

You might want to disable Ganglia monitoring by deselecting this option if:

 You already have a monitoring system that you plan to use for iPrint.

 You plan to configure a dedicated appliance for viewing monitoring information. (You do this 
by selecting Unicast below, then specifying the DNS name or IP address of the appliance 
where monitoring information will be collected.)

Enable monitoring on this appliance: Select this option to enable Ganglia monitoring on this 
appliance.

 Multicast: Select this option to send monitoring information to other appliances on the 
network.

 Unicast: (Recommended) Select this option to send monitoring information to a single 
destination.

Unicast mode is recommended for improving performance of the iPrint system.

Publish to: Specify the URL where Ganglia sends monitoring information when it is running 
in Unicast mode.

5 (Optional) Click Reset Database to remove all existing Ganglia metrics from this appliance.

This option is not related to the iPrint database.

6 Click OK.

For more information about how to use Ganglia monitoring with iPrint Appliance, see Section 8.7, 
“Ganglia,” on page 145.
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7.6 System Services
This section describes the actions you can perform on the system services.

1 On a Web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the Appliance System Configuration icon.

3 Click System Services.

4 You can perform the following actions: 

 Section 7.6.1, “Starting, Stopping, or Restarting System Services,” on page 87

 Section 7.6.2, “Setting System Services to Automatic or Manual,” on page 87

 Section 7.6.3, “Downloading Log Files for System Services,” on page 87

7.6.1 Starting, Stopping, or Restarting System Services

1 Select the service that you want to start, stop, or restart.

2 Click Action, then click Start, Stop, or Restart.

3 Click Close to exit System Services.

7.6.2 Setting System Services to Automatic or Manual

1 Select the service that you want to make automatic or manual.

2 Click Action, then click Set as Automatic, or Set as Manual.

7.6.3 Downloading Log Files for System Services

In the Log Files column of the table, click the download link for the service for which you want to view 
log files. 

You can download the following log files for each service:

SSH: This is the SSH service that is running on the appliance. 

Novell iPrint Mobile: The iprintmobile0.log file includes log messages related to mobile server and 
renderer. To access this file, either click Download or browse to /var/opt/novell/log/
iprintmobile/ folder. 

Novell iManager: The catalina.out file includes log messages related to iManager operations. To 
access this file, either click Download or browse to /var/opt/novell/tomcat6/logs/ folder. 

Novell Authentication Services: The catalina.out file includes log messages related to services 
accessed by the users. To access this file, either click Download or browse to /opt/novell/filr/
apache-tomcat/logs/ folder.
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NetIQ eDirectory: The ndsd.log file includes log messages related to eDirectory operations. To 
access this file, either click Download or browse to /var/opt/novell/eDirectory/log/ folder.

Apache server for Novell iPrint: The error_log file includes log messages related to Apache web 
server operations. To access this file, either click Download or browse to /var/log/apache2/ folder.

Avahi: The messages file includes log messages related to Appliance system operations. To access 
this file, either click Download or browse to /var/log/ folder.

Driver Store: The idsd.log file includes log messages related to driver store operations. To access 
this file, either click Download or browse to/var/opt/novell/log/iprint/ folder.

Print Manager: The ipsmd.log file includes log messages related to print manager operations. To 
access this file, either click Download or browse to /var/opt/novell/log/iprint/ folder. 

7.7 Firewall
You can view your current firewall configuration directly from the iPrint Appliance:

1 On a Web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the Appliance System Configuration icon.

3 Click Firewall.

Port numbers are listed with the current status of each port number. This page is for 
informational purposes and is not editable.

To have seamless experience with iPrint Appliance, ensure you do not block the ports with your 
firewall settings. For more information, see Section 3.2, “Ports Requirements,” on page 22.

7.8 Support
You can upload configuration files to Novell Support via FTP, or to download the configuration files so 
that you can send them by an alternative method.

1 On a Web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the Appliance System Configuration icon.

3 Click Support.
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4 Select Automatically send the configuration to Novell using FTP to automatically send your iPrint 
Appliance system’s configuration information to Novell Support via FTP.

or

Select Download and save the configuration file locally, then send it to Novell manually to 
download your iPrint Appliance system’s configuration information to your management 
workstation. You can then send the information to Novell Support using a method of your choice.

5 Click OK to complete the process.

7.9 Field Patch
You can manage field test patches for the iPrint Appliance from the Field Patch page. You can install 
new patches, view currently installed patches, and uninstall patches.

1 On a Web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the Appliance System Configuration icon.

3 Click Field Test Patch.

4 (Optional) Install a Downloaded Patch:

4a Before you can install a patch, you first need to download it from the Novell Support web 
site (https://www.novell.com/support/) to your management workstation.

4b From the Field Test Patch page on the iPrint appliance, click Browse.

4c Browse to and select the patch that you downloaded in Step 4a.

4d Click Install.

5 (Optional) Manage Installed Patches: Uninstall Patch

5a Click Uninstall Latest Patch to uninstall the latest patch. You may not be able to uninstall 
some patches.

6 (Optional) Manage Installed Patches: Download Log File

6a Click Download Log File to download the log file. This file includes details about patch 
installation.

7.10 Storage
If you have created partitions for /vastorage and /var, iPrint Appliance provides native tools to allow 
you to expand the storage space for the /vastorage and /var partitions.

1 On a Web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the Appliance System Configuration icon.
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3 Click Storage.

4 Use the tools provided by your virtualization platform vendor to expand the virtual disks that 
contain the partitions your are expanding.

5 In the provided table, select the partitions to be expanded.

6 Click Expand partitions.

Appliance services are stopped, the selected partitions are expanded to the size of their 
respective disks, and appliance services are restarted.

7 Reboot the appliance so the operating system can detect the disks that have been expanded.

7.11 Logging
iPrint Appliance system events are logged in the /var directory. Since the /var directory can fill up 
with log files and cause the boot partition to grow, it is recommended that /var be located either on a 
separate hard disk on the appliance, or on a remote NFS directory.

To move the /var directory to a dedicated disk or to a remote NFS directory:

1 On a Web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the Appliance System Configuration icon.

3 Click Logging.

4 Specify the hard disk information for the /var directory:

 Select disk: Select the hard disk where you want to place /var.

 File system type: Specify the type of file system.

5 Click OK.

7.12 Shutting Down and Restarting iPrint Appliance
1 On a Web browser, use either the DNS name or the IP address to access the Management 

Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the Appliance System Configuration icon.
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3 Click Reboot or Shutdown.

7.13 Signing Out of iPrint Appliance
1 In the upper-right corner of the Management Console page, next to the user name, click Logout.

NOTE: On the Appliance System Configuration and iPrint Appliance Configuration pages of 
iPrint Appliance, you can see the user name displayed along with the Home and Logout links. 
The Home link directs you to the iPrint Appliance main page, and the Logout link allows you to 
sign out of iPrint Appliance.
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8 8Managing Print System

In this section, you can manage the appliance through the iPrint Appliance Management Console and 
the configure the server to automatically update the Macintosh and Windows clients. 

The Novell iPrint Appliance Management Console allows you to add and manage printers, check the 
printer status, create printer maps, and monitor iPrint Appliance. To access the Management 
Console, on a Web browser, specify either the DNS name or the IP address. For example, https://
10.0.0.1:9443 or https://iprint.example.com:9443.

The iPrint Appliance Management Console page displays the following options:

 Section 8.1, “iPrint Appliance Configuration,” on page 93

 Section 8.2, “Appliance System Configuration,” on page 101

 Section 8.3, “iPrint Printer Configuration (iManager),” on page 101

 Section 8.4, “iPrint Printer Status,” on page 142

 Section 8.5, “iPrint Printer Import / Migration,” on page 142

 Section 8.6, “iPrint Map Creation,” on page 143

 Section 8.7, “Ganglia,” on page 145

 Section 8.8, “What’s Next,” on page 146

8.1 iPrint Appliance Configuration
The iPrint Appliance Configuration page displays the following options:

 Section 8.1.1, “Mobile Configuration,” on page 93

 Section 8.1.2, “Driver Store Configuration,” on page 95

 Section 8.1.3, “Printers,” on page 95

 Section 8.1.4, “Renderers,” on page 96

 Section 8.1.5, “Services,” on page 96

 Section 8.1.6, “Export Configuration,” on page 96

 Section 8.1.7, “LDAP Import,” on page 97

 Section 8.1.8, “License,” on page 100

8.1.1 Mobile Configuration

On the Mobile configuration page, you can configure email printing and default options for printers.

Email Configuration

iPrint Appliance can be configured to accept print jobs through email messages and attachments. 
When configured for email printing, iPrint Appliance becomes a client to an email server. Email 
account inbox(es) are polled for incoming print jobs, which are routed to the intended printer. Email 
accounts must be created and functional prior to their association with Novell iPrint Appliance.
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Enable email-based printing: Select this option to enable email printing. A global email address can 
be assigned for all printers. The global email address feature requires access to an email account 
such as GroupWise, Exchange, Lotus Notes, or Gmail.

The following fields are used by iPrint Appliance to describe and access the global email account:

Email address: Specify the full email address for global print jobs. iPrint Appliance polls the inbox of 
this email address looking for print jobs. When an email-based job arrives, the subject line is parsed 
to determine the printer to which the job is sent. For example, print@example.com.

Account Username: Specify the user name for iPrint Appliance to log in to the email server to 
access the global email account. For example, iprint.

Account Password: Specify the password for iPrint Appliance to log in to the email server to access 
the global email account.

Re-type Password: Confirm the account password.

Incoming Mail Server: Specify the address of the incoming mail server for the email account. For 
example, imap.example.com.

Incoming Server Type: iPrint Appliance supports POP and IMAP protocols to poll for incoming print 
jobs. Select POP or IMAP depending on the protocol that your email server supports.

Outgoing (SMTP) Mail Server: Specify the address of the outgoing mail server for the email 
account. For example, smtp.example.com. iPrint Appliance uses the SMTP protocol to send email 
back to users who submit email-based print jobs to report their job status. In order to support iPrint 
Appliance, the email server you select must support the SMTP protocol.

Enable Mail-body Printing: With email-based printing, attachments are always printed. This option 
allows the email message body to also be printed. It is enabled by default.

Polling Interval: Configures the interval (in seconds) at which emails are fetched from mail servers.

NOTE: Each instance of iPrint Mobile service must be configured with a unique email address, which 
cannot be shared with other instances of mobile service. Similarly, an email address used for a 
particular printer (per printer email configuration) cannot be shared for any other printer or mobile 
service.

Printer Defaults

Printer features managed by iPrint Appliance can be enabled and disabled. The fields in this section 
are the default values for newly added printers. As each printer is added, these values can be 
modified.

Paper Size:  Select Letter or A4.

Orientation: Select between Landscape or Portrait printing orientation.

Enable Duplex Printing: Duplex printing allows automatic printing of a sheet of paper on both sides. 
Print devices without this capability can only print on a single side of paper (simplex printing).

Enable Color Printing: Color (or Colour) printing prints the documents in color, as opposed to 
monochrome (black and white) printing.
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8.1.2 Driver Store Configuration

You can change the Drive Store post the initial configuration. The Driver Store Configuration page 
contains the following options:

Enable local driver store: Select this option to use the Driver Store located on the local machine

Enable remote driver store: Select this option to change the location of the Remote Driver Store. 
Specify the DNS Name/Address, Username (FDN format - for example, cn=admin,o=companyname), 
and the Password of the new Remote Driver Store, then click Save.

Changing from local to remote driver store or vice versa: After initial configuration, if you change 
the local driver store to remote driver or vice versa, you must again set the default driver for the local 
renderer.

8.1.3 Printers

The Printers page lists all printers currently managed by iPrint Appliance. You can enable a printer for 
AirPrint, Email printing, and IPP printing. Select a printer, click the AirPrint or Mobile drop-down 
menu, then click Enable. On enabling the printer for AirPrint, the printer is advertized as an AirPrint-
enabled printer and also gets enabled for Mobile and Email Printing. On enabling the printer for 
mobile, you can print to that printer from your mobile devices or by using the email printing feature. 
The platform-specific associated drivers are also installed on enabling the printer for mobile. 

You can also assign a specific email address to each printer by clicking the Configure drop-down 
menu, then clicking Private Email Settings. When configured for private email printing, iPrint 
Appliance becomes a client to an email server. You must provide the following information to enable a 
private email address for the printer:

NOTE: An email address used for a particular printer (per-printer email configuration) cannot be 
shared for any other printer or mobile service.

IMPORTANT: If you configure a printer for private email printing and then disable the printer for 
Mobile printing, the private email configuration settings are deleted. If you want to enable private 
email printing in future, you must specify the information manually.

Account  Email Address: Specify the full email address of the mailbox to be polled for the 
print jobs. When an email-based job arrives, the print job is processed to the 
printer. For example, print@example.com.

 Username: Specify the user name to be used by iPrint Appliance to log in to the 
email server to access the private printer email account. For example, iprint.

 Password: Specify the password for iPrint Appliance to log in to the email 
server to access the private printer email account.

 Retype Password: Confirm the account password.

Server  Incoming Mail Server: Specify the address of the incoming email server for the 
email account. For example, imap.example.com.

 Outgoing Mail Server: Specify the address of the outgoing email server for the 
email account. For example, smtp.example.com.

 Access Method: iPrint Appliance supports two different protocols to poll for 
incoming print jobs. Select POP or IMAP depending on the protocol your email 
server supports.
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Printer Rename and Printer Refresh

You can rename a printer from the Printers page. Select a printer you want to rename, click the 
Configure menu, then click Rename Printer.

To refresh the printers list, click the Reload button in the upper right of the Available Printers window.

Bulk Printer Import Using a CSV File

You can import printers into iPrint Appliance through a csv file. You must create a csv file, then upload 
the csv file into iPrint Appliance by clicking the Bulk Printer Upload button in the upper-right corner of 
the Available Printers window.

The csv file must contain the following fields:

PrinterName,PrinterIP,Location,Description,Win95_98_Driver,Winnt_Driver,Win2k_Driv
er,Winxp_Driver,Linux_Driver,Mac_Driver,Vista32_Driver,Vista64_Driver,Win732_Drive
r,Win764_Driver,Win832_Driver,Win864_Driver,Enable DirectPrinting,Secure 
Printing,Enable Auditing,LPR/RAW,Raw Port

In the secure printing, auditing, and direct printing fields, populate with the options Yes or No.

For more information on importing printers into iPrint Appliance through a csv file, see Section 5.4.3, 
“Bulk Printer Import Using a CSV File,” on page 57.

8.1.4 Renderers

The Renderers page allows you to download the remote renderer. The page also displays all 
renderers registered with iPrint Appliance, and allows you to add, delete, and activate/deactivate a 
renderer. For more information about installing and configuring a remote renderer, see Section 6.3, 
“Installing and Configuring a Remote Renderer,” on page 74. 

8.1.5 Services

The Services page displays the system services that are required for iPrint Appliance. 

To enable or disable a service, select a service on the page, click the Action drop-down menu, then 
click Start, Stop, or Restart.

To set the Startup Type of the services to Automatic or Manual, select a service on the page, click the 
Options drop-down menu, then click Set as Automatic or Set as Manual.

To refresh the information on the page, click Refresh List.

8.1.6 Export Configuration

The Export Configuration page allows you to create a backup of the iPrint Appliance configuration. 
You can back up the configuration file of iPrint Appliance to protect against system or hard drive 
crashes. You can also use the backup to transfer the configuration to another iPrint Appliance, or to 
quickly restore iPrint Appliance. 

1 On a Web browser, use either the DNS name or the IP Address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

Ignore the security certificate warning, and continue to the iPrint Appliance Management 
Console.
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2 Specify vaadmin or root as the user name.

3 Specify the password.

The Management Console page is displayed.

4 Click iPrint Appliance Configuration.

5 Under Administration, click Export Configuration.

6 Specify the eDirectory administrator Password, then click Export.

The iprintconfig.zip file is created. This is the backup file. The backup file contains the 
configuration information.

Any configuration change in iPrint Appliance takes at least 20 minutes to get updated to the 
configuration file. If you export the iPrint Appliance configuration file within 20 minutes of modifying 
the configuration settings, and then import the configuration file into another copy of iPrint Appliance, 
the changes are not captured. In this case, you might not be able to view the updated information in 
the iPrint Appliance. We recommend that you wait at least 20 minutes after the last configuration 
change before you export the configuration file.

8.1.7 LDAP Import

To create an iPrint Appliance user account, you can synchronize initial user information from your 
network directory service (NetIQ eDirectory or Microsoft Active Directory service) after you have 
installed the iPrint Appliance software. Over time, you can continue to synchronize user information 
from the LDAP directory to your iPrint Appliance.

When you synchronize user information into iPrint Appliance from a source LDAP directory service, 
the entire Base DN on the source is imported into iPrint Appliance. For example, if you sync the 
context o=users from an LDAP source, the same o=users context is created in iPrint Appliance.

IMPORTANT: 

 iPrint Appliance performs one-way synchronization from the LDAP directory. If you change user 
information in iPrint Appliance, the changes are not synchronized back to your LDAP directory. It 
is recommended that you do not change synced LDAP user information on iPrint Appliance.

 iPrint Appliance does not support multi-value attributes. If your LDAP directory contains multi-
value attributes, iPrint Appliance recognizes only the first attribute. For example, if your LDAP 
directory contains multiple email addresses for a given user, only the first email address is 
synchronized to iPrint Appliance.

 LDAP import does not sync user passwords to iPrint Appliance. Authentication requests from the 
mobile app are redirected to the defined LDAP source. If a user password is changed on the 
LDAP source, you do not need to update the same password on iPrint Appliance.

 The LDAP source IP or DNS name must be always active for iPrint Appliance to authenticate 
users.

You can configure multiple LDAP connections. To create a new LDAP connection, click Add a New 
LDAP Source on the LDAP Import page.

For information on importing certificates into iPrint Appliance when using LDAP, see the knowledge 
base article: How to enable SSL to Teaming LDAP Synchronization and Authentication.

Each connection requires the following configuration information:

 “LDAP Server URL” on page 98

 “User DN (Proxy User for Synchronizing Users and Groups)” on page 98
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 “LDAP Attribute to Identify a User or Group” on page 98

 “LDAP Attribute for iPrint Appliance User Name” on page 99

 “User and Group Object Locations” on page 99

 “LDAP Synchronization” on page 100

LDAP Server URL

In order to synchronize initial user information, iPrint Appliance must access an LDAP server where 
your directory service is running. You must provide the hostname of the server, using a URL with the 
following format:

ldap://hostname

If the LDAP server requires a secure SSL connection, use the following format:

ldaps://hostname

If the LDAP server is configured with a default port number (389 for non-secure connections or 636 
for secure SSL connections), the port number is not required in the URL. If the LDAP server uses a 
different port number, use the following format for the LDAP URL:

ldap://hostname:port_number
ldaps://hostname:port_number

If the LDAP server requires a secure SSL connection, additional setup is required. You must import 
the root certificate for your LDAP directory into the Java KeyStore (JVM Certificates) from 
Management Tools > Appliance System Configuration > Digital Certificates on the iPrint server, 
before you configure iPrint Appliance for LDAP synchronization.

User DN (Proxy User for Synchronizing Users and Groups)

To sync users into iPrint Appliance, you must provide the user name and password of a user who has 
sufficient rights to access the user information on the LDAP server.

In your LDAP directory tree, you must provide the fully qualified, comma-delimited user name, along 
with its context, in the format expected by your directory service.

LDAP Attribute to Identify a User or Group

The LDAP attribute that uniquely identifies a user or group helps facilitate renaming and moving iPrint 
users and groups in the LDAP directory. If this attribute is not set and you rename or move a user in 
the LDAP source directory, iPrint Appliance assumes that the new name (or the new location of the 
same name) represents a new user rather than a modified user, and creates a new iPrint Appliance 
user.

For example, you have an iPrint user with a given name of William Jones. If William changes his 
name to Bill and you make that change in the LDAP directory, iPrint Appliance creates a new user 
named Bill Jones.

Directory Service Format for the User Name

eDirectory cn=username,ou=organizational_unit,o=organization

Active Directory cn=username,cn=organizational_unit,dc=domain_component
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To ensure that iPrint Appliance modifies the existing user instead of creating a new user when the 
user is renamed or moved in the LDAP directory, you must specify the name of the LDAP attribute 
that uniquely identifies the user. For eDirectory, this value is GUID. For Active Directory, this value is 
objectGUID. This attribute always has a unique value that does not change when you rename or 
move a user in the LDAP directory. If you want to map users to a different attribute, you must ensure 
that the attribute that you use is a binary attribute. For example, the cn attribute cannot be used 
because it is not a binary attribute.

LDAP Attribute for iPrint Appliance User Name

The setting LDAP Attribute Used for iPrint Appliance User Name is used for two purposes:

 The value is used as the iPrint Appliance user name when the user is first provisioned from 
LDAP. The value of this attribute must be unique.

 During iPrint Appliance login, iPrint Appliance uses this attribute to locate the user in the LDAP 
directory, and then tries to authenticate as that user.

LDAP directories differ in the LDAP attribute used to identify a User object. Both eDirectory and 
Active Directory might use the cn (common name) attribute. A more sure alternative for Active 
Directory is to use the sAMAccountName attribute. Other LDAP directories might use the uid (unique 
ID) attribute, depending on the structure and configuration of the directory tree.

Consult with your directory administrator in order to determine the best attribute to use. In some 
cases where not all users are being imported successfully, you must set up two LDAP sources 
pointing to the same LDAP server and have each source use a different value for the LDAP Attribute 
Used for iPrint Name. For example, set up one LDAP source and use cn as the LDAP Attribute Used 
for iPrint Name, and then set up a separate source to the same LDAP server and use 
sAMAccountName as the LDAP Attribute Used for iPrint Name.

In addition to the attributes already mentioned in this section, other LDAP attributes can be used for 
the LDAP Attribute Used for iPrint Name, as long as the attribute is unique for each User object. For 
example, the mail LDAP attribute on User objects can be used to enable iPrint Appliance users to log 
in by using their email addresses.

User and Group Object Locations

iPrint Appliance can find and synchronize initial user information from User objects located in one or 
more containers in the LDAP directory tree. A container under which User objects are located is 
called a base DN (distinguished name). The format you use to specify a base DN depends on your 
directory service.

To identify potential iPrint users, iPrint Appliance by default filters on the following LDAP directory 
object attributes:

 Person

 orgPerson

 inetOrgPerson

Directory Service Format for the User Container

eDirectory ou=organizational_unit,o=organization

Active Directory cn=organizational_unit,dc=domain_component
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If you want to create iPrint groups based on information in your LDAP directory, iPrint Appliance filters 
on the following LDAP directory object attributes:

 group

 groupOfNames

 groupOfUniqueNames

You can add attributes to the user or group filter list if necessary. You can use the following operators 
in the filter:

 | OR (the default)

 & AND

 ! NOT

You can choose whether you want iPrint Appliance to search for users (and optionally, groups) in 
containers below the base DN (that is, in subtrees).

You can create a group that consists of all the users that you want to set up in iPrint Appliance, 
regardless of where they are located in your LDAP directory. After you create the group, you can use 
the following filter to search for User objects that have the specified group membership attribute:

(groupMembership=cn=group_name,ou=organizational_unit,o=organization)

IMPORTANT: Ensure that you include parentheses in your filter.

LDAP Synchronization

Synchronization options apply to all LDAP configurations.

Select Enable schedule, then set the schedule to synchronize users and groups. You can perform 
LDAP synchronization every day, or on specific days of the week. You can also perform a sync once 
a day at a specified time, or multiple times each day. The smallest time interval you can set is .25 
hours (every 15 minutes).

To synchronize users and groups immediately, select Run Immediately.

NOTE: If you want to delete users that are synced from a particular LDAP source, you must delete 
the LDAP source connection then run an LDAP sync. When you delete an LDAP source, the users 
and groups from that context are deleted while the context itself is retained.

8.1.8 License

The License page displays information about your current iPrint license, including the date it was 
issued and the number of days from the issue date that the license is valid.

iPrint ships with a 60-day evaluation license. You must update this license to a full product license.

You can obtain a new valid license key from the Novell Customer Center (NCC).

 “Accessing the License Page” on page 101

 “Updating the iPrint Appliance License” on page 101
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Accessing the License Page

You can access the License page of iPrint Appliance by using the Management Console.

1 On a Web browser, specify either the DNS name or the IP address of iPrint Appliance. For 
example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Log in using vaadmin or root credentials.

3 Click the iPrint Appliance Configuration icon.

4 Under Administration, click License.

The License page displays the license details of the iPrint Appliance.

Updating the iPrint Appliance License

To update your iPrint Appliance license:

1 On the License page, browse and select a valid license (.xml) file to upload.

2 Click Upload.

IMPORTANT: If you are running multiple copies of iPrint Appliance, you must update the license 
for each copy of iPrint Appliance individually.

After copying the license file, iPrint Appliance is updated. Restarting the services is not required.

8.2 Appliance System Configuration
You can change configuration settings, such as administrative passwords, network settings, and 
certificate settings. For more information, see Chapter 7, “Managing iPrint Appliance,” on page 81.

8.3 iPrint Printer Configuration (iManager)
iManager is a tool that allows you to manage your print environment. You can create printers, printer 
drivers, profiles, and users. You can also manage workstations. iManager enables you to perform the 
following operations on iPrint Appliance:

 Section 8.3.1, “Understanding and Managing Certificates,” on page 102

 Section 8.3.2, “Managing the Driver Store,” on page 102

 Section 8.3.3, “Managing the Print Manager,” on page 105

 Section 8.3.4, “Managing Printers,” on page 119

 Section 8.3.5, “Using iPrint Client Management,” on page 135

NOTE: If you are running Windows XP Service Pack 2 or other browsers with pop-up blocking, you 
might encounter problems with pop-up windows. To manage iPrint in iManager and to install printers 
with iPrint clients, turn off pop-up blocking or allow the URL.
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8.3.1 Understanding and Managing Certificates

When you manage Print Managers, driver stores, and printers that are running on a different server 
than the server running iManager, you might receive a certificate error, meaning that the host name or 
IP address of the server where you are managing the print object does not match any of the 
certificates on the server where iManager is running. 

To find and accept the correct certificate:

1 Click the iPrint Certificate Manager link in the error.

2 Review the certificate information for accuracy.

3 Select the action you want to perform for this certificate.

In order to manage the print object, you must accept the certificate.

4 Click OK.

You might need to scroll down in order to click OK to accept the certificate. 

5 Restart your task.

Certificates are accepted on a per-user basis.

You can remove accepted certificates by deleting the certstore folder located at: /var/opt/novell/
iManager/nps/portal/modules/iPrintX/certstore. Deleting this folder removes all accepted 
certificates.

8.3.2 Managing the Driver Store

Although the default settings lets users print without additional configuration, you might want to 
modify some settings so that you can manage your printing resources most effectively.

 “Creating Additional Driver Stores” on page 102

 “Understanding the Driver Store Configuration File” on page 103

 “Changing the eDirectory Server Assignment” on page 103

 “Loading or Unloading the Driver Store” on page 104

 “Updating Printer Drivers” on page 104

 “Deleting Printer Drivers” on page 105

Creating Additional Driver Stores

Although you can create additional Driver Stores, you only need one for your iPrint system because 
the Print Manager saves the downloaded drivers files to disk. If the Print Manager does not have a 
requested driver, it copies the driver from the Driver Store and then saves it to disk. This process is 
relatively quick, even for the first user to request a printer driver. We recommend that you maintain 
only one Driver Store, so you do not need to track which Driver Store contains what printer drivers. 
Periodically, the Print Manager checks the Driver Store for updated printer drivers.

If you configure multiple Driver Stores that run on the same server, they all point to the same 
repository of printer drivers. This can be useful because each Driver Store has its own eDirectory 
object, and you can distribute the objects in your eDirectory tree.

To create a driver store:

1 In iManager, click iPrint > Create Driver Store.

2 Specify the Driver Store name you want for the Driver Store object.
102 Novell iPrint Appliance 1.1 Administration Guide



3 Specify the container name where you want the Driver Store object to reside.

4 Specify a DNS name or IP address of the target server where you want the Driver Store to 
reside.

5 Specify an eDirectory server that you want the Driver Store to communicate with.

For fault tolerance, you can specify more than one eDirectory server from the same tree. For 
more information, see “Changing the eDirectory Server Assignment” on page 103.

6 Click OK.

To modify the Driver Store properties or to add printer drivers, click Manage Driver Store, then select 
the Driver Store you want to modify.

Understanding the Driver Store Configuration File

When you create a Driver Store, a configuration file is created in /etc/opt/novell/iprint/conf. 
The filename is idsd.conf. Each time you use iManager to create a Driver Store object and assign it 
to the same server, a separate entry is added to idsd.conf. Although you can have several Driver 
Stores assigned to a server, all printer driver files are stored in one file structure on the server. For 
information about the entries in the configuration file, see /etc/opt/novell/iprint/conf/
idsd.conf.

Changing the eDirectory Server Assignment

If you need to change the eDirectory server assignment for the Print Manager or Driver Store, edit the 
Directory Services Server1= entry in the corresponding configuration file, 
print_manager_name.context.ipsmd.conf or idsd.conf, located in /etc/opt/novell/iprint/
conf. 

NOTE: As many as two additional servers can be specified, using Directory Services Server2 and 
Directory Services Server3. Directory Services Server1 is considered to be the primary eDirectory 
server. Directory Services Server2 and Directory Services Server3 are considered to be secondary 
servers. 

For example, editing the Directory Services Servers 1, 2, and 3 entries for the idsd.conf file looks 
like this:

cat /etc/opt/novell/iprint/conf/idsd.conf {

DSServer1 server1.blr.novell.com

DSServer2 server2.blr.novell.com

DSServer3 server3.blr.novell.com

IDSObjectDN CN=ds-102-59-2,O=novell

IDSObjectPasswd yhvuevdbumpuvfuklnqqapvipxvemh

IDSHostAddress 100.100.100.100

}

Editing the Directory Services Servers 1, 2, and 3 entries for the ipsmd.conf file looks like this:

cat /etc/opt/novell/iprint/conf/ipsmd.conf

DSServer1 server1.blr.novell.com
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DSServer2 server2.blr.novell.com

DSServer3 server3.blr.novell.com

PSMObjectDN CN=psm-dns-name,O=novell

PSMObjectPasswd pgtnlafnfekh

PSMHostAddress server1.blr.novell.com

Loading or Unloading the Driver Store

You can start and stop the Print Manager in two ways:

 “Using the Command Line” on page 104

 “Using iManager” on page 104

Using the Command Line

The Driver Store uses init scripts for starting and stopping the daemon. To load the Driver Store from 
the command line, enter/etc/init.d/novell-idsd start

The following init script actions are also valid:

Table 8-1   Driver Store Actions

Using iManager

On the Driver Store Control property page, you can view the Driver Store’s status and unload or load 
the Driver Store daemon.

1 In iManager, click iPrint > Manage Driver Store.

2 Browse to and select the Driver Store you want.

3 Click Driver Store Control > Shutdown to stop the Driver Store process.

4 Click OK.

Updating Printer Drivers

1 Add a new driver. 

For more information on adding a new driver, see Section 5.3, “Configuring Printer Drivers,” on 
page 43.

2 Associate the printer to the driver.

Action Description

reload or force-reload Stops and then starts the daemon.

start Starts the daemon.

status Displays the status of the daemon and the name of the Driver 
Store.

stop Stops the daemon.
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NOTE: Only the new iPrint Clients auto-update the drivers. For the existing or old Print Clients, you 
need to manually install and associate the drivers. 

Deleting Printer Drivers

1 In iManager, click iPrint > Manage Driver Store, then browse to and select the Driver Store you 
want.

2 Click Drivers, then select the client platform you want to work with.

3 Select the driver you want to delete.

4 Click Delete.

5 Click OK.

8.3.3 Managing the Print Manager

Although the default settings let users print without additional configuration, you probably want to 
modify some of those settings so that you can manage your printing resources most effectively. 

NOTE: Printer driver profiles are stored in the Print Manager database file (psmdb.dat). While the 
.dat file can be viewed only using iManager and the /psmstatus page, a text copy of the database file 
can be viewed using many tools (including text editor, web browser, and others). This text copy is 
periodically backed up in the same directory as the .dat file, but in XML format. The directory 
location is: /var/opt/novell/iprint/<print manager name.ou.ou.o>.psm/.

 “Understanding the Print Manager Database” on page 105

 “Understanding the Print Manager Configuration File” on page 106

 “Changing the eDirectory Server Assignment” on page 106

 “Using the Print Manager Health Monitor” on page 107

 “Setting Up a Printer Pool” on page 109

 “Using Print Auditing” on page 110

 “Creating Additional Print Managers” on page 114

 “Loading or Unloading the Print Manager” on page 115

 “Moving Print Managers to Another Linux Server” on page 116

 “Auto Driver/Profile Update” on page 116

 “Enabling Printer Agent Redirection” on page 117

Understanding the Print Manager Database

The Print Manager uses a database to store information about the printers it controls. The database 
creates a backup when you create or delete a printer and also every night at midnight. 

NOTE: Although database creation is a quick process, sometimes the backup is delayed because of 
other tasks the Print Manager is doing. You might need to wait a short while after you create or delete 
a printer before a backup is generated and uploaded to eDirectory. 
Managing Print System 105



The last four backups are saved. When a new backup file is created, the oldest of the four stored files 
is deleted. If the oldest backup file is older than four days, then the Print Manager creates a new 
backup.

If the database fails to load through normal mechanisms, you can use the following procedure to 
access the backup database:

1 Rename /var/opt/novell/iprint/<PSM_Name>/psmdb.* to psmdbold.*.

2 Rename /var/opt/novell/iprint/<PSM_Name>/psmdbsav.* to psmdb.*.

3 Start the Print Manager.

Understanding the Print Manager Configuration File

When you create a Print Manager, a configuration file is created in /etc/opt/novell/iprint/conf. 
The file name is print_manager_name.context.ipsmd.conf. A separate file is created for each 
Print Manager that is created and assigned to run on the same server. Only one Print Manager can 
run on the server at a time. For information about the entries in the configuration file, see /etc/opt/
novell/iprint/conf/ipsmd-template.conf.

The ipsmd.conf file links to the configuration file of the currently loaded Print Manager.

To load a different Print Manager on the server, use the iPrint> Manage Print Manager > Manager 
Control page in iManager. If you attempt to load a Print Manager when one is already running, you 
receive an error message instructing you to unload the current Print Manager before loading the new 
one.

Changing the eDirectory Server Assignment

If you need to change the eDirectory server assignment for the Print Manager or Driver Store, edit the 
Directory Services Server1= entry in the corresponding configuration file, 
print_manager_name.context.ipsmd.conf or idsd.conf, located in /etc/opt/novell/iprint/
conf. 

NOTE: As many as two additional servers can be specified, using Directory Services Server2 and 
Directory Services Server3. Directory Services Server1 is considered to be the primary eDirectory 
server. Directory Services Server2 and Directory Services Server3 are considered to be secondary 
servers. 

For example, editing the Directory Services Servers 1, 2, and 3 entries for the idsd.conf file looks 
like this:

cat /etc/opt/novell/iprint/conf/idsd.conf {

DSServer1 server1.blr.novell.com

DSServer2 server2.blr.novell.com

DSServer3 server3.blr.novell.com

IDSObjectDN CN=ds-102-59-2,O=novell

IDSObjectPasswd yhvuevdbumpuvfuklnqqapvipxvemh

IDSHostAddress 100.100.100.100

}
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Editing the Directory Services Servers 1, 2, and 3 entries for the ipsmd.conf file looks like this:

cat /etc/opt/novell/iprint/conf/ipsmd.conf

DSServer1 server1.blr.novell.com

DSServer2 server2.blr.novell.com

DSServer3 server3.blr.novell.com

PSMObjectDN CN=psm-dns-name,O=novell

PSMObjectPasswd pgtnlafnfekh

PSMHostAddress server1.blr.novell.com

Using the Print Manager Health Monitor

The Print Manager Health Monitor provides you with a global view of your print system. The Health 
Monitor shows you the current status of the Print Manager and the associated printers and lets you 
configure error threshold, customize some print system settings, and generate reports about your 
system.

 “Understanding the Print Manager Health Monitor” on page 107

 “Accessing the Print Manager Health Monitor” on page 107

 “Generating Reports” on page 108

 “Configuring Health Monitor Settings” on page 109

 “Posting Administrator Messages about a Printer” on page 109

Understanding the Print Manager Health Monitor

The Print Manager Health Monitor is a powerful tool for managing and troubleshooting your print 
system. 

The opening page of the Health Monitor shows all of your printers; their current state; and general 
statistics including the number of print jobs printed in the last hour, in the last day, and since the Print 
Manager was last started.

A quick look at these statistics helps you identify which printers are not printing because of errors or 
which printers are not being used.You can click a printer name to see additional details about the 
printer that can help you troubleshoot a reported printer error and why users are not using the printer.

For example, if the printer status shows Error printing, click the printer for a list of known 
problems. If one of the known problems is Printer not connected, use the IP address listed in the 
Load String field to ping the printer to determine if the IP address is valid.

By looking at the statistical information, you can correct printer problems or make decisions about 
redeploying under used printers to departments that print a lot. For more information, see “An 
Overview of the iPrint Manager Health Monitor”.

Accessing the Print Manager Health Monitor

Access the Health Monitor by going to http://server_address/psmstatus, where server_address is the 
IP address or DNS name of the server where the Print Manager is running.

For example: http://printing.my_company.com/psmstatus.
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You can view current Printer Agent states, start up and shut down Printer Agents, and other 
information about your print system.

Generating Reports

The report feature of the Health Monitor allows you to generate a report that can be displayed on the 
page or saved as a comma-separated-value (.csv) file that can be used in a spreadsheet program. 

1 On the Print Manager Health Monitor main page, click Advanced Print Manager Information > 
Generate Report.

2 (Optional) To save the report as a file, click Write Results to File under the File Options heading. 

The heading specifies the location and filename of the report.

3 Select the information you want included in the report by selecting the corresponding check 
boxes.

4 Click Generate Report.

The report is displayed on the screen, even if you selected to save the report to a file. 

The following common reports are available for you to generate:

Printer Configurations: To determine what features are enabled for each Printer Agent, generate 
the following reports:

 SSL Required for iPrint Access

 Auditing Enabled

Printer’s Current State: To view the states of the printers and any printer console messages,  
generate the following reports:

 Printer Agent Status

 Printer Agent State Reasons

 Printer Console

Printing Statistics: To view statistics about your print system, generate the following reports:

 Jobs Printed Ever

 Jobs Printed Since Load

 Jobs Printed Today

 Average Job Size Since Load

 Average Job Size Today

Gateway Information: To view information about a gateway associated with the Printer Agents, 
including the gateway’s IP address, generate the following report:

 Gateway Load String

Printer Driver Associations: To view the printer drivers associated with each printer, generate the 
following reports:

 Windows 95/98 Driver

 Windows NT4 Driver

 Windows 2000/XP Driver

 Win XP Driver

 Linux Driver
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Printer and Printer Agent Associations: Because a Printer Agent can service more than one 
printer, use the Associated NDS Printers option to view the number of printers serviced by each 
Printer Agent.

Configuring Health Monitor Settings

You can configure settings in the Health Monitor to control how the Health Monitor presents 
information when certain thresholds are met.

1 On the Print Manager Health Monitor main page, click Advanced iPrint Manager Information > 
Configure Settings and Error Thresholds.

2 Adjust the settings you want to change.

See the online help for information about the available settings. For most print systems, the 
default settings are sufficient.

Posting Administrator Messages about a Printer

Suppose a printer has been taken offline and sent for repairs, but you keep getting phone calls from 
other administrators that the printer has an error in the Health Monitor. This can be resolved by 
leaving a message about the printer in Health Monitor. Users can see the message, but only 
administrators can edit it.

1 On the Print Manager Health Monitor main page, click the printer you want, then click Message 
from Admin.

2 Type the text you want displayed for this printer.

3 Click Apply.

To remove a message, follow the steps above and delete the text in the message box (Step 2).

Setting Up a Printer Pool

You can create a pool of printers to share the load of printing. Users install one of the printers in the 
pool. When a printer in the pool has a print job waiting, the Print Manager can redirect that print job to 
an idle printer in the pool. The Print Manager attempts to evenly distribute print jobs among all 
printers in a pool. 

For example, if four printers are in the pool and the first printer is printing a 100-page job, then the 
next print job is sent to the second printer. If the second printer completes the print job and the first 
printer is still busy, the next print job is sent to the third printer to distribute print jobs throughout the 
pool. Printer pools are specific to the Print Manager, and a printer pool cannot span multiple Print 
Managers.

Printers that are included in a pool should be the same model and use the same printer drivers. You 
can include only printers from the same Print Manager in a pool.

When you create a printer pool, the pool information resides in the Print Manager and can be viewed 
only using iManager. Unlike the printers and the Print Manager, a separate eDirectory object for a 
printer pool is not created.

After you set up a printer pool, users install only one of the printers in the pool on their workstation. 
When a user submits a print job to the installed printer, the Print Manager uses the method described 
in the example above to send the print job to the next available printer in the pool. Users should be 
reminded that their print jobs might be printed by any printer in the pool. For this reason, the physical 
printers that are members of a printer pool should be located close to one another. You might also 
want to enable banner pages, depending on the type of documents being printed.
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To configure a printer pool, do the following:

1 In iManager, click iPrint > Printer Pool Configuration.

2 Select the Print Manager for this pool.

3 Select Create Pool from the Select Operation list, then click OK. 

4 Specify the name of the printer pool.

This name is used to identify the pool only within iManager.

5 Select the printers you want included in the pool.

6 Click Next, then click OK.

To modify or delete a pool, follow the above steps and select the desired action from the Select an 
Operation list in Step 3.

Using Print Auditing

To use print auditing, you first need to enable auditing for each printer you want to audit using 
iManager or the Print Manager Health Monitor.

When auditing is enabled for a Printer Agent, a log file is created indicating who printed how many 
pages to which printer on a given date. The log file is in a comma-separated format (.csv). The data 
from this log file can be viewed from the Health Monitor or downloaded into a spreadsheet. 

Figure 8-1   Auditing Management Page

From the Auditing Management page, you can complete the following tasks:

 “Using iManager to Enable Auditing” on page 111

 “Using the Health Monitor to Enable Auditing” on page 111

 “Viewing Auditing Information” on page 111

 “Managing Audit Logs” on page 113
110 Novell iPrint Appliance 1.1 Administration Guide



 “Configuring Automatic Log Rotation” on page 113

 “Downloading an Audit Report” on page 114

Using iManager to Enable Auditing

1 In iManager, click iPrint > Manage Printer.

2 Browse to and select the printer you want to enable auditing for.

3 Click Configuration > Auditing.

4 Select the Enable Auditing check box.

Using the Health Monitor to Enable Auditing

1 To access the Print Manager Health Monitor, open http://server_IP_address/psmstatus in a Web 
browser.

For example: http://printing.my_company.com/psmstatus.

2 Select a printer, then click Configuration Options.

You can also access Configuration Options by going to https://server_IP_address/PsmStatus/
configOpt/Printer_Name.

3 Select the Enable Auditing check box.

Viewing Auditing Information

You can generate an audit report that shows all print jobs, or you can filter the report based on a user 
or a printer or both.

1 In the Print Manager Health Monitor, click Advanced iPrint Manager Information > Auditing > 
Generate Report. 

If there is more than one audit log, click Generate Report for the audit log you want to view.

2 (Optional) Filter the search by using the Limit Search by User or Limit Search by Printer filters.
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3 Click Generate Report to view the report with the specified filters.

There are only 250 print jobs listed at a time. To view more print jobs in the report, click Next.
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The following table explains the fields that are displayed under the Report Summary.

The following table discusses what is displayed in the body of the report.

Managing Audit Logs

You can manage your audit logs by using the buttons on the Auditing Management page. When audit 
logs are no longer needed, you can manually delete them. To automatically save and create new 
logs, see “Configuring Automatic Log Rotation” on page 113. 

The active audit log file (audit.csv) logs data for all printers that have been enabled for auditing. You 
can generate a report from this file or you can move the data to a saved file by using the Start New 
Audit Log option. You cannot download the audit.csv file. To download a file, it must be saved as a 
separate audit log. When you move the data to a saved audit log by using the Start New Audit Log 
button, the log file is named auditxxx.csv, where xxx is the next sequential number of the log. After 
a log file is saved, you can download the file to your workstation and import it into a spreadsheet 
program.

Configuring Automatic Log Rotation

Audit Log Rotation automatically creates a new log when certain criteria are met.

1 In the Print Manager Health Monitor, click Advanced iPrint Manager Information > Auditing > 
Configure Log Rotation. 

2 Select Enable Audit Log Rotation.

Field Description

iPrint Manger The Print Manager that the information is from.

Audit Log The audit log filename that was used to create the report.

Selected User Any user filter criteria that were used to create the report.

Selected Printer Any printer filter criteria that were used to create the report.

Number of Jobs 
Currently Displayed

The number of jobs submitted by the indicated users and printers.

Field Description

Job Owner The owner of the print job.

Printer The printer the print job was sent to.

Time Submitted The time the print job was submitted to the printer.

Time Completed The time the print job was printed on the printer.

Completion Status The completion status of the submitted print job:

Completed, Cancelled by User, Cancelled by Operator, or Other (Other 
usually indicates the job was aborted by the system).

Page Count The number of pages printed.

Job Size The size of the print job (in bytes).

Job Name The print job filename that was submitted and the type of print client that 
submitted the print job.
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3 Specify the number of logs to keep.

When the number of logs to keep is reached, the oldest log is deleted when the next log is 
created. When setting this number, take in to account the criteria you are using to create new log 
files. If you want a year’s worth of logs, set the number of audit logs to keep to 12 and then select 
the By Date and By Month options.

4 Specify the criteria used for log rotation:

By Job Count: Specify the maximum number of print jobs that an audit log can contain before a 
new log is created.

By Date: Select when you want the audit logs to rotate.

 Day: The log rotates each day at midnight.

 Week: The log rotates each Sunday. If the Print Manager is not loaded on Sunday, the log is 
rotated the next time the Print Manager starts.

 Month: The log rotates at midnight on the first day of the month.

NOTE: If you select Day or Week, ensure that the Maximum Number of Audit Logs to Keep entry 
is large enough so that logs are not rotated before you need the data.

By File Size: Specify the maximum file size (in KB) before a new log is created. The maximum 
file size is 4194304 KB.

Downloading an Audit Report

When the file is downloaded, you can open the report in a spreadsheet application to sort, view, and 
format the data to meet your needs. The active audit log, audit.csv, cannot be downloaded. You 
must first start a new audit log by clicking the Start New Audit Log option, then download the newly 
created audit log.

1 On the Print Manager Health Monitor main page, click Advanced iPrint Manager Information > 
Auditing.

2 Right-click the name of the audit log you want to download, then click Save Target As.

3 Follow the prompts and save the file to the desired location.

Creating Additional Print Managers

A Print Manager must be created and running before you can create and associate printers. A Print 
Manager provides a platform for Printer Agents, which are logical representations of printers that 
reside on the server. You can manually load Print Managers on a server.

Use the following guidelines to determine where and when to place a Print Manager:

 Only one Print Manager can be running on a server.

 For optimal performance, place the Print Manager and the printers it controls on the same LAN 
segment.

 Consider distributing your printers across multiple Print Managers so that if one manager goes 
down, not all of the Printer Agents are affected.

You need the Supervisor right for the container where the Print Manager object is to reside. 

1 In iManager, click iPrint > Create Print Manager.

2 Specify the Print Manager name for the iPrint Manager object.

3 Specify the container name where you want the Manager's object to reside.
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4 Specify an eDirectory server you want the iPrint Manager to communicate with.

For fault tolerance, you can specify more than one eDirectory server from the same tree. For 
more information, see “Changing the eDirectory Server Assignment” on page 103.

5 Specify the Driver Store name.

6 Select the Start print manager after creation check box. 

If you do not select the Start print manager after creation check box, you should start the Print 
Manager. You can start the Print Manager by using Manage Print Manager > Manager Control in 
iManager or by entering /etc/init.d./novell-ipsmd start at a command prompt.

IMPORTANT: In a cluster setup, do not select the Start print manager after creation check box.

7 Click OK.

After the Print Manager is created, the daemon is loaded on the server.

To modify the Print Manager properties, click Manage Print Manager, then select the manager you 
want to modify.

For information about Access Control roles, see .

Loading or Unloading the Print Manager

You can start and stop the Print Manager in two ways:

 “Using the Command Line” on page 115

 “Using iManager” on page 116

Using the Command Line

The Print Manager uses init scripts for starting and stopping the daemon. To load the Print Manager 
from the command line, enter/etc/init.d/novell-ipsmd start

The following init script actions are also valid:

Table 8-2   Print Manager Actions

Action Description

start Starts the daemon.

stop Stops the daemon.

reload or force-reload Stops and then starts the daemon.

restart Restarts the daemon.

try-restart Tries restarting the daemon.

status Displays the status of the daemon and the name of the Print 
Manager.
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Using iManager

On the Manager Control Property page, you can view the Print Manager’s status and unload or load 
the manager daemon.

1 In iManager, click iPrint > Manage Print Manager.

2 Browse to and select the Print Manager you want to control.

3 Click Manager Control > Shutdown to stop Print Manager.

4 Click OK.

Moving Print Managers to Another Linux Server

Sometimes it is necessary to move the Print Manager from one server to another. If you assigned a 
DNS name to the Print Manager, you should update the DNS entry with the new IP address that the 
Manager is running on when the move is completed; otherwise, you cannot manage the Print 
Manager and users are cannot print.

IMPORTANT: The URLs generated by iPrint are based on the server’s IP address or a DNS name. If 
you move a Print Manager to a server that has a different IP address or a different DNS name than is 
currently being used, a new URL is generated for each printer. Users must delete and reinstall their 
iPrint printers. If you are using NDPS Printers, printing is not affected.

1 In iManager, click iPrint > Manage Print Manager.

2 Browse to and select the Print Manager you want to move, then click OK.

3 Click Shutdown.

IMPORTANT: All printing associated with this Print Manager ceases and waiting print jobs are 
lost.

4 On the Manager Control page, click Move.

5 Fill in the fields:

Target Server: Specify the DNS name or IP address for the server that is to host the Print 
Manager. For example, 192.0.34.166 or print.my_company.com. 

iPrint Service Name: Displays the IP address or DNS name for the iPrint service. 

eDir Server: Specify an eDirectory server that you want the Print Manager to communicate with.

If you are using a DNS name, you must update your DNS host tables to reflect the move.

6 Click OK to move the Print Manager.

The Print Manager is moved and loaded on the destination server.

Auto Driver/Profile Update

An auto driver/profile update allows you to automatically update the client with the latest drivers and 
the modified profiles available on the server, without users needing to manually update the driver or 
profile. If you make any changes to the driver in the Driver Store or modify the profile, the client is 
prompted for the changes and the client is updated.

NOTE: The client might take few seconds to 24 hours to reflect the changes. 
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To enable the auto driver/profile update:

1 Upload the updated driver. 

2 Create or modify the profile.

For more information on how to create the profile, see “Using Printer Driver Profiles” on 
page 126.

3 Enable the auto driver/profile update:

3a In iManager, click iPrint > Manage Print Manager.

3b Browse to and select the Print Manager for which you want to enable the auto driver/profile 
update.

3c Click Printer Agents.

3d Select the Auto driver/profile update for the Printer Agents for which you want to enable 
auto driver/profile update.

3e Click OK.

Enabling Printer Agent Redirection

Printer Agent Redirection is useful when you are decommissioning an iPrint printer and want to 
automatically redirect printing to a different iPrint printer without users manually deleting and 
reinstalling the printer. Redirection can continue even after you delete the Printer Agent for iPrint 
printers only. 

Printer Agent Redirection is supported with the iPrint client for Windows v4.26 or later.

With Printer Agent Redirection enabled by entering a Printer Redirect URL, the client attempts to 
access the printer and is then redirected to the new printer. The client verifies that it can access the 
new printer before deleting the installed printer and installing the new printer.

Before implementing Printer Agent Redirection, you should be aware of the following:

 When you redirect a mobile-enabled printer, you must ensure the redirected printer is also 
mobile-enabled else the job fails to print. For example, Printer1 is redirected to Printer2. Later, if 
you mobile-enable Printer1, you must ensure to mobile-enable Printer2 before sending a print 
job. 

 When you redirect a Printer Agent, the iPrint Printer List Web page is automatically updated to 
install the redirected printer. This means when a user clicks to install a printer listed from the list 
page, the link has been updated to install the redirected printer.

For example, you redirect a Printer Agent that has the name of Printer_1_Color to a printer 
called Color_Printer. On the iPrint Printer List Web page, the user sees and clicks 
Printer_1_Color. After the printer is installed, the printer listed in the Windows Printer Folder is 
Color_Printer.

 Printers on maps are not automatically redirected. If you are using maps and you redirect the 
Printer Agent, you need to also update your map and republish it to show the newer Printer 
Agent. You should update the map before enabling Printer Agent Redirection because as soon 
as you enter a redirection URL, the link on the map is broken and any user clicking the link in the 
map receives an error. 

 If you redirect a Printer Agent to another printer that is also being redirected, the iPrint client 
attempts to install the final destination printer; however, this might cause undesired results.
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For example, if you have redirected Printer_1_Color to Color_Printer, and then redirect Printer_A 
to Printer_1_Color, the iPrint client attempts to install Color_Printer for Printer_A.

 You should enable Printer Agent Redirection before deleting a printer; otherwise, when the client 
accesses the Print Manager and cannot find the associated Printer Agent for an installed printer, 
the installed printer is deleted.

IMPORTANT: If you are using iPrint Client Management, you should not use Printer Agent 
Redirection. Using Printer Agent Redirection for printers being used by iPrint Client Management can 
cause undesired results.

Instead, you should update iPrint Client Management with the desired printers.

Managing Printer Agent Redirection

Before deleting Printer Agents from a Print Manager, you should enable Printer Agent Redirection for 
iPrint printers by entering another printer URL. By adding the URL before deleting the printer, 
workstations can update to the newest printer.

The Printer Agent Redirection lists include NDPS and iPrint printers. If you enable redirection for 
NDPS printers, then install the iPrint client on the workstations and edit the UpgradeNDPSPrinter= 
entry in the iprint.ini file, NDPS printers can be upgraded. However, if you delete an NDPS 
Printer Agent, redirection is discontinued.

NOTE: By default, the iprint.ini file is located at: /var/opt/novell/iprint/htdocs/iprint.ini.

1 In iManager, click iPrint > Manage Print Manager.

2 Browse to and select a Print Manager.

3 Click Printer Agent Redirection.

4 For each Printer Agent you want to redirect, use the browse button to select the Printer object in 
eDirectory to ensure that you use the correct URL.

If the printer resides in a different tree, you can manually enter the URL in the following format: 
ipp://server/ipp/pa_name where server is the IP address or DNS name of the server and 
pa_name is the Printer Agent. 

5 Click Apply.

Each URL is validated to ensure that the format is valid and that the Printer Agent is available. 
An error is displayed when the URL cannot be validated.

Managing Deleted Printer Agent Redirection

Each time a Printer Agent is deleted, it is moved to the Deleted Printer Agent Redirection list. 
Periodically, you should review this page and delete printers that are no longer being accessed or 
printers where redirection was not enabled.

1 In iManager, click iPrint > Manage Print Manager.

2 Browse to and select a Print Manager.

3 Click Printer Agent Redirection > Deleted Printer Agent Redirection.

4 Select the Printer Agents to delete.

Use Printer Last Accessed Time and Printer Deleted Time to determine if users are still 
attempting to access a specific printer and if sufficient time has passed that you can delete 
Printer Agents from the list.
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5 Click Apply.

Each URL is validated to ensure the format is valid and that the Printer Agent is available. An 
error is displayed when the URL cannot be validated.

8.3.4 Managing Printers

Although the default settings let users print without additional configuration, you might want to modify 
some of those settings so that you can manage your printing resources most effectively. 

 “Creating Secure Printers” on page 119

 “Creating Additional Printers” on page 125

 “Deleting Printers” on page 125

 “Managing Printer Agents” on page 126

 “Using Printer Driver Profiles” on page 126

 “Enabling iPrint Direct” on page 129

 “Managing Print Jobs” on page 129

 “Using Printer Banner Pages” on page 130

 “Modifying the Printer’s Gateway Load Commands” on page 132

 “Configuring LPR Printers” on page 134

 “Configuring Job Holds” on page 135

Creating Secure Printers

You can set up a secure printing environment by using the following methods:

 “Setting Access Control for Your Print System” on page 119

 “Using SSL/TLS for Secure Printing” on page 123

 “Password Caching” on page 125

Setting Access Control for Your Print System

Your print system is designed to take full advantage of eDirectory. You receive all the benefits of 
eDirectory security and ease of management provided by the industry’s most advanced and robust 
directory service. The Access Control feature lets you specify the access that each User, Group, or 
Container object has to your printing resources. Currently, access control for printers is only 
supported on the Windows iPrint Client.

Access control roles are mutually exclusive, even though the same individual might need to perform 
tasks reserved for different roles. For example, only Printer Managers can add or delete printer 
operators or printer users. In a similar way, managers and operators must also be designated as 
users for a printer before they can submit print jobs to it.

In actual implementation, the defaults prevent most problems that might occur from these distinctions. 
For example, a manager is automatically designated an operator and user, and an operator of a 
printer is automatically designated a user of that printer. 

The creator of an object is automatically granted privileges for all available roles for the type of object 
being created. 
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The following sections describe some of the security issues and features you might find useful as you 
plan your print system setup:

 “Setting Access Control for Printers” on page 120

 “Setting Access Control for the Print Manager” on page 121

 “Setting Access Control for the Driver Store” on page 122

Setting Access Control for Printers

Printer security is ensured through the assignment of the manager, operator, and user access control 
roles and by the strategic placement of your printers and printer configurations.

 “Printer Access Control Roles” on page 120

 “Assigning Printer Access Control Roles through Printer Objects” on page 121

Printer Access Control Roles

Different User, Group, or container objects can have different access rights to the same printer. For 
example, if you want only certain users to be able to send jobs to a particular printer, you can specify 
which users should have access and what access roles each user should have.

The following table describes the rights and privileges associated with each of the printer access 
control roles:

Table 8-3   Printer Access Control Roles

Role Description

Manager Tasks performed exclusively by the Manager are those that require the creation, 
modification, or deletion of objects, as well as other edirectory administrative 
functions. Managers are automatically designated as Operators and Users, so 
they can perform all tasks assigned to those operator roles. Typical manager 
functions include the following:

 Modifying and deleting Printer objects

 Adding or deleting operators and users for a printer

 Adding other managers

 Configuring interested-party notification

 Creating, modifying, or deleting printer configurations

Operator Operators are automatically designated as Users, so they can perform all tasks 
assigned to Users roles. Printer management tasks performed by the operator 
include the following:

 Performing all of the functions available through the Printer Control page

 Pausing, restarting, or reinitializing printers

 Reordering, moving, copying, and deleting jobs

 Setting printer defaults, including locked properties

Operators cannot create, modify, or delete eDirectory objects or perform other 
eDirectory administrative functions.
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Assigning Printer Access Control Roles through Printer Objects

Different User, Group, or Container objects can have different access rights to the same printer. For 
example, if you want only certain users to be able to send jobs to a particular printer, you can specify 
which users should have access and what access roles each user should be given.

1 In iManager, click iPrint > Manage Printer.

2 Browse to and select the printer you want to enable Access Control for.

3 Click the Access Control tab.

4 Add or delete Users, Groups, or Container objects to the different access control roles.

5 Click OK.

Setting Access Control for the Print Manager

Print Manager security is ensured through the assignment of the manager access control role.

 “Print Manager Access Control Role” on page 121

 “Assigning the Manager Role for Print Managers” on page 122

Print Manager Access Control Role

The only access control role available for the Print Manager is that of manager. The following table 
explains the tasks performed by the manager role:

Table 8-4   Print Manager Access Control Role

User Tasks performed by users include the following:

 Submitting print jobs

 Managing print jobs they own (users cannot copy, move, reorder, or 
remove jobs they do not own)

To simplify administration, the container a printer resides in is automatically 
assigned as a user for that printer, so all users in that container and its 
subcontainers can use that printer without being added to the list. You can 
delete the container from the list if you want to limit access to certain users, 
groups, or roles.

Role Description

Manager Tasks performed exclusively by the manager are those that require the creation, 
modification, or deletion of print system objects, as well as other eDirectory 
administrative functions. Typical manager functions include the following:

 Creating Printer Agents and Print Manager objects

 Adding or deleting operators and users for a printer

 Adding other managers

 Configuring interested-party notification

 Creating, modifying, or deleting printer configurations

Role Description
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Assigning the Manager Role for Print Managers

To create manager assignments for your Print Manager objects:

1 In iManager, click iPrint > Manage Print Manager.

2 Browse to and select the Print Manager you want to enable access control for.

3 Click the Access Control tab.

4 Add or delete Users, Groups, or containers to the manager role.

5 Click OK.

Setting Access Control for the Driver Store

The Driver Store security is ensured through the assignment of manager access control roles.

 “Driver Store Access Control Roles” on page 122

 “Assigning Managers for the Driver Store” on page 122

Driver Store Access Control Roles

The access control roles available to the Driver Store are manager and public access user. The 
following table explains these roles:

Table 8-5   Driver Store Access Control Roles

Assigning Managers for the Driver Store

To create Manager assignments for your Driver Store objects:

1 In iManager, click iPrint > Manage Driver Store.

2 Browse to and select the Driver Store you want to enable access control for.

3 Click the Access Control tab.

4 Add or delete Users, Groups, or Containers to the manager role.

5 Click OK.

Role Description

Manager Tasks performed exclusively by the Driver Store manager are those that require 
the creation, modification, or deletion of Driver Store objects, as well as those 
that involve other eDirectory administrative functions. Typical manager 
functions include the following:

 Creating, modifying, and deleting Driver Store objects

 Adding other managers

 Adding resources to the Driver Store

Public Access User A public access user is a role assigned to all entities on the network that are 
users of resources provided by the Driver Store. This role is assigned by default 
and does not require specific administrative action by the Driver Store 
manager. Typically, Print Managers refresh their cached copies of printer 
drivers for the printers they are hosting with updated printer drivers from the 
Driver Store.
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Using SSL/TLS for Secure Printing 

Secure printing takes advantage of SSL, which requires users to authenticate with their eDirectory 
usernames and passwords. Users authenticate once per eDirectory tree per session. Between the 
client and the Print Manager, the print data is encrypted and all print communication uses port 443. 
Without secure printing, the printer is available to anyone inside the firewall on the network and the 
print data is not encrypted to the server. Secure printing works in conjunction with the security level 
set for the printer. All print data between the server and the printer is not encrypted because most 
printers do not support encrypted data. Also, when you enable iPrint Direct, data is not encrypted 
between the client and the printer.

If you are using the latest iPrint Client and server software, iPrint automatically attempts to use TLS 
for printing on port 631. TLS printing supports encrypted and non-encrypted print communication 
through port 631. Whether or not encryption is used is dependent on the secure printing setting of the 
Printer Agent. If secure printing is enabled on a printer, the user is required to authenticate, and the 
print data is encrypted. If secure printing is not enabled, the user does not authenticate and the print 
data is not encrypted.

Beginning with Open Enterprise Server and the iPrint Client 4.05, both non-secure and secure 
printing URLs use ipp://.

Prior to Open Enterprise Server, printer URLs were based on http:// and https://. When a non-secure 
printer using an http:// URL changes to a secure printer, the URL changes to https:// or ipp:// and 
users must delete the printer and reinstall the new secure printer. 

 “Enabling SSL/TLS” on page 123

 “Saving Passwords for Secure Printers” on page 123

 “Configuring TLS Printing with Proxies” on page 123

Enabling SSL/TLS

1 In iManager, click iPrint > Manage Printer.

2 Browse to and select the Printer object you want to modify.

3 Click Client Support > iPrint Support.

4 Select the Enable Secure Printing check box.

5 Click Apply or OK to update the printer settings.

Saving Passwords for Secure Printers

When users print to a secure printer, they are prompted for the eDirectory username and password. 
Users can select to have their workstations remember their password for printing. For Windows NT/
2000 users, passwords are saved on a per-user basis.

Configuring TLS Printing with Proxies

To use a proxy with secure printing:

1 Create a file in /etc/opt/novell/httpd/conf.d named mod_proxy.conf.

2 Add the following lines to the file:
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LoadModule proxy_module /usr/lib/apache2-worker/mod_proxy.so
LoadModule proxy_connect_module /usr/lib/apache2-worker/mod_proxy_connect.so
LoadModule proxy_http_module /usr/lib/apache2-worker/mod_proxy_http.so

# This is the port the proxy will listen on
Listen 8080

ProxyRequests On
ProxyVia On
<Proxy *>
    Order deny,allow
    Allow from All
</Proxy>
AllowCONNECT 631 443

3 Set the proxy port on the client to 8080.

4 Restart Apache.

To set up a Squid proxy:

IMPORTANT: Implementing the following changes lets your users print using TLS; however, there 
are security risks involved. Contact your Security Administrator before completing these steps.

1 Rename the Squid configuration file by using the following command: mv /etc/squid/
squid.conf /etc/squid/squid.conf.orig

2 Create a new /etc/squid/squid.conf file.

3 Add the following lines to the file:

http_port 3128

#acl all src all
acl manager proto cache_object
acl localhost src 127.0.0.1/32
acl to_localhost dst 127.0.0.0/8
acl SSL_ports port 80 443 563 631
acl Safe_ports port 80          # http
acl Safe_ports port 21          # ftp
acl Safe_ports port 443 563 631 # https, snews
acl Safe_ports port 70          # gopher
acl Safe_ports port 210         # wais
acl Safe_ports port 1025-65535  # unregistered ports
acl Safe_ports port 280         # http-mgmt
acl Safe_ports port 488         # gss-http
acl Safe_ports port 591         # filemaker
acl Safe_ports port 777         # multiling http
acl CONNECT method CONNECT

acl ipp_access port 631
http_access allow all
miss_access allow all
http_access allow CONNECT ipp_access
http_reply_access allow all
icp_access allow all
miss_access allow all
ignore_expect_100 on

4 Set the proxy port on the client to 3128.

5 Restart Squid.
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Password Caching

When users change their passwords, secure printers might continue printing with the old password 
for up to 10 minutes. This is caused by caching inside the iPrint LDAP authentication module, and 
affects only the users created inside the local eDirectory tree on iPrint Appliance.

To resolve this issue, see Section 11.5.10, “Secure Printer Continues Printing after Changing the 
User Password (Local Appliance eDirectory Users Only),” on page 206.

Creating Additional Printers

Before creating additional printers, ensure that you meet the following prerequisites:

 Have the Supervisor right for the destination container where its associated Printer object is to 
reside.

 Be designated as a manager of the Print Manager that controls this printer.

 Have a Driver Store running.

 Have a Print Manager running.

To create additional printers:

1 In iManager, click iPrint > Create Printer.

2 Fill in the fields.

Click Help for explanations about the fields.

3 Click OK.

4 Click Next, then select the drivers for this printer.

If the printer drivers for this printer are not listed, you can still create the printer. After the printer 
is created, you can add the printer drivers to the Driver Store and then associate the drivers to 
the printer by clicking Manage Printer > Drivers.

These drivers are automatically downloaded to users’ workstations when they install the printer 
in the future.

Because the list of printer drivers included with this product is limited, you can add drivers to the 
Driver Store. See “Updating Printer Drivers” on page 104 for more information.

If you do not select a driver, users are prompted to provide a disk with the appropriate driver the 
first time they install this printer on their workstations.

5 Click Next to create the printer.

Deleting Printers

You use iManager to delete existing Printer Agents. Before deleting a Printer Agent, ensure that the 
agent is no longer being used by running an report on the printer or by using Printer Agent 
Redirection to redirect the printer for a period of time before deleting it.
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WARNING: Deleting a printer permanently removes the printer from the Print Manager. You cannot 
use Printer Agent Redirection. The printer is automatically removed from workstations the next time 
the workstation communicates with the Print manager. 

1 In iManager, click iPrint > Delete Print Object.

2 Browse to and select the objects you want to delete.

3 Click OK.

Managing Printer Agents

You use iManager to manage Printer Agents. You can start up and shut down a Printer Agent, pause 
and resume input and output, view printer information, set configuration settings, and change the 
printer drivers. 

1 In iManager, click iPrint > Manage Printer.

2 Browse to and select the printer you want to manage.

3 Use the tabbed property pages to complete the task you want.

Using Printer Driver Profiles 

A printer driver profile allows you to set the driver defaults for a Windows printer driver. When you 
associate the printer driver profile to a printer, the printer is installed and configured with your defined 
settings. For example, in a law office you might want the default paper size to be legal size. This 
means that every time the printer and its corresponding driver is installed on a workstation, the paper 
size is set to legal size.

When creating a printer driver profile, you work directly with a platform-specific printer driver; so you 
should create and modify profiles from the same operating-specific platform as the printer driver. For 
example, to create or modify a Windows 2000 printer driver profile, you must access iManager and 
complete the task from a Windows 2000 workstation.

Use the Bi-Directional driver option to enable the selected printer driver to communicate with the 
printer. Bi-Directional communication allows the driver to communicate with the printer and discover 
its capabilities. This enables you to create more detailed profiles. Bi-Directional drivers communicate 
with the printer during profile creation. If your printer is not reachable from the client during profile 
creation, only basic profiles are created. When you create a profile for Bi-Directional drivers, you must 
provide a Printer Agent.

Use the Universal Printer Driver (UPD) model to simplify the task of managing the vast array of printer 
makes and models. This model allows the printer vendor to create a single printer driver that works 
with most of the printer and multifunction devices that the vendor manufactures. With this innovation, 
the Administrator/User no longer needs to install a unique driver for each and every printer model, but 
uses one driver to communicate with their devices. 

Installing the UPD on the iPrint server (NetWare or Linux) is the same as installing individual drivers. 
Use iManager to upload the driver to the Broker or Driver Store and then assign this driver to the 
printers. You should use the latest iManager and also the latest support packs/updates for the iPrint 
server. The latest updates include support for Windows 7, printer driver profile updates, and 
enhancements for bidirectional communications, which are necessary for UPD function and printer 
driver profile creation. For more information, see “Novell iPrint Universal Printer Driver Support” (http:/
/www.novell.com/products/openenterpriseserver/pdfs/iprint_upd_environment.pdf). 
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You can create, copy, delete, and modify the printer driver profiles.

 “Creating a Printer Driver Profile” on page 127

 “Modifying a Printer Driver Profile” on page 127

 “Copying a Printer Driver Profile” on page 128

 “Deleting a Printer Driver Profile” on page 128

 “Associating a Printer Driver Profile with a Printer” on page 128

Creating a Printer Driver Profile

1 In iManager, click iPrint > Printer Driver Profile.

2 Browse to and select the Print Manager where you want the driver profile to be stored and made 
available to the printers on that manager.

3 From the Select operation drop-down menu list, select Create Printer Driver Profile and click OK.

4 In the Create driver profile window, perform the following tasks:

4a Specify the Driver Profile name.

You can create a new driver profile or you can use the existing driver profile.

4b To create a new driver profile, select Create new driver profile and then select the driver for 
new profile from the list.

4c To use the existing driver profile, select Create using existing driver profile and then select 
the driver profile from the list of existing driver profiles.

The associated printer model of the selected driver profile is displayed.

4d To enable printer communication, select the Requires printer communication check box.

4e Specify the name of the existing Printer Agent in the iPrint Printer name field. The driver 
profile is created and associated with the printer model.

NOTE: Ensure that your printer is reachable from the client during profile creation, or only 
basic profiles are created. 

4f Click Next.

The Loading Driver Configuration window appears and shows the progress.

4g When the driver profile is loaded, the Save Driver Profile page is displayed. Click Next.

The complete page opens. 

4h Click OK.

The driver profile is created. 

After creating a printer driver profile, you must associate it with a printer. For information on 
associating the driver profile, see “Associating a Printer Driver Profile with a Printer” on 
page 128.

Modifying a Printer Driver Profile

1 In iManager, click iPrint > Printer Driver Profile.

2 Browse to and select the Print Manager where you want the driver profile to be stored and made 
available to the printers on that manager.

3 From the Select operation list, select Modify Printer Driver Profile and click OK.

4 Select the Driver Profile that you want to modify and click Next.

You can select only one driver profile at a time for modification.
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5 (Optional) Specify the name of the existing Printer Agent in the iPrint Printer name field and click 
Next.

Ensure that the printer model matches the profile printer model.

This option is displayed only if the printer model is displayed. 

The printer model is displayed if you have selected Requires printer communication when 
creating the printer driver profile.

The Loading Driver Configuration window is displayed to indicate the progress.

6 When the driver configuration is completed, the Modify Driver Profile page is displayed. Click 
Next.

The complete page is displayed. 

7 Click OK.

The driver profile is modified.

Copying a Printer Driver Profile

1 In iManager, click iPrint > Printer Driver Profile.

2 Browse to and select the Print Manager where you want the driver profile to be stored and made 
available to the printers on that manager.

3 From the Select operation drop-down list, select Copy Printer Driver Profile, then use the 
Destination printer manager name list to select the Printer Manager where you want to copy your 
driver profile. Click OK.

4 Select the Driver Profiles that you want to copy and click Next.

The complete page is displayed. 

5 Click OK.

The driver profile is copied.

Deleting a Printer Driver Profile

1 In iManager, click iPrint > Printer Driver Profile.

2 Browse to and select the Print Manager where the driver profile that you want to delete is stored.

3 From the Select operation drop-down list, select Delete Printer Driver Profile and click OK.

4 Select the driver profiles that you want to delete and click Next.

The complete page is displayed. 

5 Click OK.

The driver profile is deleted.

Associating a Printer Driver Profile with a Printer

1 In iManager, click iPrint > Manage Printer.

2 Browse to and select the printer you want to modify.

3 Click Drivers > Drivers Platform.

4 Select the printer driver from the list of available drivers.

5 Select the profile that you want to associate with this printer from the list of Available Driver 
Profiles for Selected Driver.
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If you do not want a profile to be associated, select None.

6 Click OK to save the changes.

Enabling iPrint Direct

A printer that is enabled for iPrint Direct sends print jobs directly to the printer instead of sending the 
job to the Print Manager first. A job is sent to the printer in LPR or raw 9100 format, depending on the 
setting in the gateway autoload command for the printer. Although this greatly reduces server 
communication, the ability to audit print jobs is lost. iPrint Direct supports direct banner printing (if the 
banner is already configured) and driver updates. The printer information is gathered directly from the 
printer by using SNMP.

NOTE: Direct Banner for iPrint Direct is supported only on Windows.

1 In iManager, click iPrint > Manage Printer.

2 Browse to and select the printer for which you want to enable iPrint Direct printing.

3 Click Client Support > iPrint Direct.

4 Select the Enable iPrint Direct Printing option.

5 Click OK.

NOTE: For detailed information on iPrint Direct, see Technical Information Document (TID #7001343) 
on the Novell Support Site. 

Managing Print Jobs

The following sections provide specific information about the print job management features. Users 
designated as managers or operators for a printer can perform these tasks for all jobs routed to that 
printer; individual job owners can perform these tasks only for their own print jobs.

 “Viewing Print Job Information” on page 129

 “Deleting Print Jobs” on page 129

 “Changing the Order of Print Jobs” on page 130

Viewing Print Job Information

You can view information about individual print jobs waiting to be processed by a specific printer.

1 In iManager, click iPrint > Manage Printer.

2 Browse to and select the printer the job was sent to.

3 Click Printer Control > Jobs.

Information about print jobs is displayed.

Deleting Print Jobs

Administrators can delete any print job after it has been submitted if the job has not yet started 
printing. Users can delete only their own print jobs.

1 In iManager, click iPrint > Manage Printer.

2 Browse to and select the printer the job was sent to.
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3 Click Printer Control > Jobs.

4 Select the check box next to the job you want to delete.

5 Click Delete.

Changing the Order of Print Jobs

Occasionally, you might need to print a job ahead of other jobs that have already been submitted to a 
printer but have not yet started printing. Administrators, managers, and operators can move any job 
up or down the list. Users can move only their own jobs, and can move them only down the list. 

1 In iManager, click iPrint > Manage Printer.

2 Browse to and select the printer the job was sent to.

3 Click Printer Control > Jobs.

4 Select the check box next to the job you want to modify.

5 Click Promote to move a print job up the list.

Using Printer Banner Pages

Banner pages create a cover sheet for each print job that a printer produces. You use the Printer 
Banner Configuration task to customize the information printed on a banner to your needs. If you 
select to display eDirectory information such as the eDir e-mail address, the Print Manager needs 
rights to read these attributes. Follow the steps in “Using eDirectory Attributes with Custom Banners” 
on page 131. 

 “Configuring a Custom Banner” on page 130

 “Associating a Custom Banner to a Printer” on page 131

 “Using eDirectory Attributes with Custom Banners” on page 131

Configuring a Custom Banner 

1 In iManager, click iPrint > Printer Banner Configuration.

2 Browse to and select the Print Manager you want.

3 Select an operation and click OK.

Create Custom Banner: Lets you create a new custom banner.

Delete Custom Banner: Lets you delete an existing banner.

Modify Custom Banner: Lets you edit the settings of an existing custom banner profile.

4 Complete the fields with the information you want. If you create multiple banners, you should use 
banner names that are descriptive enough to identify them when you associate the banner to a 
printer.

5 Select the Banner Text Location.

This is where the banner option information appears on the banner page. The banner 
information is grouped together and then placed as a unit either starting at the top of the page, 
centered on the page, or starting at the bottom of the page.

6 Select the banner options you want and the font size you want to display the information.

7 Click OK to save the changes.
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Associating a Custom Banner to a Printer

1 In iManager, click iPrint > Printer Banner Configuration.

2 Browse to and select the Print Manager where the Printer Agents are hosted.

3 Select Assign Custom Banner, then click OK.

4 From the Custom Banner drop-down list, select the banner you want.

5 Select the check box next to each printer you want this banner associated with.

When you select the check box, the banner name appears in the Assign Banner field. To 
associate a different banner, select the desired banner from the Custom Banner drop-down list, 
and select the check box for the printer you want to change. If you do not want a banner to be 
used, select None.

You can also assign banners when you use the Manage Printer task.

1 In iManager, click iPrint > Manage Printer.

2 Browse to and select the printer you want to modify.

3 Click Configuration > Custom Banners.

4 In Available Banners, select the banner that you want this printer to use.

5 Click OK to save the changes.

If you select to display eDirectory information such as the eDir e-mail address, the Print Manager 
needs rights to read these attributes. Follow the steps in “Using eDirectory Attributes with 
Custom Banners” on page 131.

Using eDirectory Attributes with Custom Banners

Custom banners lets you select the information you want displayed on the banner page. Some of the 
banner options use information contained in eDirectory. In order for the Print Manager to obtain this 
information, you must modify the trustee rights and give the Print Manager read rights to these 
properties. Because rights flow down the eDirectory tree, you can assign the trustee right at a 
container level above the users, or to the tree.

1 In iManager, click Rights > Modify Trustees.

2 Select the container or tree where you want to modify the rights.

3 Click Add Trustee, then select the Print Manager object.

4 Click Add Property, then select the Show All Properties in Schema check box.

5 Select the attributes that you want:

Banner Option eDirectory Property

eDir mail stop mailstop

eDir e-mail address EMail Address

eDir location L

eDir telephone number Telephone Number

eDir user first name Given Name

eDir user full name Full Name

eDir user last name Surname
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6 Click OK.

7 Ensure that at least the Read right is selected.

8 Click Done.

NOTE: If your client, printer, and server are not all configured for the same language, you might 
experience problems with the output of your banner pages, such as the job name being corrupted. If 
you are working in this type of mixed environment, you should consider not using banner pages.

Modifying the Printer’s Gateway Load Commands

1 In iManager, click iPrint > Manage Printer.

2 Browse to and select the printer you want to modify.

3 Click Configuration > Gateway.

4 Edit the gateway autoload command.

The following table describe the gateway load commands and parameters that can be used.
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Gateway Load Parameters Description

IPRINTGW The gateway executable that is loaded for the Printer Agent.

PA= The name of the Printer Agent to be supported by this gateway 
instance.

PORT= The port on the physical printer to be used for print job 
submission. Valid values are:

LPR: Specifies the LPR print protocol and resolves to the 
standard LPR port - 515.

RAW: Specifies the RAW print protocol and resolves to the 
default RAW port - 9100 unless the port number is specified 
separately in the load string. Port 91 can also be used instead of 
9100.

Number: The actual port number for the physical printer.

NODATA: Specifies the LPR print protocol, but document data is 
not submitted to the physical printer.

NULL: SNMP and ping are disabled for this gateway instance. 
Document data is not submitted to the physical printer.

STRICTLPR Limits the port number on the gateway side of LPR 
communication to the standard LPR range of sockets (721 - 
1020).

This parameter is needed only for some older printers that 
enforce the range of ports specified by the original LPR 
specification for LPR clients.

HOSTADDRESS=  

HOSTNAME= 

HOST=

IPADDRESS=

Any of these specifies the hostname / IP address for the physical 
printer to be supported by this gateway instance.

NOTE: If the hostname / address value has :nn at the end of the 
value, the port number for the printer is derived from this value.

However, the most common approach is to specify the port with 
the PORT= parameter.

PRINTERNAME=

PRINTER=

The printer / queue name for LPR protocol print sessions to the 
physical printer. The default value is PASSTHROUGH.

USERNAME_CN Passes only the user name for LPR communication. 

For example, if the user name is admin and container is novell, 
then on passing this parameter, the user name passed is 
"admin". If this parameter is not passed, the user name is 
passed in FQDN format (admin.novell).

USERNAME_TRUNCATED Truncates the length of the user name to 31 characters as per 
standard LPR protocol. 

GETCOMMUNITYSTRING= 

GET=

Specifies the community string for SNMP requests. This is only 
needed when a printer has been configured with a community 
string that is different from the default string "public".
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5 Click OK to save the changes.

Configuring LPR Printers

To complete the LPR configuration, users need to know the LPR Host and the LPR Printer/Queue 
information, which is the Printer Agent name, provided in iManager. The iPrint Client is not required 
for LPR printing.

UNIX, Macintosh, and other LPR clients can print to iPrint printers through LPR. 

IMPORTANT: In order for LPR to work, the Printer Agent name cannot contain spaces. If it does, you 
need to re-create the Printer Agent or select a different printer.

To set up an iPrint printer to accept LPR print jobs, you need to enable LPR/LPD printing for the 
printer.

1 In iManager, click iPrint > Manage Printer.

2 Browse to and select the printer you want to enable LPR printing for.

SQUERYACTIVE= Specifies the interval between SNMP requests to the physical 
printer while the printer is idle. The default value is 300 seconds 
(5 minutes).

SPOLL= Specifies the interval between SNMP requests to the physical 
printer while the printer is active or idle.

SETCOMMUNITYSTRING= Sets the community string to be used for the SNMPGet and 
GetNext requests.

JPOLL= Sets the job polling interval (in seconds). 

NOTE: When the JPOLL option is not set, the job polling interval 
is 2 seconds. 

NOSNMP Disables SNMP requests for this gateway instance to its 
respective physical printer.

WAITONPRINTER= Specifies the number of minutes to timeout for communication to 
the physical printer.

NOTE: For write attempts, this parameter is only effective if the 
value is greater than the minimum default timeout value. If 
SNMP is disabled by the NOSNMP or the NULL parameter, the 
minimum default is 15 minutes. If SNMP is active, the minimum 
default is 5 minutes.

THROTTLE= Specifies a delay of nn seconds while establishing 
communication with the physical printer and between print jobs. 
This is primarily used for solving a problem where the end of a 
job is lost when submitting an LPR job to a windows system.

KYOCERA= Sets the Printer Manufacturer (Make) attribute for this Printer 
Agent to "Kyocera".

RICOH= Sets the Printer Manufacturer (Make) attribute for this Printer 
Agent to "Ricoh".

TROY= This has no effect.

Gateway Load Parameters Description
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3 Click Client Support > LPR Support.

4 Select the Enable LPR/LPD Client Support check box.

The LPR Host and LPR Printer/Queue fields display information required when setting up 
printing for Macintosh, UNIX, or other LPR clients.

LPR Host: The server name where the Print Manager is running.

LPR Printer/Queue: The same as the Printer Agent’s name. The Printer Agent name cannot 
contain any spaces; otherwise, LPR does not work properly.

5 (Optional) Enable the following options:

Filter All LF to CRLF and Append FF to Jobs: Selecting this check box changes bytes in the 
LPR data stream of all incoming LPR print jobs from Line Feeds to Carriage Returns with Line 
Feeds and appends a Form Feed to the end of the print job. Typically, these changes are made 
at the LPR client; however, if you are sure of your users’ configurations, you can implement this 
option.

Address Ranges: Add an address range only if you want to restrict access to this printer to LPR 
clients within the address range. When the list is empty, all addresses are allowed to print 
(default).

6 Click Apply or OK to update the printer settings.

7 From the UNIX, Macintosh or other LPR client, set up a printer using the LPR Host and LPR 
Printer/Queue information displayed in Step 4. 

Configuring Job Holds

1 In iManager, click iPrint > Manage Printer.

2 Browse to and select the printer you want to modify.

3 Click Configuration > Job Holds.

4 Modify the settings.

Operator Hold: A job does not print until the operator releases it.

User Hold: A job does not print until the user who has submitted the job releases it.

5 Click OK to save the changes.

8.3.5 Using iPrint Client Management

iPrint Client Management (iCM) includes functionality similar to the Remote Printer Management 
feature included in Novell Distributed Print Service, which lets you designate printers to be installed 
on a workstation when a user logs in to the workstation using the Novell Client. Previously, this 
functionality was only available with NDPS printers, but now it is available for iPrint printers. iCM also 
lets you control the iPrint Client configuration, making it easier to configure the iPrint Client without 
visiting each workstation. When the user logs in to the workstation using the Novell Client, the iPrint 
Client settings you designate are configured on the user’s workstation.

iCM is available for Windows 2000/XP/2003/2008/Vista/7/8/8.1/2012/2012 R2 workstations, and 
requires the following:

 iPrint iManager plug-in for Linux or the iPrint iManager plug-in for NetWare dated May 2006 or 
later

 Novell iPrint Client v4.17 or later (install after the Novell Client)

 iprint.ini

 eDirectory schema update from NetWare 6.5 Support Pack 8 or later.
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NOTE: iPrint Client Management does not support dynamic groups.

IMPORTANT: Novell iPrint Windows Client components of version 5.72 and later do not require the 
Novell Client. However, Novell iPrint Windows Client components of versions prior to 5.72 need 
Novell Client 4.91 for Windows 2000/XP/2003 or later. For more information, see “Configuring iCM for 
Windows / Active Directory (AD) environments without Novell Client” on page 137.

All of the required components are included in NetWare 6.5 Support Pack 8 except the Novell Client 
4.91 for Windows 2000/XP, which is available from the Novell Support Web site (http://
support.novell.com/produpdate/patchlist.html#client).

The iPrint iManager plug-ins also work with Mobile iManager. Mobile iManager is available at Novell 
Downloads (http://download.novell.com/SummaryFree.jsp?buildid=BJosshlLid0~).

NOTE: You can install the iPrint iManager plug-in for NetWare NPM on Mobile iManager or iManager 
running on NetWare. You can install the iPrint iManager plug-in for Linux on Mobile iManager or 
iManager running on Linux or NetWare. Depending on your iManager configuration, you might see 
two iPrint roles. The iPrint role is for iPrint running NetWare tasks, and, the iPrint (Linux) role is for 
iPrint running Linux tasks. 

With iCM, you manage a set of attributes on a given eDirectory tree regardless of whether the printers 
are hosted on an Open Enterprise Server NetWare or a Linux server, because iCM is configured and 
managed through eDirectory objects.

Use the following information to install and configure iCM:

 “Understanding the Schema Update” on page 136

 “Deploying iPrint Client Management” on page 137

 “Configuring iCM for Windows / Active Directory (AD) environments without Novell Client” on 
page 137

 “Managing iPrint Client Settings” on page 137

 “Automatically Installing Printers” on page 138

 “Using Advanced Settings” on page 139

 “iCM in OES Environment” on page 140

 “iCM with iPrint Appliance” on page 141

Understanding the Schema Update

iPrint Client Management requires you to extend the eDirectory schema. The iprint.sch file (found 
in - /opt/novell/sch/iprint.sch) contains the schema extension, which adds some optional 
attributes to Organization, Organizational Unit, Groups, and User object class definitions. The 
attributes are:

 iPrintiCMPrinterList

 iPrintiCMClientTrayURI

 iPrintiCMClientProxyURI

 iPrintiCMClientFlags
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Users should be able to read these new attributes on their user objects; however, if you plan to 
configure iCM at an Organization, Organizational Unit, or Group object level, users might need the 
Read right to read the attributes. The first time you access iCM on an Organization, Organizational 
Unit, or Group object in iManager, iManager attempts to assign the Read right to the attributes. Then 
users should be able to read these attributes through inheritance on subcontainers and groups. If 
iManager cannot assign the read right to the Organization, Organizational Unit, or Group object, your 
configuration is saved, but a message appears explaining that rights to the attributes could not be 
granted. You need to grant rights to these iPrint attributes by using either the eDirectory 
Administration or Trustee task in iManager.

TIP: To avoid multiple explicit rights assignments for the iCM attributes, you should make your first 
iCM assignment as high in the eDirectory tree as possible so that the rights can flow down the tree. 
You could even make an iCM assignment so that the Read right is set, and then disable the iCM 
assignment because this does not remove the Read right to the attributes.

Deploying iPrint Client Management

1 Distribute the iPrint Client version 4.26 or later.

For more information, see . If the iPrint Client is has already been distributed, see “Updating the 
iPrint Client” on page 167.

If you use iprint.ini to distribute the iPrint Client, you need to allow enough time for users to 
update to the new client before configuring iCM. If you do not allow enough time, the client 
attempts to update a workstation at the same time it is trying to deploy the settings in iCM.

2 Configure iPrint Client Management in iManager.

See “Managing iPrint Client Settings” on page 137 or “Automatically Installing Printers” on 
page 138 for more information.

Configuring iCM for Windows / Active Directory (AD) environments 
without Novell Client

The Novell iPrint Windows Client (version 5.72 and later) now supports Windows / Active Directory 
environments without the Novell Client. This new feature provides shared authentication with the 
Windows Login, and also supports iCM for printer distribution and client settings. The following 
prerequisites should be met:

 Synchronization of users, groups, and containers (via Novell Identity Manager or a similar 
synchronization tool) 

 Standardization on LDAP user names that require unique user names and require the uniqueID 
attribute to be set

Managing iPrint Client Settings 

You can standardize the iPrint Client settings for users by using iCM Client Configuration to define the 
attributes for an Organization, Organizational Unit, Group, or a User Object. The attributes are 
delivered as a complete set, meaning that if you change only one attribute, all of the attributes are 
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delivered to the client. The changes are not additive, so you cannot change the value of an attribute 
for an object and change the value of a different attribute on another object. Only the set of attributes 
closest to the user’s object are used.

When a user logs in, iCM walks up the tree from the user’s container to the highest container in the 
user’s fully distinguished name. Then iCM starts applying the iCM attributes in each container as it 
walks back down to the user object. Then the user's group membership list is queried for the same 
attributes. Those closest to the User object have a higher priority. The set of attributes on or closest to 
the User object is always used.

WARNING: Using iCM on group objects can simplify making assignments, but using iCM on multiple 
groups can cause undesired results. You should create a new Group object with a descriptive name 
so that you can control the desired results for users that you assign to that group.

To configure the iCM client attributes:

1 In iManager, click iPrint > iPrint Client Management.

2 Browse to and select the Organization, Organizational Unit, Group, or User object you want to 
automatically configure iPrint Client Settings for.

3 Click Client Configuration.

4 Configure the attributes you want for the iPrint Client on the workstation.

Click Help for explanations about the attributes.

5 Click OK to save the changes.

Automatically Installing Printers

iPrint Client Management Printer Configuration lets you designate printers to be downloaded and 
installed automatically on user workstations when users log in to the network. These printers appear 
in the user’s printers folder, ready for use. You can also use this feature to remove printers, assign a 
printer to be the default printer, and set a printer to be a temporary printer so that it is removed when 
the workstation is rebooted.

iCM configures printers on workstations based on assignments made on the User object, Group 
object, Organization, and Organizational Unit container. When you use iManager to designate a 
printer for automatic installation on a user's workstation, the associated eDirectory Container, Group, 
or User object is updated with this information. 

The actions taken are cumulative, meaning that action is taken for each assignment you made. For 
example, if you add two printers at one level, then add three more printers at another level, the 
workstation has all five printers installed. If you have more than one printer set as the default, the last 
printer installed is set as the default.

When a user logs in, iCM starts searching at the highest container in the user’s full distinguished 
name, looking for the iCM Printer Configuration associated to containers and groups. The search 
continues through subcontainers down to the User object. Printers continue to be added or removed 
to the workstation as specified by iCM. If the Allow Only Specified Printers to Reside on Workstation 
option is enabled, any actions to printers specified above that container or group in the user’s fully 
distinguished name are ignored, but any actions to printers specified between that point and the User 
object are taken.

 If the client finds a printer designated for installation that has not yet been installed, it is 
automatically installed.

 If a currently installed printer is added to the Printers to Remove list, that printer is automatically 
uninstalled.
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 If you designate a different printer to be the default, the change is made.

 Using Do Not Update Workstations turns off iCM for printers at that container, group or user, but 
actions for iCM printers found on other containers or groups are taken.

WARNING: Using iCM on group objects can simplify making assignments, but using iCM on multiple 
groups can cause undesired results. You should create a new Group object with a descriptive name 
so that you can control the desired results for users that you assign to that group.

To automatically install printers:

1 In iManager, click iPrint > iPrint Client Management.

2 Browse to and select the Organization, Organizational Unit, Group or User object you want to 
automatically install printers for.

3 Configure the attributes you want for the Printer Configuration option.

Do Not Update Workstations: iCM for printers is disabled and printers are not installed or 
removed from workstations. Printers already installed are not altered.

Allow Only Specified Printers to Reside on Workstations: Allow only the iPrint printers 
specified in the Printers to Install list to reside on the workstation. All other iPrint printers on the 
workstation are removed. Non-iPrint printers are not affected.

4 Use the buttons to modify the Printers to Install list.

If you select a printer to be the default and want to remove the Set as Default attribute, click the 
button next to to the Default Printer field.

5 Modify the Printers to Remove list.

6 Click OK to save the changes.

Using Advanced Settings

The iPrint Client Management Advanced Settings page lets you configure how far up the eDirectory 
tree iCM should look for iCM client settings and printers. You can also configure whether the iCM 
results dialog box should display on the workstations, which is useful for troubleshooting the iCM 
results.

1 In iManager, click iPrint > iPrint Client Management.

2 Browse to and select the Organization, Organizational Unit, Group or User object you want to 
configure the settings on.

3 Click Advanced Settings.

4 Configure these settings as needed:

Ignore iPrint Client Management (iCM) settings on parent containers: Limits the scope 
used to find iCM client settings and assigned printers to the object where the assignment is 
made and below. You can enable this setting on User, Group, and Container objects. You should 
enable this setting to limit traffic on the network, especially across slow network links.

When a user logs in, iCM checks the User object and group memberships, then it walks up the 
eDirectory tree from the user object to the root-most container to determine where iCM 
assignments have been made. If iCM encounters the Ignore Settings on Parent Containers 
attribute, iCM stops walking up the tree on that object. Then, iCM implements the iCM client 
settings and printers on the workstation.

To determine the iCM printers for the workstation, iCM searches down to the User object, adding 
and removing iCM printers as specified on each Container, Group, or User object. For iCM client 
settings, iCM uses the set of iCM client attributes closest to or on the User object. 
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The attributes are delivered as a complete set, meaning that if you change only one attribute, all 
of the attributes are set on the client. The changes are not additive, so you cannot change the 
value of one attribute for an object and change the value of a different attribute on another 
object. Only the set of attributes closest to or on the user’s object are used.

The following table describes the behaviors when enabling this setting on different objects.

Display iCM results in a dialog box on workstations: Displays a window on the workstation 
that shows the printers that were installed and removed.

5 Click OK to save the changes.

iCM in OES Environment

Traditionally iCM was used in the following methods:

 “iCM with Novell Client” on page 140

 “iCM without Novell Client” on page 140

iCM with Novell Client

In OES iPrint, when a user logs in to the corporate eDirectory using the Novell Client, the iCM settings 
are pushed to the user’s machine.

iCM without Novell Client 

In iPrint Appliance, users cannot login directly using the Novell Client. This is because iPrint 
Appliance syncs only user names from the corporate eDirectory, but not the passwords. For iCM to 
work with iPrint Appliance, you can use one of the following methods:

 Novell Client users continue to login to the existing corporate eDirectory instead of iPrint 
Appliance. This way, the existing OES server is used for desktop printing, and the iCM settings 
are available only in the source eDirectory.

Object Behavior

User Only the iCM client settings and printers assigned to the User object 
are used. iCM does not check any group memberships, the User 
object's container, or parent containers.

Group iCM checks assignments on the User object and all associated 
groups, but does not check the User object's container or parent 
containers. All group memberships are read and assignments are 
considered even if this setting is enabled on just one group. This is 
useful if you want to apply iCM client settings or assigned printers 
from a group membership, but do not want any iCM client settings or 
assigned printers from the User object's container.

IMPORTANT: Using iCM on Group objects can simplify making 
assignments, but using iCM on multiple groups could cause undesired 
results. You should create a new Group object with a descriptive name 
so that you can control the desired results for users that you assign to 
that group.

Organization or 
Organizational Unit

iCM checks assignments on the user object, all associated groups, 
and each container up to a parent container where this setting is 
enabled.
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Limitation: In this method, the iCM settings are fetched only from the source eDirectory. Any 
iCM setting changes made on iPrint Appliance are not applied.

 Use iCM without Novell Client. In this method, the local Windows/AD credentials must match the 
eDirectory credentials. This method is suitable for an AD environment where users are synced 
from AD to the local eDirectory so that the credentials are automatically matched. For more 
information, see “iCM with iPrint Appliance” on page 141.

Limitation: In this method, the iCM setting are fetched only from iPrint Appliance. iCM setting 
changes made on the existing corporate eDirectory must be manually added on iPrint Appliance.

iCM with iPrint Appliance

iPrint Appliance does not support traditional iCM with the Novell Client. iPrint Appliance supports iCM 
using Windows Local/AD credentials.

Depending on your environment, you can deploy iCM in the following ways:

Apply iCM Settings from the Original Tree

In this configuration, iCM settings are applied from the original tree if iCM is not migrated from OES, 
and OES iPrint is still used for desktop printing and iCM. You can use this configuration with or 
without the Novell Client.

The limitation of using this configuration is that the iCM settings are fetched only from the source 
eDirectory. Any iCM changes made locally on iPrint Appliance are not applied.

Apply iCM Settings from iPrint Appliance eDirectory

In this configuration, iPrint Appliance is used for desktop printing, and iCM settings are created on the 
appliance only.

With Novell Client: With iPrint Appliance, users cannot login directly using the Novell Client because 
iPrint Appliance syncs only user names from the corporate eDirectory, but not the passwords. 
Therefore, iCM cannot be used with Novell Client. iCM can be used against the source eDirectory 
server.

Without Novell Client: To fetch iCM settings from iPrint Appliance, you can use iCM without the 
Novell Client. In order for iPrint clients to use the Windows Local/AD credentials for iCM, the following 
conditions must be met:

 You must set the iPrint Appliance address set as the primary PSM address on the client by using 
the command iprntcmd -S <iPrintAppliance IP Address>.

 The client’s Active Directory user name must match their iPrint Appliance credentials. If you 
import users from Active Directory to iPrint Appliance, the credentials are automatically matched.

 In order for iCM to work with imported users and groups, you must enable browse/read rights 
and inheritance for iCM for the following attributes, using iManager:

 iPrintPrinterIPPURI

 iPrintiCMClientFlags

 iPrintiCMClientProxyURI

 iPrintiCMClientTrayURI

 iPrintiCMPrinterFlags

 iPrintiCMPrinterList
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 iPrintiCMTrustedSiteList

 Group Membership

IMPORTANT: For the user accounts imported from OES, iCM settings are not migrated. You must 
reassign the iCM settings on iPrint Appliance for the OES user accounts.

To configure the iCM attributes:

1 On a Web browser, use either the DNS name or the IP Address to access iManager. For 
example, https://10.0.0.1/nps or https://iprint.example.com/nps.

2 Specify admin as the user name.

3 Specify the password, then click Login.

4 In the left pane, under Roles and Tasks, click Rights.

5 Click Modify Trustees.

6 Under Object name, click the search icon, then choose the entire tree.

7 Click OK.

8 Click the Assigned Rights link next to the Public domain.

9 Click the Add Property button in the upper right of the table.

10 In the Add Property pop-up window, select Show all properties in schema.

11 In the Property name box, select the attributes listed above, then click OK.

12 Select the Inherit check box next to the attributes you added.

13 Click Done.

For more information on using Windows Local/AD credentials for iCM, see the “Configuring iCM for 
Windows / Active Directory (AD) environments without Novell Client” on page 137.

8.4 iPrint Printer Status
The iPrint Printer Status tools provides a global view of your print system. The tool displays the 
current status of Printer Agents, and lets you configure settings and generate reports about your print 
system.

For more information about the iPrint Printer Status tool, see the Novell iPrint Appliance 1.1: Novell 
iPrint Appliance Health Monitor Administration Guide.

8.5 iPrint Printer Import / Migration
The iPrint Printer Import link provides information on how to migrate printers from an existing OES 
iPrint system or iPrint Appliance.

For more information about importing printers, see the Section 5.4.1, “Migrating Printers from an OES 
iPrint System,” on page 50.
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8.6 iPrint Map Creation
You can use the iPrint Map Designer to create a map displaying the location of printers. Users can 
identify and install the printers that are nearest to their location.

 Section 8.6.1, “Setting Up Location-Based Printing,” on page 143

 Section 8.6.2, “Customizing the iPrint HTML Interface,” on page 145

8.6.1 Setting Up Location-Based Printing

When you set up location-based printing, each Print Manager creates an iPrint Printer List that users 
can access at http://server_DNS_or_IP_address/ippdocs/filename.htm. You can make 
installing printers even easier by creating customized Web pages that link the iPrint Printer lists 
together or by using the iPrint Map Designer to create a map showing the location of printers.

 “Creating Location-Based Maps with iPrint Map Designer” on page 143

 “Creating Customized Printer Lists” on page 145

Creating Location-Based Maps with iPrint Map Designer

You can use the iPrint Map Designer tool to quickly create a map showing printer locations. The tool 
lets you import floor plans as background images that can be used to drag and drop printers onto 
actual locations. These maps are then published on a Web server so users can install printers that 
are closest to their location.

The iPrint map pages now display browser-specific user instructions during printer installation. If you 
have upgraded to iPrint Client 6.0.0 for Windows, it is recommended that you recreate your map 
pages.

After the map is created, you must use the iPrint Map Designer to modify or update it. Changes to a 
map file that are made outside of the iPrint Map Designer are not supported. If you need to add links 
to a map, you should create a frameset file and then display the map file in one frame and display 
your links in a different frame.

Prerequisites

 Windows 9x/NT/2000/XP/Vista/7/8/8.1 operating systems

 Microsoft Internet Explorer 5.5 or later

 Novell iPrint Client installed on the workstation 

 “Creating a Map for Printing” on page 143

 “Adding Printers from Different Print Managers” on page 144

 “Copy Maps to iPrint Appliance” on page 145

Creating a Map for Printing

Before creating the map, ensure that you meet the following prerequisites:

 All of your background images (maps) are copied to the following location on the server you use 
for iPrint management:

/var/opt/novell/iprint/htdocs/images/maps
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You can use JPEG, GIF, and BMP images for backgrounds and printer icon images. These files 
are detected by iPrint Map Designer at startup. A default set of printer icons is included.

 All of your custom printer icons are copied to the following location on the server you use for 
iPrint management:

/var/opt/novell/iprint/htdocs/images/printers

1 To start the iPrint Map Designer, go to http://server_address/maptool.htm in Internet Explorer, 
where server_address is the server’s IP address or DNS name of the server where the iPrint 
Manager is running.

2 Select a map from the Background drop-down list.

3 (Optional) Add a printer to the map:

3a From the Printer Icon field, select the type of printer and icon size you want.

Sizes range from 1 to 6, with 1 being the largest. Icons with a C indicate color printers.

3b Click the Printer icon and drag the printer to the desired location on the map.

3c Next to the Printer List field, click the Browse icon and specify the IP address or DNS name 
of the server where the Print Manager is running.

3d From the Printer List, select the Printer Agent you want associated with this printer icon. 

The Printer URL and Mouse Over Text are automatically filled in with the Printer Agent 
information. 

By default, Mouse Over Text displays the Printer Agent’s name. You can override this 
information by specifying the text you want to display when a user moves the mouse over 
the Printer icon.

3e (Optional) In the Printer Caption field, specify the information to display, using Enter to parse 
the information into multiple lines.

3f (Optional) From the menu bar, click Font to change the base font, color, and size for text on 
the map.

4 (Optional) Edit a printer’s information by clicking the desired printer’s icon and then editing the 
printer information fields.

To deselect a Printer icon while you are in the map, click anywhere in the design area.

5 Click Save to save the map in an HTML format. You can upload this HTML file to a Web server 
and use an HTML editor to customize the page.

IMPORTANT: Do not click Refresh or exit Internet Explorer without saving the map.

To retrieve and modify an existing map file, click Open and browse to the directory where the map is 
located.

Adding Printers from Different Print Managers

You can add printers from different Print Managers to the same map. First, add the printers from one 
Print Manager. Then click the Browse icon and select a different manager.

If you need to add or modify printers from a previously used Print Manager, click a Printer icon from 
that manager and the Printer List is populated with printers from that manager.
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Copy Maps to iPrint Appliance

On successful creation of maps, you must copy the maps to the location /var/opt/novell/iprint/
htdocs on the iPrint Appliance. 

Users can access the maps by specifying the URL http://server_DNS_or_IP_address/ippdocs/
filename.htm in their browsers.

Creating Customized Printer Lists

Printer lists let users select printers from categories that are meaningful to them. For example, you 
could create a list of printers by building location, department names, or eDirectory context. iPrint 
generates an iPrint Printer List for each Print Manager. 

To create a custom list, you must use an HTML editor and create links to the different generated lists 
or create a Web page by using the printer’s IPP URL. This URL is displayed when you enable IPP for 
a printer. 

To view a printer’s URL: 

1 In iManager, click iPrint > Manage Printer.

2 Browse to and select the printer you want.

3 Click Client Support > iPrint Support.

The printer’s URL is displayed under Current iPrint URL.

8.6.2 Customizing the iPrint HTML Interface

You can edit any of the HTML files provided in var/opt/novell/iprint/htdocs/examples/
example1/ or you can create your own files to customize iPrint for your environment.

 In the examples directory, Example 1 shows a fully graphical interface for locating and installing 
printers using standard HTML. This type of approach can also be created using the iPrint Map 
Designer.

Use your Web browser to view this example from var/opt/novell/iprint/htdocs/examples/
example1/innerweb.html

 In the examples directory, Example 2 shows a lower-maintenance approach for locating and 
installing printers using standard HTML. 

Use your Web browser to view this example from var/opt/novell/iprint/htdocs/examples/
example2/innerweb.htm

8.7 Ganglia
Ganglia is a scalable, distributed monitoring system that allows you to gather important metric data 
about the performance of your iPrint Appliance. The default metrics that you can monitor are 
processor, disk, load, memory, network, and process.

Ganglia is not enabled by default. To monitor iPrint Appliance using Ganglia, you must enable 
Ganglia Configuration in the Appliance System Configuration page of the iPrint Appliance 
Management Console. For information in how to enable Ganglia Configuration, see Section 7.5, 
“Ganglia Configuration,” on page 86.
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To view Ganglia monitoring of your iPrint Appliance system:

1 On a Web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the Ganglia icon.

An overview of all the nodes in the cluster, including information such as processor utilization, 
memory, load, and so forth is displayed.

3 In the Grid-Node drop-down list, select a node that you want to monitor.

or

Scroll to the bottom of the page and click a node to get server information for your iPrint 
Appliance.

For information about how to configure Ganglia for your environment, including changing from 
multicast mode to unicast mode, see Section 7.5, “Ganglia Configuration,” on page 86.

8.8 What’s Next
iPrint Appliance is now configured for printing through desktop and laptops. You can start printing to 
iPrint printers.
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9 9Installing and Setting Up iPrint on Client 
Workstations

For users to use iPrint, they need to install the Novell iPrint Client software and a printer. When a user 
selects a printer to be installed by iPrint, iPrint checks to see if the Novell iPrint Client software is 
installed and then installs it if necessary. If the iPrint Client software is already installed, the printer 
driver is downloaded and the printer is installed on the user’s workstation.

 Section 9.1, “Installing the iPrint Client,” on page 147

 Section 9.2, “Installing Printers,” on page 156

 Section 9.3, “Updating the iPrint Client,” on page 167

 Section 9.4, “Managing Print Jobs from the Client,” on page 167

 Section 9.5, “Windows Client: Using Additional Features,” on page 168

 Section 9.6, “Using iprntcmd on Linux and Macintosh,” on page 176

 Section 9.7, “Windows Client: Additional Features,” on page 177

 Section 9.8, “Macintosh Client: Additional Features,” on page 181

 Section 9.9, “Uninstalling the Novell iPrint Client,” on page 185

 Section 9.10, “Printing from LPR Print Systems to iPrint,” on page 186

9.1 Installing the iPrint Client
For iPrint to work properly, a workstation must have the iPrint Client installed. You can distribute the 
client to your workstations in a variety of ways, including the iPrint Printer List Web page, distribution 
software such as ZENworks, login scripts, and so on. 

 Section 9.1.1, “Linux: iPrint Client,” on page 147

 Section 9.1.2, “Macintosh: iPrint Client,” on page 151

 Section 9.1.3, “Windows: iPrint Client,” on page 152

The client is located in the /var/opt/novell/iprint/htdocs directory.

9.1.1 Linux: iPrint Client

 “Linux: iPrint Client Requirements” on page 147

 “Linux: Controlling Access to the Workstation Print System” on page 148

 “Linux: Distributing the iPrint Client” on page 149

Linux: iPrint Client Requirements

In order for iPrint to work properly, workstations should have the following:

 SUSE Linux Enterprise Desktop (SLED) 10 SP2 (supports both 32-bit and 64-bit) or SLED10 
SP3 (supports both 32-bit and 64-bit) or SLED 11 (supports both 32-bit and 64-bit).
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IMPORTANT: To install the client, you must have the root password or rights as root.

 A Mozilla-based browser (Firefox 2.x.x, 3.0, 4.0, or 5.0).

NOTE: If the iPrint server is busy when your installed printer attempts to communicate, CUPS 
(Common UNIX Printing System) moves the printer into an error state and holds all print jobs. CUPS 
plays a role similar to a Windows spooler. It is used for administering print services such as  creating 
print queues and monitoring, deleting, and restarting print jobs. To release print jobs, use the printer 
management utility to restart the printer.

Linux: Controlling Access to the Workstation Print System

The Linux iPrint Client is packaged in two different, specialized installations that control access to the 
workstation’s print system. The following table explains the differences between the two clients.

Table 9-1   iPrint Client for Linux RPMs

Using the items in the iPrint Client for Linux RPM list does not allow you to install the iPrint Client, nor 
does it play any role in determining the user’s printing capabilities. These items provide you access to 
the workstation’s print system. 

IMPORTANT: To install the iPrint Client you need root permissions. To upload drivers from the 
system, you need to be defined with lppasswd or know the root password; otherwise, when you 
attempt to add drivers from the system, the driver list is blank. To define a user to be part of 
lppasswd, use the following command:

lppasswd -a linux_user_account -g sys

Client File Name Workstation 
Access

Description

novell-iprint-xclient-sh-
version.i586.rpm

Security high. 
Limited access to 
the print system.

This client requires workstation users 
to be defined with lppasswd to install, 
delete, or administer printers on the 
workstation. When performing one of 
these print operations, the user is 
prompted for a password.

novell-iprint-xclient-sl-
version.i586.rpm

Security low. 
Unlimited access to 
the print system.

This client allows all users of the 
workstation to install, delete, or 
administer printers and print jobs on 
the workstation, including printers and 
print jobs of other users. By default, 
the iPrint Printer List Web page installs 
this RPM.
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Printing to Secure Printers

When you are installing a secure iPrint printer, you might be prompted twice for your username and 
password. First, you are prompted to provide your network credentials to verify that you have access 
to the printer (it would be no use installing a printer that would not allow you to print). The second 
prompt is for CUPS, to ensure you have rights to install printers on the client machine. You need to 
provide the root password or be defined in the CUPS lppasswd.

Printing to secure printers is supported only when you are logged in to the desktop. If for any reason 
the CUPS iPrint back end cannot deliver the job to a secure printer, the job is requeued on the client 
with a hold. You can then see the held job and release it after you log in to the desktop.

NOTE: This client does not support printing from text logins such as SSH, unless the GUI is running 
on the host workstation.

Linux: Distributing the iPrint Client

Use one of the following methods to install the iPrint Client on users’ workstations:

 “Installing the Client from the iPrint Printer List Web Page” on page 149

 “Delivering the Client through Distribution Software” on page 150

Installing the Client from the iPrint Printer List Web Page

You can download and install the iPrint Client from the iPrint Printer List Web page that resides on the 
server where the Print Manager is loaded. By default, the link is set to install the novell-iprint-
xclient-sl-version.i586 rpm  high security client. You can change this by creating a symbolic link 
in /var/opt/novell/iprint/htdocs using the following command:ln -sf client novell-
iprint-xclient.i586.rpm where client is the client filename noted above.

To user your Web browser to install the iPrint client RPM package to your desktop or directory:

http://server_IP_ address_or_dns_name/ipp.

1 Specify the iPrint server URL in your Web browser Address field: 

For example, if the DNS name for printing is printing.my_company.com, you would access iPrint 
from the following URL:

http://printing.my_company.com/ipp

2 Click the printer you want to install.

If the iPrint Client is not yet installed on your workstation, you are prompted to install it.
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NOTE: If you try to add a printer on a Mac client, the printer might get installed even if there are 
no Mac drivers associated with the printer. This is because the Mac client looks for an alternate 
associated Linux driver.

3 When you are prompted, save the iPrint Client RPM to your desktop or home directory.

4 Install the iPrint Client RPM by double-clicking the RPM. If a file association for the RPM does 
not exist, use an RPM-installer program.

5 Exit and restart your Web browser before installing printers.

6 (Conditional) If you are using the KDE desktop and printing to secure printers, log in again as a 
user (not root) to start the iPrint listener, or run the /opt/novell/iprint/bin/iprint-
listener command to manually load the listener:/opt/novell/iprint/bin/iprint-listener

For GNOME users, you must load the iPrint listener manually or configure GNOME to load it. 
See “Additional Configuration for Secure Printers with GNOME” on page 150.

NOTE: Run the iPrint Launcher from the applications menu if you want to install a secure printer 
without logging in again or without rebooting your system. 

If you are using a non-standard installation of a browser, and the plug-in does not appear, use the ln 
-s opt/novell/iprint/plugin/npnipp.so command to create a symbolic link in the browser’s 
plug-in directory. 

Delivering the Client through Distribution Software

You can use client distribution software such as ZENworks to deliver the iPrint Client and printers to 
your client workstations. For more information, see the documentation for your distribution software.

Additional Configuration for Secure Printers with GNOME

Users of the GNOME desktop that are printing to secure printers (printers that require you to 
authenticate) must add iprint-listener to the list of applications launched at login; otherwise, print 
jobs are not submitted to the secure printer. 

NOTE: This does not apply to the KDE Desktop or GNOME running on the Novell Linux Desktop. 
This also does not apply when printing to non-secure printers.

1 On the GNOME desktop, click System > Personal Settings.

2 Under the System section, click Sessions.

3 Click Startup Programs > Add.

4 For the startup command, enter /opt/novell/iprint/bin/iprint-listener.

5 Click OK > Close.

6 Load iprint-listener by either running the command in Step 4 or by logging out and logging 
in again.

The next time you log in, iprint-listener is automatically loaded.

If iprint-listener is not running, jobs submitted to secure iPrint printers are held in the local client 
queue. To release the jobs, start iprint-listener and then resume the job on the printer.
150 Novell iPrint Appliance 1.1 Administration Guide



9.1.2 Macintosh: iPrint Client

 “Macintosh: iPrint Client Requirements” on page 151

 “Macintosh: Distributing the iPrint Client” on page 151

Macintosh: iPrint Client Requirements

For supported browser, see Section C.11.1, “iPrint Client Supported Browsers,” on page 219.

Macintosh: Distributing the iPrint Client

Use one of the following methods to install the iPrint Client on users’ workstations:

 “Installing the iPrint Client from iPrint Printer List Web Page” on page 151

 “Delivering the Client through Distribution Software” on page 152

Installing the iPrint Client from iPrint Printer List Web Page

You can download and install the iPrint Client from the iPrint Printer List Web page that resides on the 
server where the Print Manager is loaded. 

1 Specify the iPrint server URL in your Web browser address field:

http://server_IP_ address_or_dns_name/ipp.

For example, if the DNS name for printing is printing.my_company.com, you would access iPrint 
from the following URL:

http://printing.my_company.com/ipp

The disk image file is downloaded, the install package extracted, and the disk image file is 
moved to the Trash. Then the iPrint Client install is launched.

2 Click the printer you want to install:

2a If the iPrint Client is not yet installed on your workstation, follow the prompts to install the 
client.

Mac OS X Versions Supported iPrint Client Versions for Mac

10.8 or later 6.0 or later

10.7 5.8

10.6 or earlier 5.0.6
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The disk image file is downloaded, the install package extracted, and the disk image file is 
moved to the trash. Then the iPrint Client install is launched.

2b After installing the client, restart your Web browser for the browser to recognize the iPrint 
Client plug-in.

3 After installing the client, restart your Web browser for the browser to recognize the iPrint Client 
plug-in.

PostScript Printer Description (PPD) files that use Foomatic filters should be running the latest 
Foomatic filter script and ESP Ghostscript, which are available from Linux Printing.org (http://
www.linuxprinting.org/macosx/hpijs). 

Delivering the Client through Distribution Software

You can use client distribution software such as ZENworks to deliver the iPrint Client and printers to 
your client workstations. For more information, see the documentation for your distribution software.

9.1.3 Windows: iPrint Client

 “System Requirements” on page 152

 “Windows: Printer Driver Profile Requirements” on page 152

 “Windows: iPrint Client Support Matrix” on page 153

 “Windows: iPrint Client Installation and Uninstallation Files” on page 153

 “Deprecated iPrint Client Files” on page 154

 “iPrint Client Files Location” on page 155

 “Windows: Distributing the iPrint Client” on page 155

System Requirements

 Windows 10 32-bit and 64-bit

 Windows 8.x 32-bit and 64-bit

 Windows 7 32-bit and 64-bit

 Windows Vista 32-bit and 64-bit

 Windows Server 2012 R2

 Windows Server 2008 R2

 Web browser with JavaScript enabled, such as Microsoft Internet Explorer 7 or later.

 Ensure that you apply the following hotfixes from Microsoft if your Vista has not been upgraded 
to SP1 or later: 

 941542 (http://support.microsoft.com/en-us/kb/941542/en-us)

 932206 (http://support.microsoft.com/kb/932206/en-us)

Contact Microsoft Customer Support Services for more information.

Windows: Printer Driver Profile Requirements

 Windows Server 2003 

 Windows Vista (32/64-bit)

 Windows Server 2008 (32/64-bit)
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 Windows 7 (32/64-bit)

 Windows 8.x (32/64-bit)

 Windows 10 (32/64-bit)

Windows: iPrint Client Support Matrix

Table 9-2   Windows iPrint Client Support Matrix

Windows: iPrint Client Installation and Uninstallation Files

The Windows iPrint Client is packaged in several different, specialized installations. Depending on 
your distribution method or need, select the file you want. The following table compares the different 
types of installations.

Client 
Version

Windows 
2000

Windows 
XP (32-bit)/
2003

Windows 
Vista/2008

Windows 7 Windows 8 Windows 
8.1

Windows 10

4.38 or 
later

Yes Yes No No No No No

5.04 No No Yes No No No No

5.12 No Yes Yes No No No No

5.20 No Yes Yes Yes No No No

5.30 No Yes Yes Yes No No No

5.40 No Yes Yes Yes No No No

5.52 No Yes Yes Yes No No No

5.60 No Yes Yes Yes No No No

5.64 No Yes Yes Yes No No No

5.74 No Yes Yes Yes No No No

5.78 No Yes Yes Yes No No No

5.82 No Yes Yes Yes No No No

5.86 No Yes Yes Yes Yes No No

5.90 No Yes Yes Yes Yes No No

5.92 No Yes Yes Yes Yes No No

5.94 No Yes Yes Yes Yes Yes No

5.96 No Yes Yes Yes Yes Yes No

5.98 No Yes Yes Yes Yes Yes No

5.99 No Yes Yes Yes Yes Yes No

6.0.0 No No Yes Yes Yes Yes No

6.1.0 No No Yes Yes Yes Yes No

6.2.0 No No Yes Yes Yes Yes Yes
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Table 9-3   iPrint Clients for Windows

Table 9-4   setupipp Options

Windows 95/98 users must restart their workstations after the iPrint Client is installed. NT/2000/XP 
users do not need to restart, unless they are using iPrint utilities to capture LPT ports.

Deprecated iPrint Client Files

Starting from iPrint Client 6.0.0 for Windows, the following iPrint Client files have been deprecated:

iPrint Client Filename Description

nipp.exe Installs the iPrint Client and displays dialog boxes and progress windows 
that require user intervention.

This is the default installation program.

nipp.zip A WinZip version of the client that can be used with distribution software 
programs. After the file is unzipped, run setupipp.exe. For a list of the 
command line parameters that you can use with setupipp.exe, enter 
setupipp.exe /h at a command prompt. For more information on 
setupipp options, refer to the Table 9-4 on page 154.

nipp-s.exe Installs the iPrint Client. A screen displays the progress of the 
installation, but requires no user intervention.

NOTE: Because Windows 95/98 users must reboot their workstations 
after the client is installed, you should use nipp-sr.exe unless you are 
using a software distribution package that reboots the workstation.

nipp-su.exe Uninstalls the iPrint Client. A screen displays the progress of the 
uninstall, but requires no user intervention.

Options Description

/S Silently installs or uninstalls the client.

/R Restarts the workstation when the installor uninstall is completed.

/U Uninstalls the client from your workstation.

/? Displays the help.

/L Installs in an LDAP-compliant environment (only unique 
usernames).
154 Novell iPrint Appliance 1.1 Administration Guide



Table 9-5   Deprecated iPrint Client Files for Windows

NOTE: Even though these files are deprecated from iPrint Client 6.0.0 for Windows and later, you can 
perform all the functionalities associated with them using the iPrint Client File nipp.zip.

iPrint Client Files Location

Starting with iPrint Client 6.0.0 for Windows, C:\Program Files\Novell\iPrint is the default 
location where the iPrint Client files are installed.

Third-party applications that require leveraging iPrint binaries can use the following registry key to get 
the install location:

Registry Key: HKEY_LOCAL_MACHINE\SOFTWARE\Novell-iPrint\ [szInstallDir]

Windows: Distributing the iPrint Client

Use one of the following methods to install the iPrint Client on users’ workstations:

 “Installing the Client from the iPrint Printer List Web Page” on page 155

 “Delivering the Client through Distribution Software” on page 156

NOTE: Windows 9x users must restart their workstations after the iPrint Client is installed. Windows 
NT/2000/XP users do not need to restart, unless they are using iPrint utilities to capture LPT ports.

Installing the Client from the iPrint Printer List Web Page

You can download and install the iPrint Client from the iPrint Printer List Web page on the server 
where the Print Manager is loaded. 

1 To reach the iPrint Printer List Web page, enter the following URL in your Web browser address 
field: http://server_IP_ address_or_dns_name/ipp.

iPrint Client Filename Description

nipp-sr.exe Installs the iPrint Client and reboots the workstation. A screen 
displays the progress of the installation, but no user intervention 
required.

nipp-u.exe Uninstalls the iPrint Client. The user confirms the uninstallation, then 
a screen displays the progress of the uninstallation.

nipp-sl.exe Provides a ready-to-use executable package with the /L and /S 
setup options loaded automatically.
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For example, if the DNS name for printing is printing.my_company.com, you would access iPrint 
from the following URL:

http://printing.my_company.com/ipp

2 Click the printer you want to install.

If the iPrint Client is not yet installed on your workstation, you are prompted to install it.

3 When you are prompted, save the iPrint Client RPM to your desktop or home directory.

4 Install the iPrint Client RPM by double-clicking the RPM.

Delivering the Client through Distribution Software

You can use client distribution software such as ZENworks to deliver the iPrint Client and printers to 
your client workstations. For more information, see the documentation for your distribution software.

For example, when using Novell ZENworks, you can use any of the iPrint Clients described in 
“Windows: iPrint Client Installation and Uninstallation Files” on page 153 to deliver the Windows iPrint 
Client. You need to use the nipp.zip file to deliver the client to the desktop and execute 
setupipp.exe with one of the command line parameters.

9.2 Installing Printers
You can install and distribute iPrint printers in the following ways:

 Section 9.2.1, “Using the iPrint Printer List Web Page on Windows,” on page 156

 Section 9.2.2, “Using the iPrint Printer List Web Page on Macintosh,” on page 160

 Section 9.2.3, “Creating Location-Based Printing Web Pages,” on page 166

 Section 9.2.4, “Uninstalling iPrint Printers,” on page 167

NOTE: To manage iPrint in iManager and to install printers with iPrint Clients, turn off pop-up blocking 
or allow the URL.

9.2.1 Using the iPrint Printer List Web Page on Windows

You can install the iPrint printers using the following browsers:

 “On Microsoft Internet Explorer” on page 157

 “On Mozilla Firefox” on page 158

 “On Google Chrome” on page 159
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On Microsoft Internet Explorer

1 Launch the browser, and use either the DNS name or the IP address to access the iPrint Printer 
List web page.

For example, http://server_IP_ address_or_dns_name/ipp.

All the available printers are listed on the iPrint Printer List web page.

2 Click on the printer that you want to install.

(Optional) Depending on the version of the Internet Explorer you are using, you may be 
prompted with a security warning message, click Allow.

The Internet Explorer Security warning message dialog box is displayed.
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3 Click Allow to proceed with the installation of the printer. 

4 (Optional) To avoid future prompts to launch the iPrint applications, select the Do not show me 
the warning for this program again check box.

On Mozilla Firefox

1 Launch the browser, and use either the DNS name or the IP address to access the iPrint Printer 
List page.

For example, http://server_IP_ address_or_dns_name/ipp.

All the available printers are listed on the iPrint Printer List web page.

2 Click on the printer that you want to install.

The Launch Application dialog box is displayed.
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3 Select Novell iPrint Printer Installation Utility in the Launch Application dialog box, then click OK 
to proceed with the installation of the printer.

4 (Optional) To avoid future prompts to launch the iPrint applications, select Remember my choice 
for iPrint links check box.

On Google Chrome

1 Launch the browser, and use either the DNS name or the IP address to access the iPrint Printer 
List page.

For example, http://server_IP_ address_or_dns_name/ipp.

All the available printers are listed on the iPrint Printer List web page.

2 Click on the printer that you want to install.

The External Protocol Request dialog box is displayed.
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3 Click Launch Application on the External Protocol Request dialog box to proceed with the 
installation of the printer.

4 (Optional) To avoid future prompts to launch external protocol links, select the Remember my 
choice for all links of this type check box.

If the iPrint Client is not installed, install it when you are prompted.

During the printer installation, iPrint downloads and installs the printer driver, if one is associated with 
the printer, and installs the printer on the user’s workstation. The first time a printer is installed, printer 
drivers are forced to the workstation, even if the workstation contains a newer driver. Print Managers 
refresh their saved copies of printer drivers for the printers they are hosting with updated printer 
drivers from the associated Driver Store.

9.2.2 Using the iPrint Printer List Web Page on Macintosh

You can install the iPrint printers using the following browsers:

 “On Safari” on page 160

 “On Mozilla Firefox” on page 162

 “On Google Chrome” on page 164

On Safari

1 Launch the browser, and use either the DNS name or the IP address to access the iPrint Printer 
List page.

For example, http://server_IP_ address_or_dns_name/ipp.

All the available printers are listed on the iPrint Printer List web page.
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2 Click on the printer that you want to install.

The iPrint Printer Installation dialog box is displayed.

3 Click Install to proceed with the installation of the printer.

3a If you are installing a secure printer, the iPrint Printer Installation dialog box prompts for user 
credentials.
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3b Specify user credentials.

3c (Optional) To avoid future prompts, select Save Password check box.

3d Click OK after you have specified your credentials.

4 Click OK when the printer installation is complete.

On Mozilla Firefox

1 Launch the browser, and use either the DNS name or the IP address to access the iPrint Printer 
List page.

For example, http://server_IP_ address_or_dns_name/ipp.

All the available printers are listed on the iPrint Printer List web page.

2 Click on the printer that you want to install.

The Launch Application dialog box is displayed.
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3 Select Novell iPrint Printer Installation Utility in the Launch Application dialog box, then click OK 
to proceed with the installation of the printer.

4 (Optional) To avoid future prompts to launch the iPrint applications, select Remember my choice 
for iPrint links check box.

The iPrint Printer Installation dialog box is displayed.

5 Click Install to proceed with the installation of the printer.

5a If you are installing a secure printer, the iPrint Printer Installation dialog box prompts for user 
credentials.
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5b Specify user credentials.

5c (Optional) To avoid future prompts, select Save Password check box.

5d Click OK after you have specified your user credentials, then click OK to proceed with the 
installation of the printer.

6 Click OK when the printer installation is complete.

On Google Chrome

1 Launch the browser, and use either the DNS name or the IP address to access the iPrint Printer 
List page.

For example, http://server_IP_ address_or_dns_name/ipp.

All the available printers are listed on the iPrint Printer List web page.

2 Click on the printer that you want to install.

The External Protocol Request dialog box is displayed.
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3 Click Launch Application on the External Protocol Request dialog box to proceed with the 
installation of the printer.

4 (Optional) To avoid future prompts to launch external protocol links, select the Remember my 
choice for all links of this type check box.

The iPrint Printer Installation dialog box is displayed.

5 Click Install to proceed with the installation of the printer.

5a If you are installing a secure printer, the iPrint Printer Installation dialog box prompts for user 
credentials.
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5b Specify user credentials.

5c (Optional) To avoid future prompts, select Save Password check box.

5d Click OK after you have specified your user credentials, then click OK to proceed with the 
installation of the printer.

During the printer installation, iPrint downloads and installs the printer driver, if one is associated with 
the printer, and installs the printer on the user’s workstation. The first time a printer is installed, printer 
drivers are forced to the workstation, even if the workstation contains a newer driver. Print Managers 
refresh their saved copies of printer drivers for the printers they are hosting with updated printer 
drivers from the associated Driver Store.

9.2.3 Creating Location-Based Printing Web Pages

Location-based printing lets users select printers based on locations by using a list view or a map. 
Using a list view, printer locations can be displayed on HTML pages organized by building, office 
location, eDirectory context, and so forth. You configure the lists in a way that best suits the users’ 
needs. For an example of using a list view, see /var/opt/novell/iprint/htdocs/examples/
example1/innerweb.html.

For more information, see “Creating Customized Printer Lists” on page 145.

You use the iPrint Map Designer to create maps of printer location through drag-and-drop feature. 
After the maps are created, they can be posted on a Web server for users to access. When users 
view the maps, they can find a printer close to their location and then click its icon. If they are not yet 
installed, the client software and the printer are installed on the user’s workstation. For an example of 
using a list view, see /var/opt/novell/iprint/htdocs/examples/example1/innerweb.html.

For more information on using the iPrint Map Designer, see “Creating Location-Based Maps with 
iPrint Map Designer” on page 143.

NOTE: The iPrint map pages now display browser-specific user instructions during printer 
installation. If you have upgraded to iPrint Client 6.0.0 for Windows, it is recommended that you 
recreate your map pages.
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9.2.4 Uninstalling iPrint Printers

Use any of the following methods to uninstall iPrint printers based on your operating system:

Linux

 Use the CUPS management utility included with your Linux distribution

 Use the iPrint icon.

1. Right-click the iPrint icon, then click Printers. 

2. Select the printer that you want to uninstall.

3. Click Uninstall to uninstall the printer.

Hold down the Shift key to select more than one printer, or click Uninstall All to uninstall all 
the printers.

Macintosh

 Use the print list management utility included with the operating system.

 Use the iPrint icon.

1. Right-click or Control-click the iPrint icon, then click Printers.

2. Select the printer that you want to uninstall.

3. Click Uninstall to uninstall the printer.

Hold down the Shift key to select more than one printer, or click Uninstall All to uninstall all 
the printers.

Windows

Use the printer folder to delete printers installed on your system.

For more information on uninstalling the Novell iPrint Client, see Section 9.9, “Uninstalling the Novell 
iPrint Client,” on page 185.

9.3 Updating the iPrint Client
Periodically, users need updates to the Novell iPrint Client. You need to decide how to manage this. If 
you want iPrint to automatically update the clients, see “Automatically Updating the iPrint Client” on 
page 173, or you can choose to distribute a newer client through a software distribution package that 
uses and application such as Novell ZENworks.

You are allowed five times to reject the iPrint Client update. After that the iPrint Client is forcefully 
updated on your workstation. 

9.4 Managing Print Jobs from the Client
Users can monitor and manage their own print jobs from their workstations.

Linux: To manage print jobs or delete printers, use the CUPS management utility included with your 
Linux distribution. To monitor the status of the last 10 print jobs, right-click the iPrint icon in the 
notification area and select Job Status.
Installing and Setting Up iPrint on Client Workstations 167



Macintosh: To manage print jobs or delete printers, use the print list management utility included with 
the operating system. To monitor the status of the last 10 print jobs, right-click or control-click the 
iPrint icon in the notification area, and select Job Status.

Windows: To manage print jobs or delete printers, use the Windows printers folder on the Start menu 
or in the Control Panel. To monitor the status of the last 10 print jobs, right-click the iPrint icon in the 
notification area and select Document Status.

9.5 Windows Client: Using Additional Features
 Section 9.5.1, “Updating the iPrint Client,” on page 168

 Section 9.5.2, “Using the iPrint Client Icon,” on page 168

 Section 9.5.3, “Configuring the iPrint Client Settings,” on page 168

 Section 9.5.4, “Implementing iPrint by Using the Command Line,” on page 171

 Section 9.5.5, “Managing Global Actions through Iprint.ini,” on page 173

9.5.1 Updating the iPrint Client

Periodically, users need updates to the Novell iPrint Client. You need to decide how to manage this. 
You can allow iPrint to automatically update the clients or you can choose to distribute a newer client 
through a software distribution package that uses and application like Novell’s ZENworks.

See “Automatically Updating the iPrint Client” on page 173 for more information.

9.5.2 Using the iPrint Client Icon

On Windows workstations, the iPrint Client adds an icon to the notification area. The iPrint icon lets 
you receive notification when a job has printed and letes you quickly access iPrint Client settings. 
Right-clicking the icon displays the following menu options:

iPrint Settings: Opens the iPrint Client Settings page.

Document Status: Lets you check the status and other information for the last 10 documents printed.

Launch Printer Folder: Opens the Windows printer folder.

Find/Install Printers: (Optional) Opens a browser window to the Menu Link URL specified on the 
Tray Icon tab.

Close: Removes the iPrint icon from the notification area until the next reboot. To make the icon 
reappear in your notification area, click Start > Programs > Novell iPrint > iPrint Client Settings > Tray 
Icon and deselect the Enable the iPrint icon in the system tray. Click OK. Then repeat the process to 
enable the icon. 

To permanently remove the icon, see “Managing iPrint’s Notification Area Icon” on page 169.

9.5.3 Configuring the iPrint Client Settings

 “Using a Proxy Server” on page 169

 “Managing Passwords for Remote iPrint Servers” on page 169

 “Managing iPrint’s Notification Area Icon” on page 169

 “Managing Print Job Notifications” on page 170
168 Novell iPrint Appliance 1.1 Administration Guide



 “Setting Up iPrint on Terminal Servers” on page 170

 “Configuring the iPrint Client to work in a Windows / Active Directory Environments without the 
Novell Client” on page 171

Using a Proxy Server

A proxy server is located between a client and another server that the client is trying to communicate 
with. Often proxy servers are used in conjunction with a firewall to keep internal addresses private 
while exposing only the proxy server’s address to external users. If you have users that need to 
submit print jobs through a proxy server, you can use the iPrint Clients Proxy setting. The Client 
sends all print-related requests, such as a print job, to the proxy server. The proxy server then 
redirects the print job to the correct iPrint server.

For example, Juan is a laptop user who has installed and printed to a variety of iPrint printers at the 
company’s headquarters. While on the road, Juan wants to submit a report to his manager. Rather 
than sending the report by e-mail or fax, Juan decides to send it to the printer near his manager’s 
office. When Juan tries to send the report to the printer, he receives an error that the printer cannot be 
found. He knows that the company uses a firewall and a proxy server. He types the proxy server 
address in the iPrint Proxy settings, then tries to print the report again. This time the print job is 
accepted. The print job travels from his laptop to the proxy server. The proxy server redirects the print 
job to the printer’s Print Manager, where the print job is spooled and forwarded to the printer.

To set the proxy server address for iPrint in iManager:

1 Click Start > Programs > Novell iPrint > iPrint Settings > Proxy.

2 To use a proxy server, select the check box, then specify the URL for the proxy server.

To disable using a proxy server, deselect the check box.

3 Click OK.

Managing Passwords for Remote iPrint Servers

You can manage passwords for print services that you indicated should be remembered by your 
workstation. The ability to delete passwords is useful if you are connected to a print service that you 
no longer use.

To manage passwords for print services in iManager:

1 Click Start > Programs > Novell iPrint > iPrint Settings > Passwords.

2 Select the password you want to remove, then click Clear Password.

Managing iPrint’s Notification Area Icon

The iPrint icon in the notification area lets you receive notification when a job has printed,  and lets 
you view a list of print jobs that you have submitted.

1 Click Start > Programs > Novell iPrint > iPrint Settings > Tray Icon.

2 Modify the settings.

For more information about the settings, see Section 9.5.2, “Using the iPrint Client Icon,” on 
page 168.
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Managing Print Job Notifications

iPrint can notify you through a pop-up message in the notification area when your document has 
printed or needs attention. 

To turn iPrint notification on or off:

1 Click Start > Programs > Novell iPrint > iPrint Settings > Notifications.

2 Select or deselect the check box as necessary.

NOTE: If you close the iPrint applet running in the notification area, you do not receive notifications. 
To restart the applet, see Using the iPrint Client Tray Icon.

Setting Up iPrint on Terminal Servers

You can set up iPrint on a terminal server to allow terminal server clients to install the iPrint Client and 
print to iPrint printers.

 “Installing the iPrint Client on a Terminal Server” on page 170

 “Configuring iPrint for Terminal Server Clients” on page 170

Installing the iPrint Client on a Terminal Server

1 Log in to the terminal server with Administrator or equivalent rights.

2 Install the iPrint Client.

You can download the iPrint Client from the iPrint Printer List or you can copy and execute 
nipp.exe from the iPrint server in sys:\apache2\htdocs\ippdocs.

NOTE: On terminal servers, the client auto-update does not work. To update the client with a newer 
release, you must install it manually. 

Configuring iPrint for Terminal Server Clients

You can configure iPrint to work in any of the following ways, depending on the rights the terminal 
server client has.

 Install user printers only: User printers can only be installed and deleted by the user who 
installed the printer. User printers are not available to other users on the workstation.

 Install workstation printers only: Workstation printers can be installed and deleted only by 
users with sufficient rights. After a workstation printer is installed, all users using the workstation 
can print to it.

 Try to install workstation printer first: If the user has insufficient rights to install the printer, the 
printer is installed as a user printer.

To configure iPrint for terminal server clients:

1 Log in to the terminal server with Administrator or equivalent rights.

2 Click Start > Programs > Novell iPrint > iPrint Settings.

3 Click Terminal Server, then select the configuration option you want.

4 Click OK.
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Configuring the iPrint Client to work in a Windows / Active Directory 
Environments without the Novell Client

This functionality has been added to help you use iPrint on Windows platforms even if you do not 
have the Novell Client installed. You use the iPrint Client Management utility to work without the 
Novell Client and to share your Windows/AD login credentials with the iPrint Client. You can configure 
the iPrint Client Management (iCM) PSM address by using the iPrint Client tray icon. To view the 
iPrint Client tray icon’s iCM tab, enter iprntcfg icm at the command line. Then, enter the PSM 
address (IP/DNS) in the iPrint Client tray icon’s iCM tab and the system will use the DSServer 
(Directory Service Server) configuration of the PSM server to obtain the details of your iCM  profile. If 
the PSMServer is not set, you can still specify the DSServer by populating the registry entry directly. 

You can also set the address of the PSM server by using the iprntcmd -S <IP/DNS> command, in  
combination with a remote-policy pushing engine like ZENworks.

9.5.4 Implementing iPrint by Using the Command Line

Iprntcmd.exe is a DOS command line utility that lets you install iPrint printers without a web browser 
and capture LPT ports to iPrint printers. This command is useful when you have legacy applications 
that require output to an LPT port or when you want to add printers through a login script. 

Using iprntcmd.exe to Install iPrint Printers

If you need to install an iPrint printer but cannot use a Web browser, you can use the iprntcmd.exe 
command at a DOS prompt. The iprntcmd.exe command can install, remove, or set a printer as the 
default printer. 

Use the following parameters when executing the iprntcmd command.

Table 9-6   Parameters Used with iprntcmd

Parameters Description

-a | --addprinter options printer_uri Installs the specified printer. You can replace 
options with any or all of the following:

 no-gui: Does not display the printer 
installation dialog box when installing a 
printer.

 default: Installs the specified printer as the 
default printer.

 temp: The installed printer is removed when 
the workstation is rebooted.

NOTE: These options are available only in the 
Windows Client.

-d | --delprinter printer_uri Removes the specified printer.

-f | --fetchdriverlocal printer_uri Pulls drivers from the server and stores them in 
the local cache directory, such as the  
c:\ndsp\drvr_cache directory.

-g | --getdefault Displays the default printer installed on the 
workstation.
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Use quotes around printer-uri if it contains spaces.

Syntax

iprntcmd parameters

-h | --help Displays help for the command.

-j | --listjobs printer_uri Lists the print jobs for the specified printer that 
are on the server in a pending or printing state.

-l | --listlocalprinters Lists printers installed on the workstation.

-L | --listprintersonserver psm-hostname or psm-
address

Lists iPrint printers on the specified Print 
Manager where psm-hostname or psm-address 
can be a DNS name or IP address.

-p | --printfile printer-uri file path Sends a printer-ready file to the specified iPrint 
printer.

This option is used to test the print path (job flow) 
from the client workstation to the server and 
subsequently to the printer. This requires a print-
ready file as an input. The printer or the driver 
does not need to be installed on the client 
workstation.

-P | --ppdlist Lists the PPDs installed on this workstation.

-s | --setdefault printer_uri Sets the specified printer as the default.

-t | --testpage printer_uri Prints a test page to the specified printer.

-v | --version server_uri server_user Displays the server platform and version 
information, where server_uri is the URI for the 
server and server_user is a valid user for the 
server.

-U | --uploaddriver <ids-address> or <ids-hostname> 
<username> <password> [INF-Filepath <model-
name>]

Uploads printer drivers.

IMPORTANT: INF-Filepath and model-name are 
mandatory only for Windows XP platforms.

-w | --trustedwebsiteforInternetExplorer  
printer_installation_page_uri

Adds the specified URI of the printer installation 
page to the trusted site list for Internet Explorer.

The trusted site list allows users to view and add 
the printers directly from the printer IPP site or 
printer map page, without running the Internet 
Explorer browser with administrator privileges on 
Windows Vista. 

For example, http://printing.my_company.com/
ipp.

-c Clears the password from the cache.

Parameters Description
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Example

To install a printer named ColorPrinter1 and set it as the default printer, you would enter the following 
command:

iprntcmd -a -s ipp://printing.my_company.com/ipp/ColorPrinter1

9.5.5 Managing Global Actions through Iprint.ini

A configuration file named iprint.ini is located on each server where a Print Manager is running. 
The iprint.ini file should be synchronized across all servers where iPrint and a Print Manager are 
running. The iprint.ini file is located in /var/opt/novell/iprint/htdocs/.

The file controls the following tasks:

 “Automatically Updating the iPrint Client” on page 173

 “Creating a Short Printer Name Profile” on page 174

 “Installing User Printers” on page 174

IMPORTANT: When you apply a support pack, the existing iprint.ini file is saved as iprint.bak 
and a new iprint.ini is added. If you made changes to the iprint.ini file, you must delete the 
new iprint.ini file from the support pack and rename iprint.bak to iprint.ini. If you want the 
new functionality that is included with the latest iprint.ini, you should re-create the settings in 
iprint.bak in the new iprint.ini.

Automatically Updating the iPrint Client

When a workstation boots up, iPrint checks the default printer to ensure that the workstation is using 
the latest Novell iPrint Client. If necessary, a newer client is installed. You can use a configuration file 
to control how this update takes place.

An iprint.ini configuration file is located on each server where iPrint is installed. This file controls 
whether the user is prompted before the updated client is installed or the updated client is installed 
without user intervention. When the client is installed without user intervention, the user still sees the 
installation program.

1 Using a text editor, edit the iprint.ini configuration file. 

The  iprint.ini file is located in var/opt/novell/iprint/htdocs/

2 Change the AllowAutoUpdate setting for the desired behavior.

3 Save the file.

IMPORTANT: The iprint.ini file should be synchronized across all servers where iPrint and an 
Print Manager are running.

After the iPrint Client is updated, Windows 9x users must restart their machines. Windows NT/2000/
XP users do not need to reboot immediately, unless they are using iPrint utilities to capture LPT ports.
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Creating a Short Printer Name Profile

By default, the installed printer name on the client follows the full UNC/URL format: \\ipp://
dns_name\printer_name. For example,  \\ipp://Printing.My_Company.Com\ColorPrinter. These printer 
names are often too long to fit in an application’s display field for the printer name. You can use a 
Short Printer Name Profile to replace the UNC server name (or dns_name) for all printers on a Print 
Manager with any name you want to display. For example, if you want to display just the company 
name, you could use \\My_Company\ColorPrinter. 

NOTE: You should keep the UNC path and printer name to fewer than 32 characters.

The Short Printer Name Profile is available only on Windows NT, XP, 2000, 2003 and later 
workstations. When you implement a Short Printer Name Profile, printers that are already installed 
are not affected. Only newly installed printers after the change use the shortened name. For printers 
already installed, you must delete and reinstall the printers to implement any changes to their names. 

1 Edit iprint.ini in a text editor. 

The  iprint.ini file is located in var/opt/novell/iprint/htdocs/

2 Change the value of the ShortInstallName parameter to the value you want displayed.

ShortInstallName=your_name

Replace your_name with the value you want displayed. To reset the parameter to its default 
setting, use default as the value.

Use only lower ASCII characters and do not use a slash, quote, space, or comma.

3 Save the file.

IMPORTANT: The iprint.ini file should be synchronized across all servers where iPrint and a 
Print Manager are running. The Installed Printer Name Profile affects all printers on a Print Manager.

Installing User Printers

To install an iPrint printer and the associated printer driver users, you must have Administrator or 
equivalent permissions on Windows NT/2000/XP or Power User permissions on Windows NT/2000. 
User printers let you control what permissions are required to install a printer. To implement user 
printers, edit the iprint.ini file and change the value for AllowUserPrinters = entry to one of the 
following:
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Table 9-7   User Printer Settings

For example, three workers—Albert, Juan, and Carla—share the same computer during the day. 
Albert prints to an accounting printer, Juan prints to a plotter, and Carla prints to a printer in the CEO’s 
office. The administrator set AllowUserPrinters = 2. Each worker can install the printer he or she 
needs but cannot see printers installed by the other users.

NOTE: The user printer feature is supported only on Windows NT/2000/XP/Vista/7/Server 2003 and 
2008. This feature is not supported on Windows 8, Windows Server 2012 and higher versions.

Enabling and Disabling iPrint Client Management

You can use the iprint.ini file to enable and disable iPrint Client Management (iCM). Use the 
iCMEnabled value in the following ways:

 iCMEnabled = 1    

iCM is fully enabled. iCM attributes are identified from the full tree hieararchy.

 iCMEnabled = 0

iCM is disabled. 

IMPORTANT: Using this command disables all iCM  configurations created in the Novell Client.

Setting the Default Attributes Container for iPrint Client Management 

You can use the iprint.ini file to set the default container that iCM  should read values from. To 
configure this scope, use the following command:

 iCMScope = DEFAULT 

Using this command stops the system from reading iCM attributes beyond the container you 
specify. The iCM attributes are read on the full tree hierarchy. The iCM attributes are considered 
within the specified tree hierarchy.  

Value Description

0 Follow Windows standards and only let users with sufficient permissions to install 
the printer to the desktop. This allows all users to see and use this printer. This is 
considered a global or workstation printer.

1 If the current user does not have permissions to add a workstation printer (option 
0), automatically add the printer so that only the current user can install, view, 
modify, or delete this printer. This is considered a private or user printer.

2 Only add user printers. All users (including Administrators or Power Users) that 
add a printer can install, view, modify, or delete the printer they installed. All 
printers are private or user printers.

3 Only add workstation printers. No permissions are required. All users have rights 
to install, view, modify, or delete iPrint printers even if the Windows workstation 
has been locked down. Non-iPrint printers are not affected.
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For example, you can use the OU=UNIT,O=COMPANY command to set the iCMScope to the 
Organizational Unit in the OU from the base of the tree. The user should be present within the 
specified container for iCM function to work. 

NOTE: Setting the attribute in this way does not work above the specified container.

9.6 Using iprntcmd on Linux and Macintosh
The Linux and Macintosh iPrint Clients include the iprntcmd utility that performs the same functions 
as iprntcmd in the Windows iPrint Client. In addition, you can use iprntcmd to upload PPD drivers to a 
Driver Store from the Linux iPrint Client. iprntcmd is located in /opt/novell/iprint/bin/iprntcmd 
on Linux and in /usr/bin on Macintosh.

Use the following parameters when executing the iprntcmd command:

Table 9-8   Parameters Used with iprntcmd

Parameters Description

-T | --tray-icon Displays an iPrint icon to the notification area and 
starts the iprint-listener-gui process, if it is 
not running. 

-r | --run-listener Launches the iprint-listener process if it is 
not already running.

-a or --addprinter printer_uri Installs the specified printer.

-d or --delprinter printer_uri Removes the specified printer.

-d or --delprinter  all Removes all printers. This option requires your 
confirmation before removing all the printers.

-d or --delprinter  all --force Remove all the printers. This option removes all the 
printers forcibly without any user intervention.

-g or --getdefault Displays the default printer installed on the 
workstation.

-h or --help Displays help for the command.

-j or --listjobs printer_uri Lists the print jobs for the specified printer that are 
on the server in a pending or printing state.

-l or --listprinters Lists printers installed on the workstation.

-L or --listprintersonserver psm-hostname or psm-
address

Lists iPrint printers on the specified Print Manager 
where psm-hostname or psm-address can be a 
DNS name or IP address.

-p or --printfile printer-uri filepath Sends a printer-ready file to the specified iPrint 
printer.

-P or --ppdlist Lists the PPDs installed on this workstation.

-s or --setdefault printer_uri Sets the specified printer as the default.

-t or --testpage printer_uri Prints a test page to the specified printer.
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Syntax

iprntcmd options parameters

You must use quotes around parameter information that contains a space, such as printer names and 
printer drivers.

Example

To install a printer named Color Printer 1 and set it as the default printer, enter the following:

iprntcmd -a "ipp://printing.my_company.com/ipp/Color Printer 1"

iprntcmd --setdefault "ipp://printing.my_Company.com/ipp/Color Printer 1"

For uploading PPD files from Mac and Linux clients, enter the following:

iprntcmd -u <ids-hostname or ids-address> <ppd path with/without wild cards>

When prompted for a username, examples of two acceptable formats are:

admin   or cn=admin,o=OrgName

For more examples, use the man iprntcmd command on your server console.

9.7 Windows Client: Additional Features
 Section 9.7.1, “Automatically Removing a Printer from the Client Workstation,” on page 178

 Section 9.7.2, “Auto Redirection of Printer,” on page 178

 Section 9.7.3, “Auto Driver/Profile Update,” on page 178

 Section 9.7.4, “Using the iPrint Client Icon,” on page 178

-u or --uploadids ids_uri ppd with/without a wildcard Uploads the specified PPD files to the indicated 
Driver Store where ids_uri is the IP address or DNS 
name for the Driver Store, and ppd is the directory 
path and filename to the PPD files. You can use a 
wildcard in the PPD filename. 

-U or --uploadbroker rms_uri rms_name ppd with/
without a wildcard

Uploads the specified PPD files to the indicated 
Broker where rms_uri is the IP address or DNS 
name for the Broker’s associated Print Manager, 
rms_name is the username with rights to add 
drivers to the broker, and ppd is the directory path 
and filename to the PPD files. You can use a 
wildcard in the PPD filename. 

-v or --version psm-hostname or psm-address Displays the server platform and version 
information where server_uri is the URI for the 
server.

-i or --info printer-uri Displays the printer information.

Parameters Description
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9.7.1 Automatically Removing a Printer from the Client 
Workstation

You can automatically remove the printer from the client workstation if the printer is removed from the 
server. The client displays a pop-up when the printer is removed from the client. 

9.7.2 Auto Redirection of Printer

You can automatically redirect the printer from the client if the printer redirection is set up in the 
server. The older printer is removed and the new printer is installed on the client.

The client displays a pop-up informing you that your currently installed printer will be  automatically 
uninstalled and a new printer will be installed in its place.

9.7.3 Auto Driver/Profile Update

You can automatically update the client with the latest drivers available on the server, so users do not 
need to manually update. If you make any changes to the driver in the driver store, the client displays  
a pop-up describing the changes and the printer is updated with the new driver. 

You can enable this option using iManager. For more information on, see “Auto Driver/Profile Update” 
on page 116.

9.7.4 Using the iPrint Client Icon

On Linux workstations, the iPrint Client adds an icon to the notification area. The iPrint icon lets you 
receive notification when a job has printed and allows you to access iPrint client settings quickly. If the 
iPrint icon does not appear in your notification area, run the iprntcmd -T command from your 
terminal. 

Right-clicking the iPrint icon displays the following menu options:

 “Printers” on page 178

 “Job Status” on page 179

 “Message Board” on page 179

 “Configuration” on page 179

 “About” on page 181

 “Find/Install Printers” on page 181

 “Hide Tray Icon” on page 181

Printers

Displays the iPrint printer list, printer status, location of the printer, and the driver associated with the 
printer. You can also uninstall your printers from here.

To uninstall a printer:

1. Right-click the iPrint icon, then click  Printers. 

2. Select the printer that you want to uninstall.

Press Shift to select more than one printer. 
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3. Click Uninstall to uninstall the printer.

or

Click Uninstall All to uninstall all the printers.

Job Status

Displays the name of the job, the status of the job, the size of the job, and the name and locationof 
the printer for the job. This option also allows you to clear the job information from the job status tab.

To clear job information:

1. Right-click the  iPrint icon, then click  Job Status.

2. Select the job that  you want to clear.

Press Shift to select more than one job.

3. Click Clear to remove the job information. 

or

Click Clear All to remove all the jobs information. 

Message Board

The message board stores all the information related to the status of the printers, the jobs issued, 
automatic removal of printer from the client, automatic  redirection of printer, and automatic  driver 
updates. 

To remove the data from the message board:

1. Right-click the iPrint icon, then click Message Board.

2. Click Clear to remove the data from the message board.

Configuration

You can configure the following iPrint settings:

 “Managing Notifications” on page 179

 “Using a Menu Link URL” on page 180

 “Using a Proxy Server” on page 180

 “Uninstalling an iPrint Printer When You Uninstall the iPrint Client” on page 180

 “Setting theTrace Level” on page 180

 “Keeping Driver Files on Upload or Download” on page 181

Managing Notifications

iPrint notifies when your document has printed or your iPrint client needs attention. 

To turn the iPrint notification on:

1. Right-click the  iPrint icon, then click Configuration. 

2. Select Notify when jobs get printed or need attention.

3. Click Save to save the settings.
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Using a Menu Link URL

A menu link URL points you to the iPrint printer list or a customized printer installation page. You can 
find and install your printer from that page. 

To specify the menu link URL:

1. Right-click the  iPrint icon, then click Configuration. 

2. Specify the menu link URL in the Menu link URL field.

3. Click Save to save the settings.

Using a Proxy Server

A proxy server is located between a client and another server that the client is trying to communicate 
with. Proxy servers are often used in conjunction with a firewall to keep internal addresses private by 
exposing only the proxy server’s address to external users. If you have users that need to submit print 
jobs through a proxy server, you can use the iPrint Clients Proxy setting. The Client sends all print-
related requests to the proxy server. The proxy server then redirects the print job to the correct iPrint 
server.

For example, Juan is a laptop user who has installed and printed to a variety of iPrint printers at the 
company’s headquarters. While he is on the road, Juan wants to submit a report to his boss. Rather 
than sending the report by e-mail or fax, Juan decides to send it to the printer near his boss. When he 
tries to send the report to the printer, he receives an error that the printer cannot be found. He knows 
that the company uses a firewall and a proxy server. He types the proxy server address in the iPrint 
Proxy settings, then tries to print the report again. This time the print job is accepted. The print job 
travels from his laptop to the proxy server. The proxy server redirects the print job to the printer’s Print 
Manager, where the print job is spooled and forwarded to the printer. 

To set the proxy server address:

1. Right-click the iPrint icon, then click Configuration. 

2. Specify the URL in the Proxy URL field.

3. Click Save to save the settings.

NOTE: If you do not want to use the proxy server, delete the URL specified in the Proxy URL field and 
save the settings.

Uninstalling an iPrint Printer When You Uninstall the iPrint Client

1. Right-click the iPrint icon, then click Configuration. 

2. Select Uninstall iPrint Printers on iPrint client uninstallation.

3. Click Save to save the settings.

Setting theTrace Level

The trace level determines how much of the debugging information is displayed To set the trace level:

1. Right-click the  iPrint icon, then click Configuration. 

2. Select one of the following options:

Off: No error tracing.

Shell:  Debug output is displayed on the shell where the application started. 
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File: Debug output is sent to /home/<user>/.iprint/trace.txt>. If the user's home directory 
cannot be determined, the debug output is sent to /var/opt/novell/log/iprint/client/
<pid>-<uid>_trace.txt.

All: Debug output is sent to both the shell and the file.

3. Click Save to save the settings.

Keeping Driver Files on Upload or Download

This option allows you to store your driver files in the temporary folder when you upload or download 
the drivers for printer installation. To keep the driver files in the temporary folder:

1. Right-click the iPrint icon, then click Configuration. 

2. Select Keep driver files on upload or download.

3. Click Save to save the settings.

When you upload driversfor printer installation, temporary files are stored at /tmp/iprint-
<username>/tmp-xxxxxx. This file is removed after upload, if the Keep driver files on upload or 
download option is not selected.

When you download drivers for printer installation, temporary files are stored at /tmp/iprint-
<username>/tmp-xxxxxx/download-xxxxxx. This file is  removed after download, if the Keep 
driver files on upload or download option is not selected.

About

Displays the version of the iPrint Client installed on your workstation.

Find/Install Printers

Opens a browser window to the menu link URL specified in the Configuration tab of the tray icon. The 
menu link URL points you to the iPrint printer list or a customized printer installation page. 

You can find and install your printers from there. 

Hide Tray Icon

Removes the iPrint icon from the notification area until the iprint-listener-gui process is 
restarted. To make the icon reappear in your notification area, run the iprntcmd -T command from 
your terminal.

9.8 Macintosh Client: Additional Features
 Section 9.8.1, “Automatically Removing a Printer from the Client,” on page 181

 Section 9.8.2, “Automatically Redirecting a Printer,” on page 182

 Section 9.8.3, “Automatically Updating a Driver/Profile,” on page 182

 Section 9.8.4, “Using the iPrint Client Icon,” on page 182

9.8.1 Automatically  Removing a Printer from the Client

You can automatically remove the printer from the client, if the printer is removed from the server. 
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9.8.2 Automatically  Redirecting a Printer

You can  automatically redirect a printer from the client if the printer is redirected from the server. The 
older printer is removed and the new printer is installed on the client. 

9.8.3 Automatically Updating a Driver/Profile 

You can  automatically update the client with the latest drivers available on the server. 

You enable this option through iManager. For more information, see “Auto Driver/Profile Update” on 
page 116.

9.8.4 Using the iPrint Client Icon

On Macintosh workstations, the iPrint Client adds an icon to the notification area. The iPrint icon lets 
you receive notification when a job has printed and access iPrint client settings quickly. If the iPrint 
icon does not appear in your notification area, run the command iprntcmd -T command from your 
terminal. 

Left-clicking the iPrint icon displays the following menu options:

 “Printers” on page 182

 “Job Status” on page 182

 “Message Board” on page 183

 “Configuration” on page 183

 “About” on page 185

 “Find/Install Printers” on page 185

 “Hide Tray Icon” on page 185

Printers

Displays the iPrint printer list, printer status, location of the printer, driver associated with the printer, 
and the description for the reason of printer status. You can also uninstall your printers from here.

To uninstall a printer:

1. Left-click the iPrint icon, then click Printers. 

2. Select the printer that you want to uninstall.

Press Shift to select more than one printer.

3. Click Uninstall to uninstall the printer.

or

Click Uninstall All to uninstall all the printers.

Job Status

Displays the name of the job, the status of the job, the size of the job, and the name and locationof 
the printer for the job. This option also allows you to clear the job information from the job status tab.

To clear job information:

1. Left-click the iPrint icon, then click Job Status.
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2. Select the job that you want to clear.

Press Shift to select more than one job.

3. Click Clear to remove the job information. 

or

Click Clear All to remove all the job information.

Message Board

The message board stores all the information related to the status of the printers, the jobs issued, 
automatic removal of printer from the client, automatic  redirection of printer, and automatic  driver 
updates. 

To remove the data from the message board:

1. Left-click the iPrint icon, then click Message Board.

2. Click Clear to remove the data from the message board.

Configuration

You can configure the following iPrint settings:

 “Managing Notifications” on page 183

 “Using a Menu Link URL” on page 183

 “Using a Proxy Server” on page 184

 “Uninstalling an iPrint Printer When You Uninstall the iPrint Client” on page 184

 “Setting the Trace Level” on page 184

 “Keeping Driver Files on Upload or Download” on page 185

Managing Notifications

iPrint notifies when your document has printed or your iPrint client needs attention. 

To turn the iPrint notification on:

1. Left-click the iPrint icon, then click Configuration.

2. Select Notify when jobs get printed or need attention.

3. Click Save to save the settings.

Using a Menu Link URL

A menu link URL points you to the iPrint printer list or a customized printer installation page. You can 
find and install your printer from that page. 

To specify the menu link URL:

1. Left-click the iPrint icon, then click Configuration.

2. Specify the menu link URL in the Menu link URL field.

3. Click Save to save the settings.
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Using a Proxy Server

A proxy server is located between a client and another server that the client is trying to communicate 
with. Proxy servers are often used in conjunction with a firewall to keep internal addresses private by 
exposing only the proxy server’s address to external users. If you have users that need to submit print 
jobs through a proxy server, you can use the iPrint Clients Proxy setting. The Client sends all print-
related requests to the proxy server. The proxy server then redirects the print job to the correct iPrint 
server.

For example, Juan is a laptop user who has installed and printed to a variety of iPrint printers at the 
company’s headquarters. While he is on the road, Juan wants to submit a report to his boss. Rather 
than sending the report by e-mail or fax, Juan decides to send it to the printer near his boss. When he 
tries to send the report to the printer, he receives an error that the printer cannot be found. He knows 
that the company uses a firewall and a proxy server. He types the proxy server address in the iPrint 
Proxy settings, then tries to print the report again. This time the print job is accepted. The print job 
travels from his laptop to the proxy server. The proxy server redirects the print job to the printer’s Print 
Manager, where the print job is spooled and forwarded to the printer. 

To set the proxy server address:

1. Left-click the  iPrint icon, then click Configuration.

2. Specify the URL in the Proxy URL field. 

3. Click Save to save the settings.

NOTE: If you do not want to use the proxy server, delete the URL specified in the Proxy URL 
field and save the settings.

Uninstalling an iPrint Printer When You Uninstall the iPrint Client

1. Left-click the  iPrint icon, then click Configuration.

2. Select Uninstall iPrint Printers on iPrint client uninstallation.

3. Click Save to save the settings.

Setting the Trace Level

The trace level determines how much debugging information is displayed. 

To set the trace level:

1. Left-click the  iPrint icon, then click Configuration. 

2. Select one of the following options:

Off: No error tracing.

Shell:  Debug output is displayed on the shell where the application started. 

File: Debug output is sent to /home/<user>/.iprint/trace.txt>. If the user's home directory 
cannot be determined, the debug output is sent to /var/opt/novell/log/iprint/client/
<pid>-<uid>_trace.txt.

All: Debug output is sent to both the shell and the file.

3. Click Save to save the settings.
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Keeping Driver Files on Upload or Download

This option allows you to store your driver files in the temporary folder when you upload or download 
the drivers for printer installation. 

1. Left-click the iPrint icon, then click Configuration.

2. Select Keep driver files on upload or download.

3. Click Save to save the settings. 

When you upload driversfor printer installation, temporary files are stored at /tmp/iprint-
<username>/tmp-xxxxxx. This file is removed after upload, if the Keep driver files on upload or 
download option is not selected.

When you download drivers for printer installation, temporary files are stored at /tmp/iprint-
<username>/tmp-xxxxxx/download-xxxxxx. This file is  removed after download, if the Keep 
driver files on upload or download option is not selected.

About

Displays the version of the iPrint Client installed on your workstation.

Find/Install Printers

Opens a browser window to the menu link URL specified in the Configuration tab of the tray icon. The 
menu link URL points you to the iPrint printer list or a customized printer installation page. 

You can find and install your printers from there.

Hide Tray Icon

Removes the iPrint icon from the notification area until the iprint-listener-gui process is 
restarted. To make the icon reappear in your notification area, run the iprntcmd -T command from 
your terminal.

9.9 Uninstalling the Novell iPrint Client
Uninstalling the Novell iPrint Client is dependent on your workstation’s operating system.

 Section 9.9.1, “Uninstalling the Linux iPrint Client,” on page 185

 Section 9.9.2, “Uninstalling the Macintosh iPrint Client,” on page 186

 Section 9.9.3, “Uninstalling the Windows iPrint Client,” on page 186

9.9.1 Uninstalling the Linux iPrint Client

You can remove the Linux iPrint Client RPM from a terminal prompt. Depending on whether a high-
security (sh) or low-security (sl) Client, use one of the following commands:

rpm -e novell-iprint-xclient-sh

rpm -e novell-iprint-xclient-sl
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NOTE: You need to delete the printers manually after uninstalling the Linux iPrint Client on the 
workstation. For more information, refer Section 9.2.4, “Uninstalling iPrint Printers,” on page 167.

9.9.2 Uninstalling the Macintosh iPrint Client

You can uninstall iPrint from your workstation. 

1. Select Go > Computer > Applications > iPrint Uninstallation.

2. Double-click iPrint Uninstallation.

3. Click Yes to uninstall the iPrint Client.

9.9.3 Uninstalling the Windows iPrint Client

To remove the Novell iPrint Client, use the Add or Remove Programs option in the Windows Control 
Panel.

NOTE: When you uninstall the Windows iPrint Client, all iPrint printers are removed from the 
workstation.

9.10 Printing from LPR Print Systems to iPrint
The implementation of LPR printing (BSD-style printing) in UNIX systems and other systems varies 
greatly. Typically, UNIX or LPR users know how to set up LPR printing on their systems. In order to 
complete the configuration, users need to know the LPR Host and the LPR Printer/Queue 
information, which is the Printer Agent name, provided in iManager. The iPrint Client is not required 
for LPR printing.

To set up an iPrint printer to accept LPR print jobs, you need to enable LPR/LPD printing for the 
printer. See “Configuring LPR Printers” on page 134 for more information.
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10 10Mobile Device Management (MDM)

iPrint App is now enabled for MobileIron.

10.1 Configuring MobileIron to Manage the iPrint App
iPrint App is enabled for MobileIron. You must configure MobileIron to manage the iPrint mobile app.

 Section 10.1.1, “Supported Features,” on page 187

 Section 10.1.2, “Adding the iPrint App to MobileIron,” on page 187

 Section 10.1.3, “Pre-Populating Fields for iPrint Login,” on page 189

 Section 10.1.4, “Distributing the iPrint App to Devices,” on page 191

10.1.1 Supported Features

iPrint mobile app provides an additional feature to pre-populate the following fields on the iPrint login 
screen on both iOS and Android devices:

 Server IP Address

 User ID

 Password

10.1.2 Adding the iPrint App to MobileIron

 “Adding the Android iPrint App” on page 187

 “Adding the iOS iPrint App” on page 188

Adding the Android iPrint App

To add the Android iPrint app to MobileIron, upload the *.apk file and then apply the Android label to 
the application:

1 Download the Novell iPrint for MobileIron Appconnect (*.apk) file from the Novell downloads 
site (http://download.novell.com/Download?buildid=aTGzeK7Yud4~). 

2 Upload the file to MobileIron:

2a In the MobileIron Admin Portal, click the Apps tab.

2b On the App Distribution Library tab, in the Select Platform drop-down list, select Android.

2c Click Add App.

The Add App Wizard is displayed.

2d Click Next, then specify the following information:

Distribution Type: Select In-house App.

Silently Install: If your device supports a silent install, select Yes. If the device does not 
support a silent install or if you are unsure, select No.
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App Upload: Browse to and select the .apk file that you downloaded.

2e Click Next, then specify the following information:

App Name: Novell iPrint is already specified for you. This cannot be changed.

Display Version: The version is already specified for you. This cannot be changed.

Code Version: The version is already specified for you. This cannot be changed.

Description: Specify a short description for the app.

Override URL: For information about this feature, see the blue information icon next to this 
field.

Featured: Select whether you want to feature this app.

Category: Select the category that most closely matches the app. You can add a new 
category as described in the dialog box.

2f (Optional) Click Next, then click Browse to upload any screen shots that you have for the 
app.

The mandatory image size is displayed in the dialog box.

2g Click Finish to close the Add App Wizard.

3 Apply the Android label to your application:

3a From the App Distribution Library tab on the Apps tab, select the Novell iPrint app that you 
just created, then click Actions > Apply To Label.

The Apply To Label dialog box is displayed.

3b Select the Android label, then click Apply > OK.

Adding the iOS iPrint App

To add the iOS iPrint app to MobileIron, import it from the Apple Appstore (https://itunes.apple.com/
us/app/novell-iprint/id582808768?mt=8&ign-mpt=uo%3D4) and then apply the iOS label to the 
application: 

1 Import the app from the Apple Appstore:

1a In the MobileIron Admin Portal, click the Apps tab.

1b On the App Distribution Library tab, in the Select Platform drop-down list, select iOS.

1c Click App Store Import.

The App Store Search dialog box is displayed.

1d In the App Name field, type Novell iPrint.

1e In the App Store field, select the country appropriate to your location.

1f Click Search.

1g Click Import next to the Novell iPrint app, then click OK after it is imported.

1h Close the App Store Search dialog box.

1i From the App Distribution Library tab on the Apps tab, click the Edit icon next to the Novell 
iPrint app that you just imported.

The Edit App for iOS dialog box is displayed.

1j Make any desired changes to the app details and icon, then click Save.

2 Apply the iOS label to your application:

2a From the App Distribution Library tab on the Apps tab, select the Novell iPrint app that you 
just created, then click Actions > Apply To Label.
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The Apply To Label dialog box is displayed.

2b Select the iOS label, then click Apply > OK.

10.1.3 Pre-Populating Fields for iPrint Login

Pre-populate the server URL and user ID fields for both the iOS and Android apps. 

You must modify the app configuration for Android, and create a new app configuration for iOS.

 “Creating the iOS iPrint App Configuration for MobileIron” on page 189

 “Key-Value Pairs” on page 190

 “Modifying the Android iPrint App Configuration for MobileIron” on page 191

Creating the iOS iPrint App Configuration for MobileIron

1 In the MobileIron Admin Portal, click the Policies & Configs tab.

2 On the Configuration tab, click Add New > AppConnect > Configuration.

The New AppConnect App Configuration dialog box is displayed.

3 Specify the following information:

Name: Provide a name for the configuration, such as iPrint iOS Configuration.

Description: (Optional) Provide a description for the configuration.

Application: Specify the iPrint iOS bundle ID, which is com.novell.print.

4 In the App-specific Configurations section, click the Plus icon to add a new field to the key-value 
pair table; you can then specify the key-value pair to be included in the configuration.

The key-value pairs that you can add are shown in Table 10-1, “iPrint Key-Value Pairs,” on 
page 190. Key-value pairs that you add to the table represent the information that will be pre-
populated for iPrint login.

5 Click Save.
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Key-Value Pairs

Table 10-1   iPrint Key-Value Pairs

Examples for Key-Value Pairs

 Multiple Servers and Same Users: If there are two iPrint servers and you want all the app 
users to print through both the servers, specify the server values and user and password as the 
key. 

Table 10-2   Multiple Servers and Same Users

 Multiple Servers and Different Users: If there are two iPrint servers and you want different set 
of app users to print through each server, specify the server values and subsequent user and 
password as the key. Use the key-value pair as server1 and user1, password1 and server2 
and user2, password2. 

Key Value

server Specify the URL of your iPrint site. For example, iprint.acme.com.

server2 When specifying multiple servers, the subsequent servers will be server2, server3, 
and so forth. You can provide same or different user for each server.

user Specify $USERID$ for MobileIron to automatically populate the app with the users’ 
MobileIron user ID.

Alternatively, you can specify an individual user’s user ID.

password Specify $PASSWORD$ for MobileIron to automatically populate the app with the users’ 
MobileIron password.

Alternatively, you can specify an individual user’s password.

configlocked The value is true or false. By default, the value is true and the app users will not be able 
to modify the iPrint app configuration on their devices. 

Key Value

server iprint.acme.com

server2 iprint2.acme.com

user $USERID$

password $PASSWORD$
190 Novell iPrint Appliance 1.1 Administration Guide



Table 10-3   Multiple Servers and Different Users

Modifying the Android iPrint App Configuration for MobileIron

1 In the MobileIron Admin Portal, click the Policies & Configs tab.

2 On the Configuration tab, in the Name column, click the name of the iPrint configuration for the 
iPrint app that you uploaded, as described in “Adding the Android iPrint App” on page 187.

3 Click Edit.

The Modify AppConnect App Configuration dialog is displayed.

4 Specify the following information:

Name: Provide a name for the configuration, or keep the default.

Description: (Optional) Provide a description for the configuration, or keep the default.

Application: Select Novell iPrint from the drop-down list.

5 In the App-specific Configurations section, keep or remove the key-value pairs that are shown in 
Table 10-1, “iPrint Key-Value Pairs,” on page 190. Key-value pairs that remain in the table 
represent the information that will be pre-populated for iPrint login.

6 Click Save.

10.1.4 Distributing the iPrint App to Devices

You must distribute the iPrint app to devices in your organization via MobileIron if this is the first time 
your organization is using MobileIron with iPrint, or any time a new device enters the organization.

Some users might have independently download the iPrint app from the app store before their device 
is managed by MobileIron. Even in this scenario, you must push the app to their device via 
MobileIron. (These devices will lose any cached or downloaded files within the iPrint app after their 
device becomes managed and the iPrint app is pushed to their device.)

Key Value

server1 iprint.acme.com

user1 $USERID$

password1 $PASSWORD$

server2 iprint2.acme.com

user2 $USERID$

password2 $PASSWORD$
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11 11Troubleshooting iPrint Appliance

You might encounter the following issues when using iPrint Appliance.

NOTE: The iPrint Appliance print server maintains log files to help with debugging the server's 
activity. The log files are located at the following locations:

 Novell iManager: /var/opt/novell/tomcat6/logs/catalina.out

 Novell iPrint Mobile: /var/opt/novell/log/iprintmobile/iprintmobile0.log

 Management Console: /var/opt/novell/jetty8/logs/jetty.stderrout.out

 Export Backup: /var/opt/novell/log/iprintmobile/backup.log

 Upgrade Restore: /var/opt/novell/log/iprintmobile/restore.log

 Print Manager: /var/opt/novell/log/iprint/ipsmd.log

 Driver Store: /var/opt/novell/log/iprint/idsd.log

 eDirectory: /var/opt/novell/eDirectory/log/ndsd.log

 Apache: /var/log/apache2/error_log

 Avahi: /var/log/messages

 Section 11.1, “Server Issues,” on page 193

 Section 11.2, “LDAP Issues,” on page 195

 Section 11.3, “Renderer Issues,” on page 196

 Section 11.4, “AirPrint Issues,” on page 201

 Section 11.5, “General Issues,” on page 203

11.1 Server Issues
 Section 11.1.1, “POODLE Security Vulnerability,” on page 193

 Section 11.1.2, “Processor Utilization Increases When 10,000 Users Are Imported from an 
External LDAP Source,” on page 194

 Section 11.1.3, “Unable to Backup iPrint Appliance 1.0,” on page 194

 Section 11.1.4, “Upgrading iPrint Appliance Does Not Automatically Export the License File,” on 
page 195

 Section 11.1.5, “Upgrade Progress Bar Continues Processing,” on page 195

11.1.1 POODLE Security Vulnerability

LDAPS and HTTPS in eDirectory allow SSLv3 for secure communication, and SSLv3 has been found 
to have protocol vulnerability as per CVE-2014-3566. After applying the Appliance patches, ensure 
that you disable SSLv3 to prevent POODLE security vulnerability.

To disable SSLv3 through LDAP, add number 128 to the ldapBindRestrictions attribute on the LDAP 
server object.
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11.1.2 Processor Utilization Increases When 10,000 Users Are 
Imported from an External LDAP Source

When syncing users from an external LDAP source, the processor utilization increases if you try to 
import 10,000 users.

The reason for this behavior is that the User Sync is scheduled to run every 8 minutes, by default. 
Therefore, each time the User Sync is started, which is every 8 minutes, the processor utilization 
increases to around 50%, and remains in that state for up to 5 minutes. The utilization might further 
increase if you import over 10,000 users.

To workaround this issue, you can change the sync interval by editing the crontab file.

1 Launch the crontab file located at /etc/crontab.

2 Browse to the line where the sync interval is set to 8 minutes.

# run iprint migrate every 8 minutes

*/8 * * * * root /usr/bin/python /opt/novell/iprintmobile/python/migrate/
migrateUsers.pyc >> /var/log/ipmigrate.log 2>&1

3 Change the time to the desired time interval.

For information on scheduling time intervals for cron jobs, see the article about Cron on Wikipedia.

11.1.3 Unable to Backup iPrint Appliance 1.0

When using iPrint Appliance 1.0, you may not be able to create a backup if you have a Driver Store in 
excess of 6 GB. This is caused due to lack of disk space in the virtual machine.

To workaround this issue, you must add an additional hard disk to your virtual machine, then backup 
iPrint Appliance 1.0. If your Drive Store is 10 GB in size, then you must add an additional 20 GB of 
hard disk space. The hard disk space must be twice the size of the resdir folder.

1 Power off the iPrint Appliance 1.0 VM.

2 In the vSphere client, right-click the iPrint Appliance 1.0, then click Edit Settings.

3 Click Add.

4 Select Hard Disk, then click Next.

5 Select Create a new virtual disk., then click Next.

6 Specify the Disk Size, then click Next.

7 Click Next on the Advanced Options screen.

8 Click Finish.

9 Power on the iPrint Appliance 1.0 VM.

10 Create a partition using the fdisk command.

10a Run the command fdisk /dev/<disk name>.

10b When prompted for a command, specify n, then tap the Enter key.

10c For partition, specify p, then choose the default option.

10d When prompted for a command, specify w.

11 Create a file system using the command mkfs.ext3 /dev/<disk name>.

12 Stop the jetty service.
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13 Mount the /tmp folder to the newly added hard disk using the command mount /dev/<disk 
name> /tmp/.

14 Start the jetty service.

After completing the procedure mentioned above, try backing up iPrint Appliance 1.0.

11.1.4 Upgrading iPrint Appliance Does Not Automatically Export 
the License File

When upgrading iPrint Appliance 1.0 to a higher version, the license file does not get automatically 
exported to the newer version. This issue is caused because the license file is not automatically 
backed up on the iPrint Appliance 1.0. 

To work around this issue:

1 You must manually copy the license file located at /opt/novell/filr/apache-tomcat/
webapps/ssf/WEB-INF/ on iPrint Appliance 1.0 to your system.

2 Launch the Managment Console of iPrint Appliance 1.1. 

3 Go to iPrint Appliance Configuration > License, then upload the backed up license file.

11.1.5 Upgrade Progress Bar Continues Processing

When upgrading iPrint appliance using the iPrint Appliance Management Console, the progress bar 
continues processing. This issue is caused by the automatic update feature of the web browser.

To work around this issue, close all open browser sessions, relaunch the browser, then wait for the 
browser update to complete before upgrading iPrint Appliance.

11.2 LDAP Issues
 Section 11.2.1, “Unable to Import All Users from the Active Directory Source Using LDAP Sync,” 

on page 195

 Section 11.2.2, “Active Directory Administrator Users Unable to Perform Administrative Tasks 
Post LDAP Import,” on page 196

 Section 11.2.3, “LDAP Import Fails to Import Administrator User from Active Directory 
Environments,” on page 196

11.2.1 Unable to Import All Users from the Active Directory Source 
Using LDAP Sync

You might not be able to import all users from the Active Directory source using LDAP sync. By 
default, in Active Directory, LDAP search returns only 1,000 objects. This issue is caused by a default 
setting in Active Directory that limits LDAP searches to 1,000 results.

To work around this issue, you can use the Ntdsutil.exe tool to modify the MaxPageSize value to 
expand or limit the search, depending on the size of the Active Directory tree.

For more information, see the Microsoft support article on How to view and set LDAP policy in Active 
Directory by using Ntdsutil.exe.
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11.2.2 Active Directory Administrator Users Unable to Perform 
Administrative Tasks Post LDAP Import

Admin users migrated to iPrint Appliance through LDAP Import cannot perform administrative tasks 
such as managing iManager. This is because the LDAP Import feature imports only the user names 
but not the passwords. iManager fails to authenticate AD users with no passwords.

11.2.3 LDAP Import Fails to Import Administrator User from Active 
Directory Environments

When importing users from Active Directory environments, LDAP import fails to import the 
administrator user account.

The Active Directory administrator user is not required for iPrint Appliance. iPrint Appliance contains 
an in-built administrator account. The admin account of iPrint Appliance manages all users imported 
from Active Directory.

11.3 Renderer Issues
 Section 11.3.1, “Upgrading iPrint Renderer From 1.0 or 1.0.1 to 1.1 Corrupts the 

iPrintRenderer.conf File,” on page 197

 Section 11.3.2, “PowerPoint Job Fails to Print,” on page 197

 Section 11.3.3, “Jobs Fails to Print,” on page 197

 Section 11.3.4, “Remote Renderer Status is Inactive,” on page 197

 Section 11.3.5, “Remote Renderer Status is Inactive After Appliance Upgrade,” on page 198

 Section 11.3.6, “iPrint Rendering Service Hangs,” on page 198

 Section 11.3.7, “Printer Drivers are Missing After Registering the Remote Renderer,” on 
page 198

 Section 11.3.8, “Local Renderer Fails to Print the Password-Protected PDF Files,” on page 198

 Section 11.3.9, “Printer Prints Junk Characters,” on page 198

 Section 11.3.10, “Remote Renderer Fails to Start Because of Login Failure,” on page 199

 Section 11.3.11, “Adobe Acrobat 11 Pro Hangs While Rendering PDF Files,” on page 199

 Section 11.3.12, “Disk Space Gets Filled Up During Continuous Job Submission,” on page 200

 Section 11.3.13, “iPrint Rendering Service Fails to Start If the Windows User Account Password 
Changes or Expires,” on page 200

 Section 11.3.14, “iPrntRendCmd Stops Responding During Configuration or Other Command 
Line Operations,” on page 200

 Section 11.3.15, “Unable to Remove Inactive Renderer Entries from the Management Console,” 
on page 200

 Section 11.3.16, “Upgrade Option Missing for Remote Renderer,” on page 201
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11.3.1 Upgrading iPrint Renderer From 1.0 or 1.0.1 to 1.1 Corrupts 
the iPrintRenderer.conf File

If you have upgraded the renderer from 1.0 or 1.0.1 to 1.1, the iPrintRenderer.conf file gets 
corrupted. On corruption of this file, the renderer also fails to uninstall.

To resolve this issue, do the following:

1 Replace the contents of the c:/NDPS/Renderer/Conf/iPrintRenderer.conf file with the 
following:

Word=doc,docx,rtf,docm,dotm
Excel=xls,xlsx,xlsm,xlsb
Powerpoint=ppt,pptx,pptm,ppsm
inBuiltPDFRenderer=pdf
#Adobe=pdf

2 On your client workstation, uninstall the Renderer.

3 Install the latest renderer. For more information, see Section 6.3, “Installing and Configuring a 
Remote Renderer,” on page 74. 

11.3.2 PowerPoint Job Fails to Print 

If the remote renderer configured with Microsoft Office 2013 is under continuous load, then it may fail 
to print PowerPoint jobs. This issue is not caused if the remote renderer is configured with Microsoft 
Office 2010.

To resolve this issue, stop and start the remote renderer.

11.3.3 Jobs Fails to Print 

If the remote renderer is configured on Windows 8, Windows 8.1, Windows 2012, and Windows 2012 
R2 server, then over the period of time, you might encounter consistent print failure. This is because 
the in-built pdf renderer might have stopped responding. 

To resolve the issue, restart the remote rendering service using the following commands:

1 To stop the renderer, run iprntrendcmd -q

2 To start the renderer, run iprntrendcmd -l

11.3.4 Remote Renderer Status is Inactive

Sometimes the remote renderer status might change to Inactive and activating it from the 
Management Console also fails to change the status.

To resolve this issue, restart the renderer using the following commands:

1 To check the status of the service, run iprntrendcmd -s

2 To start the renderer, run iprntrendcmd -l
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11.3.5 Remote Renderer Status is Inactive After Appliance 
Upgrade

If you have a remote renderer associated with the iPrint Appliance, then upgrading the iPrint 
Appliance changes the remote renderer status to Inactive. To resolve this issue, follow the steps from 
Section 6.3.3, “Downloading the Remote Renderer,” on page 75 to Section 6.3.5, “Registering the 
Remote Renderer,” on page 76 to download, install, and register the new renderer.

11.3.6 iPrint Rendering Service Hangs

The iPrint Rendering Service might hang with the service status “Stopping.” 

This issue is caused when the remote renderer fails to restart when using the configuration or 
registration commands.

To workaround this issue:

1 Launch the Windows Task Manager.

2 Click the Processes tab.

3 Check the Show processes from all users box.

4 Right-click iPrint Rendering Service.exe, then click End Process.

5 Start the remote rendering service by using the iprntrendcmd -l command or through the 
window services panel.

11.3.7 Printer Drivers are Missing After Registering the Remote 
Renderer 

After registering the remote renderer, self-signed and un-signed drivers are not installed. 

To resolve this issue, run the command, iprntrendcmd -rt <FDN or IP Address>

On the prompt, accept the certificate for each driver.

11.3.8 Local Renderer Fails to Print the Password-Protected PDF 
Files

The local renderer fails to print password-protected or corrupt PDF files. 

You might get a message in the audit page that the job is complete or success message for email 
printing, if the local renderer uses the pre-packaged driver for printing.

11.3.9 Printer Prints Junk Characters

When trying to print a document, the printer might print only junk characters in the following 
scenarios:

 This issue is caused because the local renderer does not support all the font types. To resolve 
this issue, you can install the Microsoft TrueType fonts on your iPrint Appliance server.

1. Log in as root.

2. Type the following command to navigate to the fonts directory, then press Enter:
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cd /opt/novell/iprintmobile/fonts/

3. Install the supported RPM files by typing the following command, then press Enter:

rpm -ivh *.rpm

The RPM files are now installed on the iPrint server.

4. Run the script to retrieve the fonts by typing the following command, then press Enter:

sh fetchmsttfonts-11.1-5.7.10-fetchmsttfonts.sh.txt

The fonts are downloaded from Sourceforge and installed on your iPrint server.

 Few of the Linux drivers might fail to print due to absence of certain filters. You can verify this 
information, using the command: lpstat -p

The command displays the status of the drivers. Change the driver for which you have received 
the failure messages. This is applicable only for local renderer.

 If the remote renderer is registered with Built-in-PDF Renderer for processing the PDF jobs, it 
might print junk characters for PDF files. 

To resolve this issue, you need to reconfigure the remote renderer using iprntrendcmd -c 
command.

 If the remote renderer is not registered for PDF file processing, the printer might print only junk 
characters and not the actual content. This can be caused by an incompatible printer driver.

To work around this issue, use the drivers that are compatible with your printer.

11.3.10 Remote Renderer Fails to Start Because of Login Failure

The remote rendering service might not start if the credentials provided are incorrect, or if the user 
account does not have the Log on as a service rights.

To resolve this issue, you must assign the Log on as a service rights to the user account with which 
you want to set up the renderer, on the local machine:

1 Go to Start > Control Panel > Administrative Tools > Local Security Policy.

2 In the left pane, double-click Local Policies.

3 Click User Rights Assignment.

4 In the right pane, under Policy, double-click Log on as a service.

5 Click Add User or Group.

6 Add the user account to the list, then click OK.

7 Click OK, then close the Local Security Policy window.

11.3.11  Adobe Acrobat 11 Pro Hangs While Rendering PDF Files

When rendering PDF files using Adobe Acrobat 11 Pro, Adobe Acrobat might stop responding and 
not complete the rendering process.

To work around this issue, kill Adobe Acrobat from Windows Task Manager, then try again.
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11.3.12 Disk Space Gets Filled Up During Continuous Job 
Submission

When handling a large number of print requests, the remote renderer might not be able automatically 
delete the converted job data, and the disk space allocated for the remote renderer might fill up.

To work around this issue, you must manually delete the stored jobs.

1 Launch the command prompt.

2 Stop the iPrint Rendering Service manually using the command iPrntRendCmd -q.

3 Delete the files in the jobs folder located at C:\NDPS\Renderer\jobs.

4 Start the iPrint Rendering Service using the command iPrntRendCmd -l.

11.3.13 iPrint Rendering Service Fails to Start If the Windows User 
Account Password Changes or Expires

The iPrint Rendering Service might not work if the password of the user account associated with the 
service changes or expires.

To work around this issue, you must update the new password for the iPrint Rendering Service on the 
Services utility.

1 Click Start > Run.

2 Specify services.msc, then click OK.

3 Right-click iPrint Rendering Service, then click Properties.

4 Click the Log On tab.

5 Under This account, update the new password, then click Apply.

6 Click OK.

7 Right-click iPrint Rendering Service, then click Start or Restart to start the service.

11.3.14 iPrntRendCmd Stops Responding During Configuration or 
Other Command Line Operations

When configuring or modifying the remote renderer, the iprntrendcmd command might stop 
responding.

To work around this issue, close the command prompt that is currently open, launch a new command 
prompt window, and then try the iprntrendcmd command again.

11.3.15 Unable to Remove Inactive Renderer Entries from the 
Management Console

On the iPrint Appliance Management Console, the inactive render entries might not automatically get 
deleted after uninstalling the renderer.

Ensure to complete all print jobs before performing the work around to resolve this issue: 

1 Stop the Novell iPrint Mobile service through the Management Console.
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For information on stopping or starting a service, see Section 7.6.1, “Starting, Stopping, or 
Restarting System Services,” on page 87.

2 Launch the terminal.

3 Run the command iprintmobile_config_renderer -l to get a list of renderers and their IDs.

4 Run the command iprintmobile_config_renderer -r <rendererID> to remove the inactive 
renderer.

5 Start the Novell iPrint Mobile service through the Management Console. Restarting 

11.3.16 Upgrade Option Missing for Remote Renderer

The remote renderer on iPrint Appliance does not provide an upgrade option.

This is a known limitation of the remote renderer in the iPrint Appliance 1.1 and earlier versions. 

To resolve this issue, follow the steps from Section 6.3.3, “Downloading the Remote Renderer,” on 
page 75 to Section 6.3.5, “Registering the Remote Renderer,” on page 76 to download, install, and 
register the new renderer.

11.4 AirPrint Issues
 Section 11.4.1, “AirPrint Secure Printers Fails to Print,” on page 201

 Section 11.4.2, “AirPrint Printers Are Listed Twice During Printer Discovery,” on page 201

 Section 11.4.3, “AirPrint Printers Are Not Listed,” on page 202

 Section 11.4.4, “Print Job Submitted Using AirPrint Shows Processing Continuously,” on 
page 202

 Section 11.4.5, “AirPrint Errors and Symptoms,” on page 202

11.4.1 AirPrint Secure Printers Fails to Print 

If you are using iOS 7 or above devices, then AirPrint secure printers fails to print in the following 
scenarios:

 On upgrading the iPrint Appliance to 1.1

 On enabling a normal AirPrint printer as secure printer

To resolve this issue, using the iPrint Appliance Management Console, you must disable and enable 
the secure printer as AirPrint printer.

11.4.2 AirPrint Printers Are Listed Twice During Printer Discovery

iPrint AirPrint uses the same advertising medium (mDNS) as that of Apple’s AirPrint. Therefore, an 
AirPrint printer is listed twice during printer discovery.

To resolve this issue, disable the advertisement from iPrint Appliance.

1 On a Web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the iPrint Appliance Configuration icon.

3 Under Administration, click Printers.
Troubleshooting iPrint Appliance 201



4 Select the printer for which you want to disable advertising. You can select multiple printers by 
holding the Ctrl key on your keyboard, then selecting the printers.

5 Click the AirPrint drop-down menu, then select Disable Advertising.

11.4.3 AirPrint Printers Are Not Listed

When trying to print, you might not be able to see any AirPrint printers listed.

To resolve this issue, try disabling and re-enabling the wireless connection on the iOS device. If you 
are still unable to view the printers, restart the Avahi service on the AirPrint server through the iPrint 
Appliance Management Console:

1 On a Web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the iPrint Appliance Configuration icon.

3 Under Administration, click Services.

4 Select Avahi.

The Action and Options drop?down menus are activated.

5 Click the Action drop-down menu, then click Restart.

11.4.4 Print Job Submitted Using AirPrint Shows Processing 
Continuously

On iOS devices, when you submit a print job, the Print Center continuously shows that the job is 
processing. This issue occurs when a printer to which you are trying to print is redirected or not 
working.

To resolve this issue on a redirected printer, disable advertising on a redirected printer so that the 
printer is not displayed as an AirPrint printer. Advertise the target printer instead.

To resolve this issue on a printer that is not working, disable advertising and fix the printer before 
enabling advertising on the printer.

1 On a web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the iPrint Appliance Configuration icon.

3 Under Administration, click Printers.

4 Select the printer for which you want to disable advertising. You can select multiple printers by 
holding the Ctrl key on your keyboard, then selecting the printers.

5 Click the AirPrint drop-down menu, then select Disable Advertising.

6 Fix the printer. 

7 Click the AirPrint drop-down menu, then select Enable Advertising.

11.4.5 AirPrint Errors and Symptoms

When using AirPrint, users might receive a few error messages, or notice symptoms that might 
indicate issues with the printer or the network. The errors and symptoms are listed below, along with 
the possible cause.
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Table 11-1   AirPrint Error and Symptoms

Points to note:

 If the printer's input queue is paused, jobs are queued at the device print queue. To view the print 
queue on iOS devices, double-tap the Home button, then select the Print Centre app.

 For photo printing, paper types such as 4x6 and LETTER are available only on iOS 6.0 and 
above. When printing images on iOS 6.x, the paper type is displayed by default.

 On iOS 6.x, the duplex option is displayed dynamically by querying the printer for duplex 
availability status.

 AirPrint might display messages regarding the status of the printer such as empty input tray or 
printer jam, based on the status message from the printer's console. If the printer is in READY 
state without any warning/error messages, AirPrint does not display any printer error messages 
to the user.

 Before enabling AirPrint, ensure that the iPrint Appliance DNS name is resolvable by the iOS 
device.

 If a printer is not functioning, disable advertising on that printer to ensure that the printer is not 
displayed as an AirPrint printer, and users do not try printing to those printers.

 The remote renderer must be configured with iPrint Appliance to ensure that documents render 
correctly when printing using AirPrint.

11.5 General Issues
 Section 11.5.1, “Unable to upload Xerox GPD and HP UPD driver from iManager,” on page 204

 Section 11.5.2, “Fails to Print Jobs With Conversion Failure Error,” on page 204

 Section 11.5.3, “iPrint Appliance Migration Target Server SSL Authentication Fails,” on page 204

 Section 11.5.4, “RPC Error When Enabling Printers for Mobile Printing,” on page 204

 Section 11.5.5, “Email Printing Fails When the Filename Includes Extended Characters Or 
Double-byte Characters,” on page 205

 Section 11.5.6, “Unable to Configure Email Printing When SSL Is Enabled for IMAP/POP in 
GroupWise,” on page 205

 Section 11.5.7, “DataStore Creation Fails,” on page 205

 Section 11.5.8, “Garbage Characters Printed When Printing from Gmail on Internet Explorer,” on 
page 206

Error/Symptom Possible Cause

The printer is paused iPrint output printer queue paused.

Check the printer for errors Network communication failed between iPrint 
Appliance and printer, or iPrint printer is shut down.

The printer is offline iPrint Appliance is not reachable.

iOS 5.x: An error occurred printing this document

iOS 6.x and later: The printer is no longer available

iPrint printer is deleted from PSM but still published as 
AirPrint printer on the network.

The printer is no longer available iPrint printer is shut down.

The printer job is continuously under processing Printer is redirected or not working.
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 Section 11.5.9, ““Canceled by Operator” Messages in the Audit Logs,” on page 206

 Section 11.5.10, “Secure Printer Continues Printing after Changing the User Password (Local 
Appliance eDirectory Users Only),” on page 206

11.5.1 Unable to upload Xerox GPD and HP UPD driver from 
iManager

The drivers cannot be uploaded due to out of memory issue. To resolve this issue, we recommend 
you to increase the Java heap size to 1GB for iManager.

Perform the following steps:

1 In the /etc/opt/novell/tomcat6/conf/novell-tomcat6.conf file append the variable 
JAVA_OPTS with the value -Xmx1024M.

2 Execute the following command to restart tomcat:

rcnovell-tomcat6 restart

11.5.2 Fails to Print Jobs With Conversion Failure Error 

If the printer drivers are faulty the jobs might fail with a conversion failure error.

To workaround this issue, reinstall the driver for that particular printer. 

11.5.3 iPrint Appliance Migration Target Server SSL Authentication 
Fails

iPrint Appliance Migration target server SSL authentication might periodically fail.

To work around this issue, close the miggui application and launch it again.

11.5.4 RPC Error When Enabling Printers for Mobile Printing

When enabling printers for Mobile printing using the iPrint Appliance Management Console, you 
might encounter an RPC error.

To work around this issue, you can log out and log in to the iPrint Appliance Management Console if 
the browser session is open for a long time, or you can refresh the Printers page. If you are still 
seeing the RPC error, restart the Print Manager service, and then try to enable the printer for mobile 
printing.

1 On a Web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the iPrint Appliance Configuration icon.
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3 Under Administration, click Services.

4 Select Print Manager.

The Action and Options drop?down menus are activated.

5 Click the Action drop-down menu, then click Restart.

11.5.5 Email Printing Fails When the Filename Includes Extended 
Characters Or Double-byte Characters

Printing through email fails, if the name of the file includes either extended characters or double-byte 
characters.

To resolve this issue, rename the file to include only supported characters.

11.5.6 Unable to Configure Email Printing When SSL Is Enabled 
for IMAP/POP in GroupWise

If SSL is enabled for IMAP/ POP in GroupWise, you might be unable to configure email printing using 
the iPrint Appliance Management Console.

To work around this issue, you must manually import the GroupWise certificate into iPrint Appliance 
using the Management Console.

1 On a Web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the Appliance System Configuration icon.

3 Click Digital Certificates.

4 In the Key Store drop-down menu, select JVM Certificates.

5 Go to File > Import > Trusted Certificate.

6 Browse and select the GroupWise certificate, specify an Alias name, then click OK.

7 Click Close.

8 Click Reboot to reboot iPrint Appliance.

After iPrint Appliance reboots, configure email printing from the iPrint Appliance Management 
Console.

11.5.7 DataStore Creation Fails

When trying to create a DataStore, you might see a message: “Failed to parse the XML file: XML 
document structures must start and end within the same entity.” 

To work around this issue, run the configuration script located at /opt/novell/iprintmobile/bin/
config.sh.

If you are still seeing the error, you must reinstall iPrint Appliance.
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11.5.8 Garbage Characters Printed When Printing from Gmail on 
Internet Explorer

If you are using Gmail on Internet Explorer and you try to print an email, you might see garbage 
characters in place of line breaks. This is caused by a character encoding issue.

To work around this issue, you must change the default text encoding to UTF-8 in your Gmail 
settings.

1 Launch Internet Explorer, then go to www.gmail.com.

2 Sign in to Gmail with your user name and password.

3 Click the settings icon in the upper-right corner of the screen, then select Settings.

4 Under General settings, in the Outgoing message encoding section, select Use Unicode (UTF-8) 
encoding for outgoing messages.

5 Click Save Changes.

11.5.9 “Canceled by Operator” Messages in the Audit Logs

In the audit log files, you might see the following message:

Canceled by operator

This issue occurs if the files are not rendering correctly.

To work around this issue, ensure that the rendering service is active, and that the renderer is 
configured correctly.

11.5.10 Secure Printer Continues Printing after Changing the User 
Password (Local Appliance eDirectory Users Only)

When users change their passwords, secure printers might continue printing with the old password 
for up to 10 minutes. This is because of caching inside the iPrint LDAP authentication module, and 
affects only the users created inside the local eDirectory tree on iPrint Appliance.

To fix this issue, add the parameters LDAPDNCacheTTL and LDAPDNCacheEntries to the 
iprint_g.conf file, located at /etc/opt/novell/iprint/httpd/conf/iprint_g.conf as shown 
below:

To change the caching time to 30 seconds:

<IFModule mod_authnz_ldapdn.c>

   LDAPDNCacheTTL 30 

</IfModule>

To disable caching:

<IFModule mod_authnz_ldapdn.c> 

    LDAPDNCacheEntries -1 

</IfModule>
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After updating the iprint_g.conf file, launch the terminal window, and then restart the Apache 
service using the iPrint Appliance Management Console:

1 On a Web browser, use either the DNS name or the IP address to access the Management 
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the iPrint Appliance Configuration icon.

3 Under Administration, click Services.

4 Select Apache server for Novell for iPrint.

The Action and Options drop?down menus are activated.

5 Click the Action drop-down menu, then click Restart.
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12 12Known Limitations

You might encounter the following limitations when using iPrint Appliance.

 Section 12.1, “General Limitations,” on page 209

 Section 12.2, “AirPrint Through iPrint Limitations,” on page 210

12.1 General Limitations
 When using email printing commands, the status, move, resume, and cancel commands might 

not execute when used with the job name. If the commands do not execute with job names, use 
job id instead.

 Email printing to secure printers is disabled. This is to enhance the security of your print system.

 When you upgrade or export iPrint Appliance, the remote renderer status might be “Inactive.” To 
resolve this issue, you must unregister and re-register the remote renderer.

 To manage remote Driver Store, you must login to the remote machine via iManager. 

 If you want to create a local user or a local group account in iPrint Appliance, ensure that you 
create the user or group account outside of the synced user’s context. This is because when you 
sync from an LDAP source to iPrint Appliance, the user and group entries are imported into the 
MySQL database of iPrint Appliance. By default, iPrint Appliance runs a sync to the MySQL 
database every 8 minutes. If the local user or group account is not found in the MySQL 
database, the account is automatically deleted during the next sync.

 Any configuration change in iPrint Appliance takes at least 20 minutes to get updated to the 
configuration file. If you export the iPrint Appliance configuration file within 20 minutes of 
modifying the configuration settings, and then import the configuration file into another copy of 
iPrint Appliance, the changes are not captured. In this case, you might not be able view the 
updated information in the iPrint Appliance. It is recommended that you wait at least 20 minutes 
after the last configuration change before you export the configuration file.

 The Novell iPrint app does not allow imported users to log in with the full user context.

 The remote renderer installation interface is not available in Slovak, Hungarian, Netherlands 
Dutch, or Catalan languages.

 When trying to print an image through the Gmail app on Android devices, you might see the 
message “Novell iPrint could not receive the document/image in a file format,” and the image 
might not print.

 When trying to unregister a renderer through the command line, you must provide the IP address 
of the renderer. You cannot unregister a renderer using the hostname.

 Before installing or uninstalling Adobe Acrobat X Pro on the Windows machine, you must stop 
the remote rendering service using the command iprntrendcmd -q. If you do not stop the 
remote rendering service, you might see a message that Microsoft Office applications are 
running, and you might not be able to proceed with installation or uninstallation. 

 If a user account synced from an LDAP source to iPrint Appliance is renamed at the source, the 
user authentication fails. The user account is imported as a new object. Novell plans to address 
this issue in a future release.
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 On performing LDAP import the following objects are not imported to the iPrint appliance:

 Admin and default users

 Empty groups

 On performing migration the following objects are not migrated to the iPrint appliance: 

 ACLs for driver store

 iCM configuration of the admin user

 iPrint Appliance Migration target server SSL authentication might sometimes fail. To work around 
this issue, close the miggui application and launch it again.

 You might find warning logs in the /var/opt/novell/log/iprintmobile/iprintmobile0.log 
file. These logs are created if the file conversion takes more than two seconds. You can ignore 
this warning as there is no functionality loss.

12.2 AirPrint Through iPrint Limitations
 Users submitting AirPrint jobs to non-secure printers are logged as Guest users in the iPrint 

server audit log. This is because non-secure printers do not require user credentials to print. 

 If a user is not authorized to use a secure printer, the printer does not print because of an 
authentication failure. The iOS device does not display any message to indicate the 
authentication failure.

 Users might be prompted for credentials for non-secure AirPrint printers.

 Secure printing to iPrint printers through AirPrint is supported only on iOS 6.x and later versions.

 “The printer is no longer available” message is displayed even if the printer is working fine.

 If you print to a secure AirPrint printer by providing your credentials, the credentials are stored, 
and you are not prompted for the credentials when you print to that printer in the future. This is 
the default behavior of AirPrint.

 Whenever a user prints to a secure printer, an "invalid request-URI" message is displayed in the 
Apache error logs. 
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A AEmail Service Parameters

 Section A.1, “Incoming Mail Server Parameters,” on page 211

 Section A.2, “Outgoing Mail Server Parameters,” on page 212

A.1 Incoming Mail Server Parameters
iPrint Appliance uses POP3 and IMAP protocols to access email servers to poll for email-based print 
jobs. The default POP3 and IMAP protocol ports are listed below:

The information in this table is captured from an email provider support pages. This is not an 
exhaustive list. Please refer to your email provider for additional information and compatibility.

Protocol Port

IMAP 143

IMAP4 over SSL 993

POP3 110

POP3 (Secure) 995

Mail Server Protocol Address Port Notes

1&1 POP3 pop.1and1.com 995

IMAP4 imap.1and1.com 143

AT&T POP3 pop.att.yahoo.com 995 SSL-enabled

AOL Mail IMAP imap.aol.com 143

Comcast POP3 mail.comcast.net 110

Google Gmail POP3 pop.gmail.com 995 SSL-enabled

IMAP 993 SSL-enabled

Hotmail POP3 pop3.live.com 995 Secure Password 
Authentication (SPA)

Mac POP3 mail.mac.com 143

IMAP4 mail.mac.com 143

Netscape IMS POP3 pop.3.isp.netscape.com 110

Verizon POP3 pop.verizon.net 110

995 SSL-enabled

Yahoo! POP3 pop.mail.yahoo.com 465

995

SSL-enabled

SSL-enabled
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A.2 Outgoing Mail Server Parameters
The iPrint Appliance uses SMTP protocols to send email to users who submit email-based print jobs 
in order to report their job status. The default SMTP protocol ports are listed below:

The information in this table is captured from an email provider support pages. This is not an 
exhaustive list. Please refer to your email provider for additional information and compatibility.

Yahoo! Plus POP3 plus.pop.mail.yahoo.com 995 SSL-enabled

Mail Server Protocol Address Port Notes

Protocol Port

SMTP 25

SMTP (Secure via SSL) 465

SMTP (Secure via TLS) 587

Mail Server Protocol Address Port Notes

1&1 SMTP smtp.1and1.com 587

AT&T SMTP smtp.att.yahoo.com Requires 
authentication

AOL Mail SMTP smtp.aol.com 587

Comcast SMTP smtp.comcast.net 110

Google Gmail SMTP smtp.gmail.com 465

587

SSL-enabled

TLS-enabled

Hotmail SMTP smtp.live.com 587 TLS-enabled

Mac SMTP smtp.mac.com

Netscape IMS SMTP smtp.isp.netscape.com 25 SSL-enabled

Verizon SMTP smtp.verizon.net 587 SSL-enabled

Yahoo! SMTP smtp.mail.yahoo.com 995 SSL-enabled

Yahoo! Plus SMTP smtp.mail.yahoo.com 465 SSL-enabled
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B BBest Practices

iPrint Appliance strives to provide a seamless printing experience. Following the practices listed 
below can ensure a highly efficient and highly available print system.

Print Manager: We strongly recommend not to create an additional Print Manager. The iPrint Initial 
Configuration Wizard creates a Print Manager. Only one Print Manager per appliance is 
recommended.

Spam Filters: When using email printing, the print command in the subject line might trigger spam 
filters. To avoid this issue, configure your email system to allow print-specific emails. Include the 
approved print users in the spam filter of your email system to prevent unwanted print requests.

Email Polling Interval: By default, the iPrint Appliance server polls the mail server for new email 
every 30 seconds. If you rely heavily on email printing, you must reduce the polling interval for faster 
response. However, you must ensure that your mail server is not overloaded by the frequent polling.

DNS Configuration (iPrint Appliance and Remote Renderer): We strongly recommend that you 
use a DNS resolvable host name for iPrint Appliance and remote renderer. This host name is used by 
client devices when printing and can cause failures if it is not resolved. The IP address assigned to 
the iPrint Appliance and remote renderer must have DNS host entry in the DNS server. Ensure that 
the DNS entries are in the same domain.

Time Sync: It is recommended that you sync the Virtual Machine host and the guest Virtual Machine 
time to the same source.

Connectivity between iPrint Appliance and External Renderer: We recommend that you have a 
high-speed connection between iPrint Appliance and the external renderer.

Connectivity between iPrint Appliance and Mail Server: If you rely heavily on email printing, we 
recommend that you have a high-speed communication link between iPrint Appliance and the mail 
server, in order to speed up the printing of email jobs.

Applications on Remote Renderer: For best performance, do not run any other applications on the 
remote renderer machine. 

Importing Users from Active Directory Source Using LDAP Sync: You might not be able to 
import all users from the Active Directory source using LDAP sync. By default, only 1,000 users are 
returned from Active Directory. This is caused by a default setting in Active Directory that limits LDAP 
searches to 1,000 results. For more information, see the Microsoft support article: How to view and 
set LDAP policy in Active Directory by using Ntdsutil.exe.

LDAP Import: Do not create local users under LDAP imported OUs.

Partitions and Replicas Option in iManager: In iManager, you might see the Partition and Replicas 
option. This feature is not required for iPrint Appliance. Therefore, it is not supported. We recommend 
that you not use it on the iPrint Appliance eDirectory.

Creating Local Users and Groups in iPrint Appliance: If you want to create a local user or a local 
group account in iPrint Appliance, ensure that you create the user or group account outside the 
synced user’s context. This is because when you sync from an LDAP source to iPrint Appliance, the 
user and group entries are imported into the MySQL database of iPrint Appliance. By default, iPrint 
Appliance runs a sync to the MySQL database every 8 minutes. If the local user or group account is 
not found in the MySQL database, the account is automatically deleted during the next sync.
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Remote Renderer Fails When Proxy is Enabled: If proxy is enabled on the Windows machine that 
is running the remote renderer, the renderer might fail to process print jobs. To workaround this issue, 
you must disable proxy.

B.1 Best Practices for Mobile Printing
On iPrint Appliance 1.1, when you enable a printer for mobile printing, the server performs additional 
background tasks such as driver download, installation, and configuration. Though the printer is 
immediately enabled for mobile printing, the print jobs might go through the default driver configured 
for local and remote renderer(s). If the default driver is not compatible with the printer then it can lead 
to poor quality printing. It is recommended that you test the printer by issuing test prints to ensure that 
newly enabled printer is configured correctly.

Check the mobile server logs for any related errors to ensure that there are no failures with the printer 
configuration at the local or remote renderer(s). If you notice errors in the mobile server logs 
indicating a failure at the local or remote renderer(s), try following steps to resolve the issues.

1 Disable the printer for mobile printing to avoid users printing to it.

2 Ensure that the print manager is running.

3 Ensure that the Driver Store is running.

4 Ensure that the driver is present in the Driver Store for the renderer platform, and is associated 
with the printer.

5 Try installing the printer from the IPP page for the corresponding platform on which renderer 
configuration failed. This shows the exact error indicating the underlying problem.

6 Enable the printer for mobile printing after fixing the error.
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C CiPrint Appliance Support Matrix

This section provides information on the following.

 Section C.1, “Mobile Server Support,” on page 215

 Section C.2, “Mobile Operating System Support,” on page 215

 Section C.3, “Directory Services Support,” on page 216

 Section C.4, “Management Console Support,” on page 216

 Section C.5, “MobileIron Support,” on page 216

 Section C.6, “Remote Renderer,” on page 217

 Section C.7, “Supported Document Formats By the Local Renderer and Remote Renderer,” on 
page 217

 Section C.8, “iPrint Appliance Server and Client Support,” on page 218

 Section C.9, “OES Source Platform Support for Migration,” on page 218

 Section C.10, “Clients for Email Printing,” on page 219

 Section C.11, “Supported Browsers for iPrint,” on page 219

C.1 Mobile Server Support

Table C-1   Moblie Server Support

C.2 Mobile Operating System Support

Table C-2   Mobile Operating System Support for Apps

Features Version

Email  Novell GroupWise 2012

 Microsoft Exchange 2010

 IBM Domino server 9

 Lotus Notes

Type Version

iOS  7.x

 8
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C.3 Directory Services Support

Table C-3   Directory Services Support

C.4 Management Console Support

Table C-4   Management Console Support

C.5 MobileIron Support

Table C-5   MobileIron Support

Android  Gingerbread (2.3.x)

 Ice Cream Sandwich (4.0.x)

 Jelly Bean (4.1.x, 4.2.x, 4.3.1)

 KitKat (4.4)

BlackBerry  OS 10

Windows  Phone 8 

 RT 8.1

Type Version

LDAP Directory Service Version 

eDirectory  8.8.x or later

Active Directory  Active Directory configured on Windows Server 2012 R2 
Standard Edition

 Active Directory configured on Windows Server 2008 R2 
Enterprise Edition 

Access Version

Browser  Internet Explorer 11,10, and 9

 Firefox 30 or higher

 Chrome 35 or higher

 Safari 7 or higher

 iOS 6.x and 7.1 tablet with default browsers

 Android 4.x tablet with default browsers

MobileIron Core Version iPrint Mobile App Version

6.0.x 1.1 mobile app for iOS and Android
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C.6 Remote Renderer 
 Table C-6, “Operating Systems Support,” on page 217

 Table C-7, “Software Support,” on page 217

Table C-6   Operating Systems Support

Table C-7   Software Support

C.7 Supported Document Formats By the Local 
Renderer and Remote Renderer

Table C-8   Local Renderer Supported Document Formats

7.5 1.1 mobile app for iOS and Android

MobileIron Core Version iPrint Mobile App Version

Support Version

Operating System  Windows 8.1 64-bit

 Window 8 64-bit 

 Windows 7 SP2 64-bit

 Windows 2012 R2 64-bit 

 Windows 2010 (32-bit and 64-bit) Standard

 Windows 2008 R2 Enterprise 64-bit 

 Windows Vista (32-bit and 64-bit)

Support Version

Microsoft Office  Ms Office 2013 (32-bit and 64-bit) Standard

 Ms Office 2013 32-bit Standard

Adobe Acrobat  Adobe Acrobat XI Professional

Software File Formats

OpenDocument ODT, ODP, ODG, ODS

Graphics JPG, BMP, TIF, GIF, PNG

Others TXT

HTML (Static)

Static HTML content refers to the HTML content that 
does not change or have dependencies on external 
files such as MySQL database and JavaScript.
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Table C-9   Remote Renderer Supported Document Formats

C.8 iPrint Appliance Server and Client Support

Table C-10   iPrint Appliance Server and Client Support

C.9 OES Source Platform Support for Migration

Table C-11   Source Platform Support for OES iPrint Service 

Software File Formats

Microsoft Word DOC, DOCX, DOCM, DOTM, RTF

Microsoft Excel XLS, XLSX, XLSM, XLSB

Microsoft PowerPoint PPT, PPTX, PPTM, PPTX

Others PDF

Support Version

Hypervisor  Xen on SLES

 Citrix Xen

 Hyper-V

 ESXi 5.x 

 ESX 4

 VMware Workstation 9 and 10

Desktop iPrint Client  Windows 10

 Windows 8.1

 Windows 8.1 Surface Pro tablet

 Windows 8

 Windows 7

 Windows Server 2008 R2

 Windows Server 2012 R2

 Mac 10.7 or later

Appliance Installer (virtual m/c format)  OVF

 VHD

 XEN

Services NW 6.5

SP8

OES 2

SP3

OES 11 OES 11 SP1 OES 11 SP2 OES 2015

iPrint
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If the source platforms are NW 5.1, NW 6.0 SP5, OES 1 SP2, OES 2 SP1 or OES 2 SP2, you must 
upgrade to the latest supported source platform as listed in the above table.

C.10 Clients for Email Printing
 Novell GroupWise 2012 and Novell GroupWise 2014

 Microsoft Outlook 2010

 IBM Lotus Notes 9

 iOS 5, 6. x, 7.x default mail client

 Mail clients on Android 2.3 or higher

 Windows Mobile 8

 Blackberry 7.1

 Windows 8 Pro default mail client on tablet

 Gmail

C.11 Supported Browsers for iPrint
The section provides information on which Web browsers are supported for different iPrint tasks and 
operations.

 Section C.11.1, “iPrint Client Supported Browsers,” on page 219

 Section C.11.2, “Supported Browsers for the iPrint Plug-In and iManager,” on page 220

 Section C.11.3, “Supported Browsers for the iPrint Map Designer,” on page 221

C.11.1 iPrint Client Supported Browsers

The following table indicates which browsers are supported with the various iPrint Client platforms:

iPrint Client Platform Supported Browsers

Linux  Mozilla Firefox 2.x.x, 3.0.x, or later

Macintosh  Safari 8.6 or later

 Mozilla Firefox 38.1 or later

 Google Chrome 43 or later

Windows XP  Microsoft Internet Explorer 6.0 or later

 Mozilla Firefox 2.0.x, 3.0.x, or later

Windows Vista  Internet Explorer 7 or later

 Mozilla Firefox 3.0.x or later

 Google Chrome

Windows 7  Internet Explorer 8 or later

 Mozilla Firefox 3.0.x or later

 Google Chrome
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NOTE: Mozilla Firefox and Google Chrome browsers are supported only on iPrint Windows Client 
6.0.0 and above for printer installation.

C.11.2 Supported Browsers for the iPrint Plug-In and iManager

The iPrint plug-in with iManager supports the following browsers:

 Internet Explorer 6.0 or later

 Mozilla Firefox 2.x.x or later

NOTE: If you are running Windows XP Service Pack 2 or other browsers with pop-up blocking, you 
might encounter problems with pop-up windows. To manage iPrint in iManager and to install printers 
with iPrint clients, turn off pop-up blocking or allow the URL.

When you upload printer drivers and PPD files, you should use the following browsers for the 
operations indicated:

 “Uploading PPD Files Using iManager” on page 220

 “Uploading Windows Printer Drivers Using iManager” on page 220

Uploading PPD Files Using iManager

NOTE: On Mac operating systems, PPD upload is not supported. PPD files for Mac can be uploaded 
using Internet Explorer on Windows. Alternatively, you can also upload the PPD files for Mac and 
Linux using the iprntcmd command from a terminal session. For uploading the PPD files for Mac and 
Linux, refer Section 9.6, “Using iprntcmd on Linux and Macintosh,” on page 176.

Uploading Windows Printer Drivers Using iManager

Windows 8/ Windows 8.1/ Windows 10  Internet Explorer 10 or later

 Mozilla Firefox 3.0.x or later

 Google Chrome

iPrint Client Platform Supported Browsers

iPrint Client Platform Supported Browser Upload PPD file to Driver Store 
on Linux

Windows Internet Explorer 6.0 or later Supported using the Add from File 
button.

Client Supported Browser Upload Windows Printer Driver to 
Driver Store on Linux

Windows Internet Explorer 6.0 or later Supported
220 Novell iPrint Appliance 1.1 Administration Guide



C.11.3 Supported Browsers for the iPrint Map Designer

The iPrint Map Designer works only with Microsoft Internet Explorer 6.0 or later.
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D DTIDs for iPrint

This section contains the list of TIDs that are available for iPrint Appliance. These TIDs are located on 
the Novell Technical Support website and are listed in this document to provide easy access for the 
users.

TID No Description

7015553 Accessing the Renderer’s page displays RPC error

7013074 Local rendered jobs are cancelled or improperly rendered

7015506 Unable to contact the remote renderer

7015857 Renderer is not using the modified printer driver

7013428 Unable to resolve domain <iPrintApplianceDomain> when printing from a mobile 
device

7013185 Error “Check the printer for errors” is displayed when printing from a mobile device 

7015684 Copy printer driver profiles from one iPrint Appliance to another

7015896 How to install VMware Tools on the iPrint Appliance

7015913 How to install iPrint printers using AD tools

7012895 When printing from an IOS device no AirPrint printers are found

 7015852 Implementing a satellite Avahi listener to advertise iPrint printers

 7015851 Implementing an Avahi reflector to advertise iPrint printers

 7015848 Implementing a DNS-SD solution to advertise iPrint printers
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E EiPrint Commands and Utilities

This section contains information about iPrint commands and utilities.

 “iprntcmd(1)” on page 226
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iprntcmd(1)

Name

iprntcmd - iprint administrative utility. 

SYNTAX

iprntcmd <options> <parameter>

DESCRIPTION

iprntcmd provides command-line functionality for iPrint administrative tasks on a workstation.

OPTION SUMMARY

You must use quotes around parameters that contain spaces.

OPTIONS

Option type <parameter>

-T | --tray-icon  

Displays an iPrint icon to the notification area and launches the iprint-listener-gui process, 
if it is not running.

-r | --run-listener  

Launches the iprint-listener process  if it is not already running.

-a | --addprinter <printer-uri> 

Installs the specified printer.

-d | --delprinter <printer-uri> 

Removes the specified printer.

-d | --delprinter all 

Remove all the printers. This option requires your confirmation before removing all the printers.

-d | --delprinter all --force 

Remove all the printers. This option removes all the printers forcibly without any user 
intervention.

-g | --getdefault 

Displays the default printer installed on the workstation.

-h | --help 

Displays help for the command.

-j | --listjobs <printer-uri> 

Lists the print jobs for the specified printer that are on the server in a pending or printing state.
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-l | --listprinters 

Lists printers installed on the workstation.

-L | -listprintersonserver <psm-hostname or psm-address> 

Lists iPrint printers on the specified Print Manager where psm-hostname or psm-address can be 
a DNS name or IP address.

-p | --printfile <printer-uri> <file path> 

Sends a printer-ready file to the specified iPrint printer.

-P | --ppdlist 

Lists the PPDs  installed on this workstation.

-s | --setdefault <printer-uri> 

Sets the specified printer as the default.

-t | --testpage <printer-uri> 

Prints a test page to the specified printer.

-u | --uploadids <ids-uri> <ppd path with/without wildcards> 

Uploads the specified PPD files to the indicated driver store where ids_uri is the IP address or 
DNS name for the driver store, and ppd is the directory path and filename to the PPD files. You 
can use a wildcard in the PPD filename.

-U | --uploadbroker <rms-uri>  <rms-name> <ppd path with/without wildcards> 

Uploads the specified PPD files to the indicated Broker where rms_uri is the IP address or DNS 
name for the Broker’s associated print manager, rms_name is the username with rights to add 
drivers to the broker, and ppd is the directory path and filename to the PPD files. You can use a 
wildcard in the PPD filename.

 -v | --version <psm-hostname or psm-address> 

Displays the server platform and version information where server_uri is the URI for the server.

-i | --info <printer-uri> 

Displays the printer information.

-S | --setprimarypsm <IP/DNS> 

Sets the PSM address for iCM configuration.

-c | --clearallpasswords 

Clears all saved passwords.

-f | --fetchdriverlocal <printer-uri> 

Fetches the printer driver on local machine.

EXAMPLES

Syntax 

iprntcmd --<option> ipp://<host_address>/ipp/<printer_name>

Example to add a printer 

iprntcmd --addprinter ipp://printing.MyCompany.com/ipp/Printer1
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Example to delete a printer 

iprntcmd --delprinter ipp://printing.MyCompany.com/ipp/Printer1 

Example to get a default printer 

iprntcmd --getdefault

Example to list the print jobs 

iprntcmd --listjobs ipp://printing.MyCompany.com/ipp/Printer1

Example to get the list of installed printers 

iprntcmd --listprinters

Example to get the list of printers on a server 

iprntcmd --listprintersonserver printing.MyCompany.com

Example to print a file 

iprntcmd --printfile ipp://printing.MyCompany.com/ipp/Printer1 /home/user1/temp.txt 

Example to get a list of local ppd files 

iprntcmd --ppdlist

Example to set a default printer 

iprntcmd --setdefault ipp://printing.MyCompany.com/ipp/Printer1

Example to test a print page 

iprntcmd --testpage ipp://printing.MyCompany.com/ipp/Printer1

Example to upload driver <without using a wildcard> to ids 

iprntcmd --uploadids printing.MyCompany.com /usr/share/cups/model/HP/
LaserJet_4V_4LJ_Pro-lj4dithp.ppd.gz

or

iprntcmd --uploadids 192.168.3.4 /usr/share/cups/model/HP/LaserJet_4V_4LJ_Pro-
lj4dithp.ppd.gz

Example to upload driver <using a wildcard> to ids 

iprntcmd --uploadids printing.MyCompany.com /usr/share/cups/model/HP/LaserJet_4*

or

iprntcmd --uploadids 192.168.3.4 /usr/share/cups/model/HP/LaserJet_4*

Example to upload drivers (without using a wildcard) to rms 

iprntcmd --uploadbroker printing.MyCompany.com rms_name /usr/share/cups/model/HP/
LaserJet_4V_4LJ_Pro-lj4dithp.ppd.gz

or

iprntcmd --uploadbroker 192.168.3.4 rms_name /usr/share/cups/model/HP/
LaserJet_4V_4LJ_Pro-lj4dithp.ppd.gz

Example to upload drivers (using a wildcard) to rms 

iprntcmd --uploadbroker printing.MyCompany.com rms_name /usr/share/cups/model/HP/
LaserJet_4*

or

iprntcmd --uploadbroker 1.2.3.4 rms_name /usr/share/cups/model/HP/LaserJet_4*
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Example to get iprint server version 

iprntcmd --version printing.MyCompany.com

or

iprntcmd --version 192.168.3.4 

Example to get information of a printer 

iprntcmd --info ipp://printing.MyCompany.com/ipp/Printer1

Authors

Copyright 2005-2014, Novell, Inc. All rights reserved. http://www.novell.com
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F FiPrint Appliance Documentation 
Updates

This section contains information about documentation content changes made to this guide since the 
initial release of Novell iPrint Appliance.

 Section F.1, “September 2015 (iPrint Appliance 1.1 Patch 3),” on page 231

 Section F.2, “June 2015 (iPrint Appliance 1.1 Patch 2),” on page 231

 Section F.3, “April 2015 (iPrint Appliance 1.1 Patch 1),” on page 232

 Section F.4, “July 2014 (iPrint Appliance 1.1),” on page 232

 Section F.5, “February 2014 (iPrint Appliance 1.0.1 Patch 1),” on page 233

F.1 September 2015 (iPrint Appliance 1.1 Patch 3)

F.1.1 What’s New or Changed in iPrint Appliance

F.1.2 Windows 10 Support

The guide is updated with Windows 10 support in all the relevant sections.

F.2 June 2015 (iPrint Appliance 1.1 Patch 2)

F.2.1 What’s New or Changed in iPrint Appliance

F.2.2 Managing iPrint Appliance

Location Update

Section 2.2, “What’s New (iPrint Appliance 1.1 Patch 3),” on page 17 This section is new

Location Update

Section 2.3, “What’s New (iPrint Appliance 1.1 Patch 2),” on page 17 This section is new

Location Update

Section 7.9, “Field Patch,” on page 89 This section is updated with a Download Log 
File button to download the file.
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F.2.3 Installing and Setting Up iPrint on Client Workstations

F.3 April 2015 (iPrint Appliance 1.1 Patch 1)
 Section F.3.1, “What’s New or Changed in iPrint Appliance,” on page 232

 Section F.3.2, “Document Rendering,” on page 232

 Section F.3.3, “Installing and Setting Up iPrint on Client Workstations,” on page 232

F.3.1 What’s New or Changed in iPrint Appliance

F.3.2 Document Rendering

This chapter is updated with details of Secure and Non-secure communication. 

F.3.3 Installing and Setting Up iPrint on Client Workstations

This chapter is new.

F.4 July 2014 (iPrint Appliance 1.1)
 Section F.4.1, “Desktop Integration,” on page 232

 Section F.4.2, “iPrint Overview,” on page 233

 Section F.4.3, “What’s New or Changed in iPrint Appliance,” on page 233

 Section F.4.4, “Installing iPrint Appliance,” on page 233

 Section F.4.5, “iPrint Appliance Support Matrix,” on page 233

 Section F.4.6, “TIDs for iPrint,” on page 233

 Section F.4.7, “Print Commands and Utilities,” on page 233

 Section F.4.8, “Third-Party Materials,” on page 233

F.4.1 Desktop Integration

The guide is revamped to include the desktop content.

Location Update

Section 9.2.1, “Using the iPrint Printer List Web Page on 
Windows,” on page 156

This section is updated with new installation 
steps and Google Chrome browser.

Section 9.2.2, “Using the iPrint Printer List Web Page on 
Macintosh,” on page 160

This section is updated with new installation 
steps and Google Chrome browser.

Location Update

Section 2.4, “What’s New (iPrint Appliance 1.1 Patch 1),” on page 19 This section is new
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F.4.2 iPrint Overview

This chapter is revamped for better user experience.

F.4.3 What’s New or Changed in iPrint Appliance

This chapter is new.

F.4.4 Installing iPrint Appliance

F.4.5 iPrint Appliance Support Matrix

F.4.6 TIDs for iPrint

This chapter is new.

F.4.7 Print Commands and Utilities

This chapter is new.

F.4.8 Third-Party Materials

This chapter is new.

F.5 February 2014 (iPrint Appliance 1.0.1 Patch 1)

Location Update

Section 4.1.2, “Citrix Xen Configuration,” on page 32 This section is new

Location Update

Section C.7, “Supported Document Formats By the 
Local Renderer and Remote Renderer,” on page 217

This section is new

Location Update

Chapter 6, “Document Rendering,” on page 71 Updated the Remote Renderer chapter to include 
information about the in-built PDF renderer for iPrint 
Appliance 1.0.1 Patch 1.
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